Ellucian Recruiter
Guide to Using Recruiter

Release 3.8
August 12, 2015
# Table of Contents

11  **About This Manual**
   11  Who Should Read This Manual
   11  What This Manual Covers
   11  How This Manual Is Organized
   13  Recruiter Benefits
   13  Recruiter Features
   15  Where to Find More Information

19  **About Recruiter**
   19  In This Chapter
   20  About Recruiter
   21  ERP and CRM Systems in the Recruiting and Admissions Process
   22  How Recruiter Works with Your ERP System
   23  Admissions Terminology
   23  Recruiter and CRM Terminology
   24  Recruiting and Admissions Process
   25  Application Integration Points

27  **Recruiter Navigation and Interface Basics**
   27  In This Chapter
   28  Navigation and Interface Basics
   28  Navigation
   31  Data Grid
   32  Advanced Find
   34  Recruiter Online Help

37  **Recruiter Areas**
   37  In This Chapter
   38  Recruiter Areas
   39  Workplace
   40  Recruiting Area
   40  Recruiting Home Page
   42  Recruiting Reports
   42  Territory Management
   43  Enrollment Goals
   44  Suspect Management
   44  Prospect Management
   46  Convert Suspects to Prospects
   46  Organization Management
# Table of Contents

47 **Campaigns Area**
   47 **Campaigns Home Page**
   48 **Campaigns**
   49 **Drip Campaigns**
   50 **Marketing Lists**
51 **Travel and Events Area**
   51 **Travel and Events Home Pages**
   51 **Trips Home Page**
   51 **Events Home Page**
53 **Travel and Events Reports**
53 **Event Management**
53 **Event Communications**
54 **Travel Management**
55 **Applications Area**
   55 **Applications Landing Page**
   56 **Online Applications**
   58 **Application Folder**
60 **Recruiting Imports Area**
   60 **Recruiting Imports Landing Page**
   61 **Recruiting Import Process**
63 **ExactTarget Area**
   63 **ExactTarget Landing Page**
   64 **ExactTarget Configuration and Features**
65 **Settings Area**
   65 **Settings Home Page**

69 **Security Roles and User Accounts**

69 **In This Chapter**
70 **Security Roles Model**
71 **Terminology and Details**
71 **Security Roles**
71 **Entities**
72 **Privileges**
73 **Access Levels**
73 **Miscellaneous Privileges**
74 **Delivered Security Roles**
77 **View and Assign Security Roles**
78 **User Accounts**
78 **Recruiter User Accounts and Profiles**
78 **External Website User Accounts**

81 **Integrated Products Overview**

81 **In This Chapter**
### Table of Contents

<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>82</td>
<td>ERP Integration</td>
</tr>
<tr>
<td>83</td>
<td>Ellucian Applications</td>
</tr>
<tr>
<td>84</td>
<td>Third-Party Applications</td>
</tr>
<tr>
<td>85</td>
<td>Reporting Tools</td>
</tr>
<tr>
<td>85</td>
<td>Microsoft Office Excel Exports</td>
</tr>
<tr>
<td>87</td>
<td>Microsoft Dynamics CRM Report Wizard</td>
</tr>
<tr>
<td>89</td>
<td>SQL Service Reporting Services (SSRS)</td>
</tr>
<tr>
<td>89</td>
<td>Fetch-Based Reports</td>
</tr>
<tr>
<td>90</td>
<td>SQL-Based Reports</td>
</tr>
<tr>
<td>90</td>
<td>Recruiter Analytics (Colleague clients)</td>
</tr>
</tbody>
</table>

#### 93 Managing Enrollment Goals

- In This Chapter
- Enrollment Goals Overview
- Recruiting Periods
- Goal Targets and Statuses
- Territory Goals
- Reporting Goals
- Goal Calculation
- Recruiting Home Page

#### 103 Managing Suspects and Prospects

- In This Chapter
- Suspects and Prospects Overview
- Suspect and Prospect Forms in Recruiter
  - Suspect Form
  - Prospect Form
  - Prospect Plus Form
- Prospect Profile, Ratings, Statuses, and Sources
  - Prospect Profile
  - Prospect Ratings
  - Prospect Statuses
  - Prospect Sources
  - Origin Source
  - Inquiry Source
- Recruiting Imports
  - Recruiting Import Process
  - Suspect Auto-Qualification Criteria

#### 119 Managing Applications and Application Reviews

- In This Chapter
- Applications Overview
<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>120</td>
<td>Applications</td>
</tr>
<tr>
<td>121</td>
<td>Application Type and Form</td>
</tr>
<tr>
<td>122</td>
<td>Supplemental Items</td>
</tr>
<tr>
<td>123</td>
<td>Application statuses</td>
</tr>
<tr>
<td>124</td>
<td>Additional Processing with the Submitted Status</td>
</tr>
<tr>
<td>125</td>
<td>Additional Application Features</td>
</tr>
<tr>
<td>125</td>
<td>Primary Application Designation</td>
</tr>
<tr>
<td>126</td>
<td>Edit Applications</td>
</tr>
<tr>
<td>126</td>
<td>Print Applications</td>
</tr>
<tr>
<td>127</td>
<td>Export Applications</td>
</tr>
<tr>
<td>128</td>
<td>Letters of Recommendation Feature</td>
</tr>
<tr>
<td>128</td>
<td>Letters of Recommendation User Roles</td>
</tr>
<tr>
<td>128</td>
<td>Recommendation Request Statuses</td>
</tr>
<tr>
<td>129</td>
<td>Prospect and Recommender Processes</td>
</tr>
<tr>
<td>129</td>
<td>Prospect</td>
</tr>
<tr>
<td>131</td>
<td>Recommender</td>
</tr>
<tr>
<td>133</td>
<td>Application Reviews</td>
</tr>
<tr>
<td>134</td>
<td>Application Review Process</td>
</tr>
<tr>
<td>135</td>
<td>Application Folder Statuses</td>
</tr>
<tr>
<td>137</td>
<td>Managing the Prospective Student Experience</td>
</tr>
</tbody>
</table>

**In This Chapter**

- Prospective Student Experience
  - What You Can Do to Enhance the Prospective Student Experience
  - What Prospective Students Can Do on the External Website
  - What Other Contacts Can Do on the External Website

**External Website Details**

- Login Page
- My Account Page
- Create Account and Prospect Inquiry Pages
- Prospect Profile Control and Update Prospect Profile Page
- Event Control and Pages
- Online Application Control and Pages
- Recommendation Controls and Pages

**Smart Links and Quick Forms**

- Create Account Verification Process
- Configuring the Create Account Verification Process
- Update Duplicate Detection Rules
- Create an E-mail Template for Account Activation
- Review External Website Activation Webpages
<table>
<thead>
<tr>
<th>Page</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>163</td>
<td>Enable Create Account Verification</td>
</tr>
<tr>
<td>164</td>
<td>Test the Create Account Activation Process</td>
</tr>
<tr>
<td>167</td>
<td>Managing Communications Options</td>
</tr>
<tr>
<td>167</td>
<td>In This Chapter</td>
</tr>
<tr>
<td>168</td>
<td>Communications Overview</td>
</tr>
<tr>
<td>168</td>
<td>Communication Options in Recruiter</td>
</tr>
<tr>
<td>171</td>
<td>E-mail Options in Recruiter</td>
</tr>
<tr>
<td>173</td>
<td>Campaigns or Workflows</td>
</tr>
<tr>
<td>176</td>
<td>Additional Campaign Features</td>
</tr>
<tr>
<td>176</td>
<td>Catch-Up Processing</td>
</tr>
<tr>
<td>177</td>
<td>Drip Campaigns</td>
</tr>
<tr>
<td>178</td>
<td>Automatic Distribution of Campaign Activities</td>
</tr>
<tr>
<td>179</td>
<td>Marketing List Filtering</td>
</tr>
<tr>
<td>180</td>
<td>Close Activities in Bulk</td>
</tr>
<tr>
<td>182</td>
<td>Ad Hoc Activities or Quick Campaigns</td>
</tr>
<tr>
<td>183</td>
<td>Create Ad Hoc Activities</td>
</tr>
<tr>
<td>185</td>
<td>Create Quick Campaigns</td>
</tr>
<tr>
<td>187</td>
<td>Create Calendar Campaigns</td>
</tr>
<tr>
<td>192</td>
<td>Create Communications Workflows</td>
</tr>
<tr>
<td>197</td>
<td>Use ExactTarget E-mails in Recruiter</td>
</tr>
<tr>
<td>199</td>
<td>Use Mail Merge in Recruiter</td>
</tr>
<tr>
<td>199</td>
<td>CRM for Outlook Mail Merge Process (in Campaigns)</td>
</tr>
<tr>
<td>201</td>
<td>CRM Web Application Mail Merge Process (in Campaigns)</td>
</tr>
<tr>
<td>202</td>
<td>Mail Merge Process (in Communications Workflows)</td>
</tr>
<tr>
<td>205</td>
<td>Managing Duplicate Data</td>
</tr>
<tr>
<td>205</td>
<td>In This Chapter</td>
</tr>
<tr>
<td>206</td>
<td>Duplicate Detection Overview</td>
</tr>
<tr>
<td>206</td>
<td>Duplicate Detection Options</td>
</tr>
<tr>
<td>207</td>
<td>Delivered Recruiter Duplicate Detection Rules</td>
</tr>
<tr>
<td>208</td>
<td>Preventing Duplicate Data</td>
</tr>
<tr>
<td>208</td>
<td>Recruiter Functions That Require You to Resolve Duplicate Data</td>
</tr>
<tr>
<td>211</td>
<td>Detecting Duplicate Data</td>
</tr>
<tr>
<td>211</td>
<td>Duplicate Detection Rules</td>
</tr>
<tr>
<td>212</td>
<td>Duplicate Detection Jobs</td>
</tr>
<tr>
<td>215</td>
<td>Resolving Duplicate Data</td>
</tr>
<tr>
<td>217</td>
<td>Merging Duplicate Records</td>
</tr>
<tr>
<td>219</td>
<td>Managing ERP Integration Options in Recruiter</td>
</tr>
<tr>
<td>219</td>
<td>In This Chapter</td>
</tr>
<tr>
<td>Page</td>
<td>Section</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
</tr>
<tr>
<td>220</td>
<td>Recruiter and Your ERP System</td>
</tr>
<tr>
<td>220</td>
<td>Before You Begin Transferring Data</td>
</tr>
<tr>
<td>221</td>
<td>How Data Gets Into Recruiter</td>
</tr>
<tr>
<td>222</td>
<td>Data Transferred Between Recruiter and Your ERP System</td>
</tr>
<tr>
<td>223</td>
<td>Sending Data from Recruiter to Your ERP System</td>
</tr>
<tr>
<td>223</td>
<td>Actions in Recruiter That Send Data</td>
</tr>
<tr>
<td>224</td>
<td>Applications</td>
</tr>
<tr>
<td>225</td>
<td>Prospects</td>
</tr>
<tr>
<td>226</td>
<td>Proposed Admissions Decision</td>
</tr>
<tr>
<td>226</td>
<td>Activities</td>
</tr>
<tr>
<td>226</td>
<td>Test Scores</td>
</tr>
<tr>
<td>227</td>
<td>Transcript Courses</td>
</tr>
<tr>
<td>228</td>
<td>Which Data Is Sent and When</td>
</tr>
<tr>
<td>228</td>
<td>Applications and Prospects</td>
</tr>
<tr>
<td>230</td>
<td>Proposed Admissions Decision</td>
</tr>
<tr>
<td>230</td>
<td>Activities</td>
</tr>
<tr>
<td>232</td>
<td>Test Scores</td>
</tr>
<tr>
<td>233</td>
<td>Transcript Courses</td>
</tr>
</tbody>
</table>
Guide to Using Recruiter
Introduction
About This Manual

Who Should Read This Manual

Anyone responsible for using Ellucian Recruiter™ should read this manual. Typically, this manual would be helpful for Directors of Admissions, Admissions Officers/Recruiters, Admissions Administrative Staff, and Recruiter Administrators.

What This Manual Covers

This manual contains conceptual information for understanding the Recruiter software, its features, and the processes that you can manage using Recruiter.

How This Manual Is Organized

The Introduction section, which you are reading now, provides information about:

- This manual and its organization
- Recruiter benefits and high-level features
- Where to go to find additional instructional information about Microsoft Dynamics CRM and Recruiter

The Recruiter Functional Overview section provides details about:

- Recruiter concepts and functions
- Navigation and interface basics
- Recruiter areas
- Security roles and user accounts
- Integrated or supported products
The Recruiting and Admissions Processes section provides information about managing common recruiting and admissions processes and other features within Recruiter, such as:

- Enrollment goals
- Suspects and prospects
- Applications and application reviews
- Prospective student experience
- Communications
- Duplicate data
- Enterprise Resource Planning (ERP) integration options

**Note:** The integration options that are available to you are dependent on the ERP system you are using. Recruiter works in an automated way with both Banner by Ellucian and Colleague by Ellucian ERP systems to transfer data between the systems. You can also manually import and export data as needed for Banner, Colleague, and other ERP systems.
Recruiter Benefits

Recruiter is a solution that greatly enhances the recruitment capabilities of Admissions offices and staff members. This is accomplished with suspect and prospect management capabilities, event marketing and management, application process and reviews management, operational reporting for both management and recruitment staff, and communication tools.

Recruiter Features

This section describes key features of the Recruiter product. With Recruiter, you can build strong, lasting relationships with your prospective students, be more informed, and stay on target with ongoing student interactions, real-time analytics, and events and communications management.

Some of the key recruiting and admissions tasks include the ability to do the following:

- Monitor and direct recruiter activities and results.
- Manage recruiter tasks.
- Extend a personalized experience to prospects with one-to-one targeted communications.
- Know where prospects are in the admissions funnel.
- Extend an enhanced experience to prospects with personalized website pages.
- Enable prospects to apply online.
- Engage prospects in events to attract them to your institution.
- Manage campaigns to increase awareness of your institution through communications with suspects and prospects.
- Manage trips and track your Return on Investment (ROI) for each trip taken by a recruiter.
- Manage the application folder review process.
Some of the key administrative tasks include the ability to do the following:

- Send bulk e-mails using configurable e-mail templates or integrated ExactTarget® features.
- Cleanse addresses and assign a latitude and longitude to an address with integrated StrikeIron® features.
- Manage users on your website who have created accounts. You can deactivate accounts, unlock accounts, or reset passwords as needed.
- Review delivered reports to access and analyze the data in each of the Recruiter areas, and customize reports as needed.
- Create multiple event, prospect account, prospect profile, recommendation, and application forms to personalize the experience for each prospective student.
- Use Quick Forms to provide prospects and suspects e-mail links to your Recruiter external website where they can verify their identity, activate an account, or create an account. Quick Forms allow certain information to be prepopulated from Recruiter, making the process of creating a new account easier for prospective students.
- Customize and schedule workflows to automate business processes and minimize repetitive tasks.
- Use delivered imports for third-party suspect lists, test scores, and applications, and create imports for custom needs.
- Integrate Recruiter data with an ERP system, such as Banner or Colleague.
Where to Find More Information

Table 1 lists sources of information to help you install and configure Recruiter.

**Note:** Recruiter documentation is available from the Ellucian Support Center, “Ellucian Recruiter” documentation library. You can access the manuals for the Recruiter 3.8 release in the Recruiter 3.8 Documentation content pack.

### Table 1: Additional Sources of Information

<table>
<thead>
<tr>
<th>Type of Information</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Release Information</strong></td>
<td></td>
</tr>
<tr>
<td>New features and changes in this release</td>
<td><strong>Recruiter 3.8 Release Highlights</strong></td>
</tr>
<tr>
<td><strong>Installation and Integration Information</strong></td>
<td></td>
</tr>
<tr>
<td>Installing Recruiter 3.8, or upgrading from Recruiter 3.7.1 to Recruiter 3.8</td>
<td><strong>Recruiter Installation Procedures</strong></td>
</tr>
<tr>
<td>Microsoft products and support</td>
<td><a href="http://www.microsoft.com">www.microsoft.com</a></td>
</tr>
<tr>
<td></td>
<td><a href="http://www.msdn.microsoft.com">www.msdn.microsoft.com</a></td>
</tr>
<tr>
<td></td>
<td><a href="http://www.microsoft.com/technet">www.microsoft.com/technet</a></td>
</tr>
<tr>
<td><strong>Installing and setting up the Colleague Web API</strong></td>
<td><strong>Setting Up Colleague Web API</strong></td>
</tr>
<tr>
<td>Integrating Recruiter with Colleague by Ellucian</td>
<td><strong>Integrating Recruiter with Colleague</strong></td>
</tr>
<tr>
<td>Installing the Banner Recruiter Integration Manager</td>
<td><strong>Banner Recruiter Integration Manager Installation Guide</strong></td>
</tr>
<tr>
<td>Integrating Recruiter with Banner by Ellucian</td>
<td><strong>Integrating Recruiter with Banner</strong></td>
</tr>
<tr>
<td>Information about the Banner Student release that integrates with Recruiter</td>
<td><strong>Banner Student Release Guide</strong></td>
</tr>
<tr>
<td>Information about Banner Event Publisher that integrates with Recruiter</td>
<td><strong>Banner Event Publisher Release Guide</strong></td>
</tr>
<tr>
<td>Installing and setting up the e-Commerce Payment Gateway</td>
<td><strong>Payment Gateway Installation Procedures</strong></td>
</tr>
<tr>
<td><strong>Configuration and User Information</strong></td>
<td></td>
</tr>
<tr>
<td>Configuring Recruiter for your institution</td>
<td><strong>Recruiter Configuration</strong></td>
</tr>
</tbody>
</table>
Table 1: Additional Sources of Information (cont’d)

<table>
<thead>
<tr>
<th>Type of Information</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Styling the Recruiter external website for your institution</td>
<td>Styling the Recruiter Website</td>
</tr>
<tr>
<td>Specific Recruiter concepts and tasks</td>
<td>Recruiter Online Help</td>
</tr>
<tr>
<td></td>
<td>In Recruiter, in the Navigation Pane, click Workplace. In the Recruiter Help section, click Help Articles. To view the Table of Contents, click the Help tab, and then click Recruiter Help.</td>
</tr>
<tr>
<td>Specific Microsoft Dynamics CRM concepts and tasks</td>
<td>Microsoft Dynamics CRM Online Help</td>
</tr>
<tr>
<td></td>
<td>In Recruiter, click File &gt; Help &gt; Contents (or click Help on This Page for context-sensitive help).</td>
</tr>
</tbody>
</table>
About Recruiter

In This Chapter

This chapter provides an overview of Recruiter. Table 2 lists the topics covered in this chapter.

Table 2: Topics in This Chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Recruiter</td>
<td>20</td>
</tr>
<tr>
<td>Admissions Terminology</td>
<td>23</td>
</tr>
<tr>
<td>Recruiting and Admissions Process</td>
<td>24</td>
</tr>
<tr>
<td>Application Integration Points</td>
<td>25</td>
</tr>
</tbody>
</table>
About Recruiter

Ellucian Recruiter is a web-based recruiting tool that is built on a Customer Relationship Management (CRM) philosophy and platform. CRM is a strategy for managing and nurturing a company’s interactions with customers, clients, and sales prospects. A CRM system, such as Microsoft Dynamics CRM, is designed to be flexible with business processes and to enable users to adapt more quickly to changing practices and environments.

Microsoft Dynamics CRM allows you to perform and automate certain business tasks. With CRM, you can do the following:

- Access information about business records in one place.
- Track activities, e-mails, and correspondence with contacts.
- Store detailed notes and history.
- Generate reports.
- Manage leads (suspects) and contacts (prospects).
- Create marketing lists.
- Track campaigns, cost, return on investment (ROI), etc.
- Manage business processes around related tasks.

Recruiter leverages the technology of Microsoft Dynamics CRM to enhance the recruitment capabilities of your Admissions office and staff. Recruiter extends the native Microsoft Dynamics CRM functionality to provide a recruiting and enrollment operations platform, a prospective student website with online event registration and applications, and a marketing and communications console.

Recruiter helps you build strong, lasting relationships with your prospective students through a customizable prospect and applicant experience. Additionally, your management and recruitment staff can more easily manage the recruiting and admissions process details with features such as dynamic communication tools, address cleansing, enhanced event marketing and management, and real-time operational reporting.

Recruiter also complements the existing functionality of ERP systems like Banner and Colleague. Recruiter is designed to integrate with them, but it can also be used independently.
ERP and CRM Systems in the Recruiting and Admissions Process

An ERP system, or Enterprise Resource Planning system, is an integrated, software system used to manage internal and external resources. An ERP system focuses inward and allows the institution to coordinate student, finance, accounting, human resources, and advancement business strategies. The success of an ERP system relies on all staff adhering to business processes defined by the institution. Using an ERP system to manage recruiting allows the Admissions office to enforce strict business practices, but an ERP system also requires institutional control over the recruitment process.

Figure 1: ERP System

In contrast, a CRM system is customer-centered and focuses on the external business. With a CRM system, recruitment responsibilities are decentralized and distributed to staff members. It gives staff the ability to manage and personalize relationships as opposed to following ERP-driven processes. A CRM system is designed to allow business processes to change as necessary with the market.
How Recruiter Works with Your ERP System

Recruiter does not replace an ERP system’s admissions functionality, where certain admissions functions, such as financial aid and enrollment, must be performed. However, because ERP systems have rudimentary recruitment functions, Recruiter focuses on the initial recruitment process.

Recruiter can be used for all recruitment functions. These functions include managing common third-party imports, communicating with prospective students to encourage them to apply and submit a completed application, and managing prospect and application data before an admissions decision is made. After an application is submitted, the application folder has been reviewed, and an admissions decision has been proposed, this information can be transferred from Recruiter to your ERP system so that any non-recruitment admissions functions and additional communications can be performed in your ERP system. Data is ready to be passed from Recruiter to your ERP system when an application is considered complete in Recruiter. In this way, Recruiter works hand-in-hand with the existing admissions processes of your institution.
Admissions Terminology

Admissions staff across all institutions share the purpose of recruiting prospective students. However, the process and the words they use to describe their business may differ. The following list describes how specific admissions terms are used in Recruiter and Recruiter documentation:

- A **prospective student** is a general term for a potential student. This term is not specific to a stage in the admissions funnel.
- A **suspect** is a potential student who has not expressed an interest in the institution; however, the institution has determined some level of desirability to have the student attend. Names of suspects often come from purchased lists, such as ACT, the National Research Center for College & University Admissions, or The College Board. The relationship is one-way—from the institution to the student; it is not reciprocal.
- A **prospect** is a potential student who has expressed an interest in the institution and for whom the institution has valid contact information. The relationship is two-way between the institution and the student; it is reciprocal.
- An **applicant** is a potential student who has submitted an application to the institution. To complete an application, a student must be a prospect. Recruiter automatically creates a prospect record before a student applies.

Recruiter and CRM Terminology

Where possible, the Recruiter software uses admissions terms instead of the terms that are delivered in Microsoft Dynamics CRM; however, in some cases, the CRM terms are used and are the entity names. The terms are translated below.

**Table 3: Recruiter Terminology**

<table>
<thead>
<tr>
<th>Term in Recruiter</th>
<th>Term in Microsoft Dynamics CRM</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suspect</td>
<td>Lead</td>
<td>A prospective student that has not shown direct interest in an institution.</td>
</tr>
<tr>
<td>Prospect</td>
<td>Contact</td>
<td>A prospective student that has shown some reciprocal interest in the institution.</td>
</tr>
<tr>
<td>Organization</td>
<td>Account</td>
<td>A group external to the institution that is part of the recruitment process, such as a school, camp, church, etc.</td>
</tr>
</tbody>
</table>
Recruiting and Admissions Process

If you think of your recruiting and admissions process as a funnel, as shown in Figure 3, the wide end of the funnel represents the entry point into the process. A subset of suspects actually submit applications and continue in the funnel as applicants. Of your applicants, a portion are admitted and move further into the funnel. The recruiting portion of the funnel ends when students enroll in your institution.

This funnel continues at your institution. Each individual who enrolls is monitored by other offices on campus who work to retain those students until graduation. Students then become alumni and potential life-long supporters and donors.

Figure 3: Admissions Funnel
As students move through the admissions funnel, they pass through stages. These stages, as defined by Ellucian, are listed in Table 4. The number of stages and the name of the stages may vary depending on the institution.

### Table 4: Admissions Funnel Stages

<table>
<thead>
<tr>
<th>Stage</th>
<th>In This Stage...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suspect</td>
<td>The institution has purchased lists of potential students. These individuals have not yet expressed an interest in the institution; however, the institution has determined some level of desirability to have the student attend.</td>
</tr>
<tr>
<td>Prospect</td>
<td>Prospective students have expressed an interest in the institution and the institution has valid contact information for the individuals. A prospect is assigned to a territory, either directly or as a result of the student sending information, such as test scores, to the institution. (Another term used for this stage by institutions includes qualified lead.)</td>
</tr>
<tr>
<td>Inquiries</td>
<td>Prospective students that have inquired at the institution.</td>
</tr>
<tr>
<td>Applications Started</td>
<td>Prospective students have started an application.</td>
</tr>
<tr>
<td>Applicant</td>
<td>Prospective students have submitted an application and they are engaged in the application process.</td>
</tr>
<tr>
<td>Admits</td>
<td>The prospective student's application is accepted to the institution.</td>
</tr>
<tr>
<td>Confirmed</td>
<td>The prospective student has confirmed acceptance to the institution. (Other terms used for this stage by institutions include matriculated and confirmed.)</td>
</tr>
<tr>
<td>Enrolled</td>
<td>The student has made a deposit indicating acceptance of admission. (Other terms used for this stage by institutions include matriculated and confirmed.)</td>
</tr>
</tbody>
</table>

---

**Application Integration Points**

Figure 4 depicts the application integration points among the external website for prospective students, the Recruiter interface in Microsoft Dynamics CRM, and an ERP system.
Figure 4: Application Integration Points
Recruiter Navigation and Interface Basics

In This Chapter

This chapter includes information about navigation and interface options in Recruiter. Table 5 lists the topics covered in this chapter.

Table 5: Topics in This Chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigation and Interface Basics</td>
<td>28</td>
</tr>
<tr>
<td>Recruiter Online Help</td>
<td>34</td>
</tr>
</tbody>
</table>
Navigation and Interface Basics

Because Recruiter is a customization of Microsoft Dynamics CRM, its navigation works like Microsoft Dynamics CRM. Recruiter also uses the Microsoft CRM role-based security. The information that you can view and access in Recruiter depends on your role. All users must be assigned to one or more predefined or custom roles, which are managed by the System Administrator security role. See “Security Roles and User Accounts” on page 69 for more information.

Navigation

The Recruiting Prospects view in Figure 5 shows many of the features of the Recruiter web-based interface. The window is divided into three main parts: the context-specific ribbon across the top, the navigation pane on the left, and the main pane in the center.

Figure 5: Recruiter Navigation Areas

The screen layout stays the same for each area, but content and options vary depending on the area and functionality.
Areas, tabs, and menu options also may differ based on roles and permissions assigned to a particular user. The numbers in the image correspond to the descriptions in Table 6.

**Table 6: Navigation Options**

<table>
<thead>
<tr>
<th>Number</th>
<th>Navigation Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Area menu</td>
<td>The area menu is located in the lower left navigation pane. You can begin navigating in Recruiter by selecting one of the areas.</td>
</tr>
</tbody>
</table>
| 2      | Subarea menu                   | Above the area menu are additional options, called subareas, that are available within the selected area. Subareas are organized into groups. In the Recruiting area example in Figure 5, you can view the People & Organizations group with links to the following:  
  - Recruiting home page  
  - Suspects (a list of names that have not expressed direct interest in your institution)  
  - Prospects (people who have expressed direct interest in your institution)  
  - Organizations (such as high schools or churches)  
  - Other contacts (such as coaches or guidance counselors)  
  - Prospect Plus form  

The next groups provide links for viewing recruiting reports by category, setting up territories and enrollment goals, and defining various recruiting options, such as recruiting teams and academic terms. |
| 3      | Home button                    | The Home button displays the initial home page when you logged into the system, such as the Recruiting home page or the Workplace, depending on your role and the settings at your institution.                                      |
| 4      | Context-sensitive ribbon menu  | Recruiter uses the ribbon and contextual options that are built on Microsoft CRM technology. As you click different areas of Recruiter, the options on the ribbon change, and buttons and features on the ribbon are activated as appropriate. |
| 5      | View                           | A view is a filtered set of records based on some criteria. For example, the default view for the Prospects option in the Recruiting area is My Active Prospects. This view is pre-filtered to only include prospects that are active and for which you are the owner. You can select another view from the drop-down box, such as All Prospects (prospect records that can belong to other Admissions staff), or you can select custom views if any have been created. |
| 6      | Search field                   | In the upper right side of the screen just below the ribbon is a search field. You can search for a record using complete or partial names. To search using partial names, you can use an asterisk (*), which is the wildcard character. |
### Table 6: Navigation Options (cont’d)

<table>
<thead>
<tr>
<th>Number</th>
<th>Navigation Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Main pane</td>
<td>The main pane is the largest portion of the screen. This pane can display a list of records if certain options are selected (for example, Suspects, Prospects, Organizations, or Other Contacts in the Recruiting area). This pane can also display process overviews, landing pages, home pages, and calendars, depending on the Recruiter menu options that are selected in the left navigation pane.</td>
</tr>
<tr>
<td>8</td>
<td>Records counts/page footer</td>
<td>Near the bottom of the page displaying a list of records is a page footer that displays a count of the records on the page, a count of the total records, and a count of the number of records that are selected.</td>
</tr>
<tr>
<td>9</td>
<td>Alphabetical index</td>
<td>At the bottom of the page displaying a list of records, just below the records count, is an alphabetical index. You can click any letter of the alphabet to display a filtered list of records that begin with that letter. You can also click the number symbol (#) to display a filtered list of records that begin with a number. To display all records, you can click the “All” link at the beginning of the alphabet.</td>
</tr>
<tr>
<td>10</td>
<td>Page number navigation</td>
<td>You can navigate to other pages in a list using the First, Previous, Next, and Last icons (when available).</td>
</tr>
<tr>
<td>11</td>
<td>Chart options</td>
<td>To the right of the page is a toggle bar that displays the data on the page graphically in a chart. The chart opens on top of the current window. If no chart is available, you can create a simple chart by selecting chart values from drop-down fields in the Chart Designer. When the Chart Designer opens, you can select the chart type from the Chart Tools tab that is displayed on the ribbon, and then specify other values in the Chart Designer. You can select the right arrow at the top of the chart to close the chart.</td>
</tr>
</tbody>
</table>
**Data Grid**

The data grid is the standard format on pages that list records. From the data grid, you can open records or select records and then perform actions from the menu or ribbon. Data that is displayed in a grid format can also be sorted, searched, and refreshed.

**Figure 6: Data Grid Example**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>You can open a record that is displayed in a grid by selecting the check box to the left of the record and clicking <strong>Edit</strong>, or by double-clicking the white space of a record. Clicking the white space of a record once also selects the check box. Clicking a specific link on a record will open the record associated with that link, which might not be the record in the grid.</td>
</tr>
<tr>
<td>Sort</td>
<td>You can sort data that is displayed in a grid in alphabetical order by clicking on the column heading. To sort a column in reverse alphabetical order, you can click the column heading a second time. The up or down arrow next to the column heading title indicates the current sort order for that column.</td>
</tr>
</tbody>
</table>
Advanced Find

Advanced Find is a native function of Microsoft Dynamics CRM that allows you to narrow the parameters for a search. The Advanced Find feature is accessible from the ribbon on the main tab in most Recruiter areas (see Figure 7).

The Advanced Find feature helps you understand the structure of data within a Recruiter area or locate a specific record. You can use the Advanced Find feature to view details about entities, fields, and values in Recruiter.

Figure 7: Advanced Find

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td>In the upper right side of the screen just below the ribbon is a search field. You can search for a record using complete or partial names. To search using partial names, you can use an asterisk (*), which is the wildcard character.</td>
</tr>
<tr>
<td>Refresh data</td>
<td>You can click the Refresh (Refresh) icon at the end of the column header row to refresh the data that is displayed.</td>
</tr>
</tbody>
</table>

Figure 8 shows an example of the Advanced Find window. Default settings are dependent upon the area from which you accessed Advanced Find. You can change these or click New to create a new search.

The Advanced Find feature allows you to select the entity and specific conditions on which you want to search, and then displays a list of results. You can also group options in your search so that only records or activities
that match either *all* or *any* of the grouped conditions are displayed. From the results, you can access additional details or records as needed, or make changes to your search criteria to get the results you want.

You can also save your search as a saved view to use again later. By default, any new view is created as a personal view and is not available to other Recruiter users, unless it is shared. Both personal and shared views are displayed in the Advanced Find window and in the My Views section of the View box of the list page for that record type.

For more information, see the *Create, edit, or save an Advanced Find search* and *Work with saved views* articles in the Microsoft Dynamics CRM help.

**Figure 8: Advanced Find Window**
Recruiter Online Help

There are two types of Help available in Recruiter. For Microsoft Dynamics CRM-related concepts and tasks, you can use the Microsoft Dynamics CRM help, which is available in Recruiter from the File > Help > Contents menu. For Recruiter-specific concepts and tasks, you can use the Recruiter help.

The Recruiter Help option opens a Silverlight control with a Table of Contents that is sorted based on the different areas of functionality in Recruiter. The help articles are categorized and ordered within each Table of Contents book. Figure 9 is an example of the Recruiter help and how to access the Table of Contents.

Figure 9: Recruiter Help

[Image of Recruiter help interface]
You can also access Recruiter help articles directly from the Workplace area. In the Navigation Pane, click **Workplace**. In the Recruiter Help section, click **Help Articles**. From this view, you can sort the Recruiter help articles or use search options to locate articles on a particular topic. You can also access the Table of Contents for the Recruiter help from this area to view the sorted display of help articles. To locate the Table of Contents, click the **Help** tab, and then click **Recruiter Help**.

**Figure 10: Recruiter Help Articles in the Workplace Area**

<table>
<thead>
<tr>
<th>Number</th>
<th>Subject</th>
<th>Language</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>KBA-0004-45F3...</td>
<td>Administration</td>
<td>English(US)</td>
<td>Create Custom Recruiter Document...</td>
</tr>
<tr>
<td>KBA-0005-48HL...</td>
<td>Administration</td>
<td>English(US)</td>
<td>About ERP Integration</td>
</tr>
<tr>
<td>KBA-0004-94M5...</td>
<td>Administration</td>
<td>English(US)</td>
<td>Create a Workflow Schedule</td>
</tr>
<tr>
<td>KBA-0009-45F3...</td>
<td>Administration</td>
<td>English(US)</td>
<td>Define Rules for Duplicate Detection</td>
</tr>
<tr>
<td>KBA-0006-48H5...</td>
<td>Administration</td>
<td>English(US)</td>
<td>Security Role Information in Recruiter</td>
</tr>
<tr>
<td>KBA-0011-48H5...</td>
<td>Administration</td>
<td>English(US)</td>
<td>About Sending Bulk E-Mails</td>
</tr>
<tr>
<td>KBA-0001-48H5...</td>
<td>Admissions Office</td>
<td>English(US)</td>
<td>Create Recruiting Periods</td>
</tr>
<tr>
<td>KBA-0002-48H5...</td>
<td>Admissions Office</td>
<td>English(US)</td>
<td>Create Recruiting Teams</td>
</tr>
<tr>
<td>KBA-0001-48H5...</td>
<td>Application Folder</td>
<td>English(US)</td>
<td>Assigns and Routes an Application Fold...</td>
</tr>
</tbody>
</table>
Recruiter Areas

In This Chapter

This chapter includes information about features and functionality of each of the Recruiter product areas. Table 8 lists the topics covered in this chapter.

Table 8: Topics in This Chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recruiter Areas</td>
<td>38</td>
</tr>
<tr>
<td>Workplace</td>
<td>39</td>
</tr>
<tr>
<td>Recruiting Area</td>
<td>40</td>
</tr>
<tr>
<td>Campaigns Area</td>
<td>47</td>
</tr>
<tr>
<td>Travel and Events Area</td>
<td>51</td>
</tr>
<tr>
<td>Applications Area</td>
<td>55</td>
</tr>
<tr>
<td>Recruiting Imports Area</td>
<td>60</td>
</tr>
<tr>
<td>ExactTarget Area</td>
<td>63</td>
</tr>
<tr>
<td>Settings Area</td>
<td>65</td>
</tr>
</tbody>
</table>
Recruiter Areas

This section includes highlights of each of the major areas in Recruiter. These areas are available from the left navigation pane of the Recruiter interface. For detailed information about the features of each area and procedures for completing tasks in each of the areas, see the Microsoft Dynamics CRM help, the Recruiter help, and the Recruiter Configuration manual.

Recruiter has the following areas:

- Workplace
- Recruiting
- Campaigns
- Travel & Events
- Applications
- Recruiting Imports
- ExactTarget
- Settings

When you click any area, the following occur:

- A home page opens in the main pane. This is the area’s landing page. Where applicable, home pages use Silverlight technology to present business processes and data so that you can quickly see summary information about the functions within that area.
- The top left navigation pane populates with area-specific menu options that are frequently used. The information in this area changes depending on the role of the user and the area that is being viewed.

Note: Within Recruiter, you can take multiple paths to get to the same details. For example, you can open a prospect record from both the Workplace and the Recruiting area.
When you log into Recruiter, the Workplace is displayed (see Figure 11). This is your starting point for day-to-day operations. Your common tasks and activities are listed in the top left navigation pane. From this area, you can do the following:

- Access various dashboard views.
- View your activities, such as e-mails that need to be sent and phone calls that need to be made.
- View system announcements.
- Access duplicate detection details, active applications, and system reports.
- Access common recruiting areas, such as prospects, suspects, organizations, and the Prospect Plus form.
- Access the Recruiter help articles.

**Figure 11: Workplace, Dashboard Example**
Recruiting Area

The Recruiting area provides information about the various admissions funnel stages and allows you to do the following:

- Create recruiting teams and periods.
- Manage territory criteria.
- Manage enrollment goals.
- Create and manage suspects and prospects.
- Assign prospects, high schools, and other organizations to territories and recruiters.
- View prospect ratings.

For more information about these options, see “Managing Enrollment Goals” on page 93 and “Managing Suspects and Prospects” on page 103.

Recruiting Home Page

From the Recruiting Home option, you can view a page that helps you track goals by territory and see recent activity for your recruiters (see Figure 12 on page 42).

The Recruiting home page provides an aggregate view of recruiting efforts. The Recruiting home page is not a dashboard. Dashboards are customizable. On the Recruiter home page, images and the names of the stages in the funnel cannot be changed. The intention of the home page is not to take action; users should take action in other areas of the site.

From the Recruiting home page, you can do the following:

- Filter based on teams and territories.
- View the number of individuals in each stage of the recruitment process using the Main chart.
- View the number of prospects with applications in various stages using the Applicants chart.
- Document progress with recruitment efforts using the Actual/Goals grid display.
The following details apply to the Recruiting home page:

- The Recruiting Home Director Access security role can view data for all recruiters’ territories on this page. Another security role must also be granted that allows access to the accompanying prospect and territory data (such as the Director of Admissions security role).

- The Recruiting Home Access security role can view data for only the current user’s recruiting territories on this page. Another security role must also be granted that allows access to the accompanying prospect and territory data (such as the Recruiter security role).

- The date and time stamp indicates the last update to the data based on the schedule of the “Update Enrollment Goals” workflow.

- The Re-Calculate button recalculates the counts for all enrollment goals and is only available to the Recruiting Home Director Access security role.

- The Set as Default button sets the chart view that will be displayed by default when the Recruiting home page is first accessed.

For more information about security roles, see “Security Roles and User Accounts” on page 69.

Note: Data for the Recruiting home page is pulled from Recruiter and occasionally from Banner or Colleague.

Note: The Applicants count on the Main chart represents the number of prospects with submitted applications. You can click the section of that chart to view a detailed funnel of all prospect application statuses.
Recruiting Reports

Multiple reports are delivered for recruiting. Recruiting reports can be accessed in the top left navigation pane under the following categories: Suspect Reports, Prospect Reports, Organization Reports, Territory and Goal Reports, and All Reports. For more information about the purpose of each report, see the “Reports” section of the Recruiter help.

Territory Management

A territory is a set of criteria that divides prospects into subsets that can be managed and reported on independently. Territories can also be used to organize high schools and other organizations into managed groups.

Most of the time a territory corresponds to a geographic region, but not always. Non-geographic territories tend to cover special recruitment interests, such as athletics or honors.
Recruiters are assigned to particular territories and their mission is to attract and enroll prospective students. A recruiter’s territories define the scope of the recruiter’s responsibilities. Prospects are assigned to recruiters by their membership in a recruiter’s territory. The recruiter becomes the prospect’s primary contact at the institution during the recruiting period.

Creating a territory consists of the following tasks:

- Create your recruiting periods.
- Create your recruiting teams.
- Create the territory.

Each territory has a unique name and code and is assigned to a recruiter and recruiting team. After you have created the general information for the territory, you can then create prospect and organizational criteria, which is used to automatically assign prospects and organizations to the territory.

Criteria can be based upon demographic information or on a view. Depending upon how you define your criteria, a person or organization may qualify for multiple territories. The order of precedence you give to a territory determines which territory the person is ultimately assigned to. Also, if a person or an organization does not meet the criteria on any of the territories, they are assigned to the default territory.

During the course of a recruiting period, you might find it necessary to create additional territories or reassign recruiters. Recruiter provides the option to clone an existing territory, reevaluate the criteria, and update members of a territory. You can also manually change the recruiter and territory assignment, if necessary.

For more information about procedures related to territories, see the “Admissions Office Management > Recruiting Territories” section of the Recruiter help.

**Enrollment Goals**

*Enrollment goals* define a target number of prospective or enrolled students for a given recruiting period. This includes targets for the entire prospect pool and targets for specific subsets, such as undergraduates or honors students. There are two different types of enrollment goals: one is for a territory and the other is for a reporting period. The Recruiting home page allows you to view the progress of each type of enrollment goal.
For more information about procedures related to enrollment goals, see the “Admissions Office Management > Enrollment Goals and Ratings” section of the Recruiter help.

**Suspect Management**

The suspect management area allows you to manage a list of suspects that can later be targeted by recruitment campaigns. You can either enter suspects manually in this area or import suspects from vendors, including College Board, ACT, and NRCCUA, in the Recruiting Imports area. For more information, see “Recruiting Imports Area” on page 60.

After you have created all of your suspects for a reporting period, you can begin to cultivate your relationship with the suspects by building marketing lists, campaigns, and events based on your suspect pool.

For more information about procedures related to suspect management, see the “Suspects and Prospects > Suspects” section of the Recruiter help.

**Prospect Management**

The goal of prospect management is to build a relationship with prospective students that will ultimately result in meeting the institution’s enrollment targets. You can enter prospects manually, convert suspects to prospects, or import prospects; or they can be created automatically by the system. For more information, see “Recruiting Imports Area” on page 60 and “Managing Suspects and Prospects” on page 103.

You can review prospect records in the Recruiting area by selecting Prospects in the top left navigation pane. A list of prospect records is displayed. You can review any prospect record by clicking the name associated with that record.

The prospect record captures information related to the prospective student, including contact information, demographic data, family information, unofficial test scores, prospect and status information, and more. You can also use the left navigation pane within the prospect record to view additional related information about the prospect, such as extracurricular activities, high school academic history information, academic interests, official test scores, and more.
Recruiter also provides a summary view, or profile, of a prospective student that enables you to get a quick idea of where the student stands in your recruitment process. The profile displays an overview of the prospect record including contact details, admissions funnel stages completed, application status, recent communications, and icons that indicate an interest in financial aid, housing, applying for scholarships, honors programs, and study abroad programs. Figure 13 is an example of a prospective student’s profile.

For more information about procedures related to prospect management, see the “Suspects and Prospects > Prospects” section of the Recruiter help.

**Figure 13: Example of a Prospective Student’s Profile**
Convert Suspects to Prospects

As you build a relationship with a person, you can move that person from a suspect to a prospect. This allows you to move the person through the admissions funnel and to capture additional information. You have the option of moving individual suspects or a group of suspects at one time.

During the recruitment process, suspects can also automatically become a prospect if they register on your website, submit an application, or register for an event. These individuals do not need to be moved from suspect to prospect.

For more information, see the Move Suspects to Prospects article in the Recruiter help.

Organization Management

The goal of the organization management area is to manage organizations with which your institution has contact during the recruitment process. You can have many different high schools, colleges, corporations, or other organizations that are a potential source of prospective students for your institution. Any organization from which you recruit or attract prospective students can be identified as an organization in Recruiter. After you have created an organization, you can add contact information for the people who you communicate with at the organization. This includes people you contact when recruiting a prospective student.

For more information about procedures related to organization management, see the “Organizations” section of the Recruiter help.
Campaigns Area

Campaigns are containers for all of the information, planning tasks, and campaign activities that are needed to manage marketing campaigns. The Campaign area allows you to set up and manage recruitment campaigns to market your institution to prospective students.

For more information about your communications options, see “Managing Communications Options” on page 167.

Campaigns Home Page

From the Campaigns Home option, you can view a page that helps you manage all details of your campaigns (see Figure 14).

From the Campaigns home page, you can do the following:

- Manage and review campaign activities, review and manage marketing lists, view your upcoming appointments and events, generate reports, manage campaign responses, and view and manage the Campaign Calendar.
- View campaign reports. Multiple reports are delivered for campaigns. Campaign reports can be accessed in the top left navigation pane. For more information about the purpose of each report, see the “Reports” section of the Recruiter help.
Campaigns

Campaigns typically consist of a series of events, advertisements, and direct mailings that promote your institution to prospective students or organizations. Creating a campaign starts with entering some general information including a name, status, type, goals, and financial details. You can then define the various tasks and activities associated with the campaign and assign them to recruiters and other staff members. These distributed tasks and activities can include sending e-mails, mailing viewbooks, or calling prospective students.

If you are automatically distributing campaign activities, you can first create activity templates that you later add to campaign activities. Activity templates contain all of the information that is needed for campaign activities to be distributed automatically. You can create the activity templates before you start your campaign, and add them to your campaign activities when you are ready to begin distributing them.
As your campaign progresses, you can track responses to campaign activities, either manually or automatically depending on the type of activity. Campaign responses allow you to record information and details that are received from prospective students for a specific campaign activity. From this information, you can convert existing suspects to prospects.

You can also create catch-up processing on campaign activities. Catch-up processing allows you to complete campaign activities for any members that are added to a marketing list associated with an activity after the campaign has begun. For example, if you have an activity to send a new prospect a “welcome to our website” e-mail and you have catch up processing enabled, when new prospects are added to the marketing list, catch-up processing can create additional campaign activities so that you can send the e-mail to the new prospects.

At any time during a campaign, you can view campaign details on the color-coded Campaign Calendar. The Campaign Calendar provides a quick look at upcoming activities, appointments, and events. You can sort the Campaign Calendar by a variety of delivered views, such as by My Campaigns, All Campaigns for Current Fiscal Year, or Launched Campaigns.

For more information about procedures related to campaigns, see the “Recruiting Campaigns > Recruiting Campaigns” section of the Recruiter help. You can also view the Planning Campaigns article in the Microsoft Dynamics CRM help.

**Drip Campaigns**

Drip campaigns are a type of campaign that allow you to schedule the distribution of campaign activities with specific offsets. For example, you can send a welcome e-mail on day 1 of the drip campaign, send an information packet on day 5, make a phone call on day 14, and send a thank you e-mail on day 15.

You can assign either static or dynamic marketing lists to drip campaigns. If members are added or removed from a marketing list during a drip campaign, Recruiter can manage the changes to your marketing list and assign the appropriate catch-up activities. For example, if your institution is in the middle of a drip campaign, and a prospect’s status changes to “Admit,” you can remove the prospect from the marketing list and run a scheduled workflow so that the prospect will no longer receive the remaining drip campaign activities. Likewise, if you have already started a drip campaign, you can add additional prospects to the campaign, define campaign catch-up processing on the initiating activity, and the appropriate catch-up activities will be identified for the remaining drip campaign activities.
Drip campaign activities are also displayed on the Campaign Calendar, along with any catch-up activities for the drip campaign.

For more information, see the Create Drip Campaigns article in the Recruiter help.

**Marketing Lists**

Marketing lists are groups of prospective students or other contacts — for example, an individual who registers for an event. Other contacts can also be suspects or people who are employees of a feeder organization to your institution.

You can associate marketing lists with campaigns, create quick campaigns for the records in one or more marketing lists, and export marketing lists to Microsoft Office Excel. Marketing lists also include the ability to automate the process of adding and removing members from a marketing list (referred to as dynamic marketing lists) and to add members to a marketing list based on proximity to an address.

For more information about procedures related to marketing lists, see the “Recruiting Campaigns > Marketing Lists” section of the Recruiter help. You can also view the Creating and Managing Marketing Lists article in the Microsoft Dynamics CRM help.
Travel and Events Area

Recruiting events are intended to attract prospects and help move them through the recruiting and admissions funnel. The Travel and Events area allows you to track and manage your recruiting-related travel and events. You can track your travel details and costs and measure the success of events. By tracking the number of prospects that attended various events, you can use the data to establish a probability of outcomes. For example, you could answer, “If prospects attend a tour of the campus, how likely are they to become enrolled students?”

Travel and Events Home Pages

The Travel and Events area offers two home pages: one for trips and one for events.

Trips Home Page

From the Trips Home option, you can view a page that helps you manage all travel-related details (see Figure 15).

From the Trips home page, you can do the following:
- View the Overview of Trip Performance chart to analyze the number of enrolled students compared to the cost of your trips.
- View the Performance Breakdown grid for a list of trip details by date.

Events Home Page

From the Events Home option, you can view a page that helps you manage all details of your events (see Figure 16).

From the Events home page, you can do the following:
- Create and manage your event,
- Create and manage event locations, codes, hosts, and filtered lists.
- View a scrolling list of upcoming events on which you can drill down and view details.
- Filter events by code, location, or date.
Recruiter Areas

Figure 15: Trips Home Page

Figure 16: Events Home Page
Travel and Events Reports

One report is delivered for trips. The Upcoming Trip Itinerary report displays basic information around a collection of events pertaining to a single trip.

Multiple reports are delivered for events. Events reports can be accessed in the top left navigation pane under the Event Management section. For more information about the purpose of each report, see the “Reports” section of the Recruiter help.

Event Management

Most events are planned in advance and involve staff, faculty, and even students as hosts representing the institution. Prospective students are the typical invitees, but they may bring guests. The emphasis is on personalized interactions that highlight the institution’s unique culture and offerings. Events can be divided into two categories: simple events and recurring events. Simple events occur one time, while recurring events are repeated on a specific schedule over a specific period of time. For example, you might have a financial aid seminar event or a recurring event of campus tours.

Creating an event is a multistep process that requires an event to be approved before it can published on the external website. After information has been added for the event, including the registration information and event hosts, the event is ready for approval. To approve an event, the status must be set accordingly. The person with the role to approve events is sent a task to approve the event. That person can decide whether to promote the event on the website by adding information in the Web Promotion section on the event.

For more information about procedures related to preliminary event setup tasks, see the “Travel & Events > Event Setup” section of the Recruiter help. For more information about procedures related to creating and managing events, see the “Travel & Events > Events Information” section of the Recruiter help.

Event Communications

You can invite prospective students to events, send follow up communications to anyone who has registered, or send thank you notes to anyone who attended. To be able to send any correspondence to participants of an event, you must use a campaign activity. You can create an activity in a campaign
specifically for the purpose of event communication. Doing this allows you to track the responses to your correspondence and use the features of marketing lists. For more information, see the *Add a Campaign Activity to a Campaign* article in the Recruiter help.

**Travel Management**

You can organize events into a trip for a recruiter. A *trip* is a series of events that a recruiter attends or hosts for the purpose of recruiting prospective students. You can use the functionality in Recruiter to organize a trip, track the event participants, and analyze your return on investment (ROI) for the event. As you fill out the information for the trip, the event metrics will provide more information based on the participants who attend each event. In addition to the event metrics, Recruiter includes a dashboard that provides details about each trip.

Included with each trip is a series of ROI metrics that allow you to analyze the success of a trip. These metrics are calculated using the “Update Event Metrics” workflow. Fields on the Event Participant entity track the funnel status of an event’s participants. Based on these numbers (how many prospects attended, how many attendees eventually applied, etc.), reporting metrics, such as the admissions percentage and enrollment yield rate, can be calculated. The results of this workflow can be viewed on the Trips home page, the Trips form, and the Events form.

For more information about procedures related to travel management, see the “Travel & Events > Trips” section of the Recruiter help.
Applications Area

Recruiter works in conjunction with the online application on the Recruiter external website, receiving applicant information in real-time. The application data is stored in Recruiter and can be exported to the ERP system for an admissions decision after the application is complete, or the proposed admissions decision can be made in Recruiter. The Applications area allows you to manage, view, coordinate reviews of, and report on applications.

For more information about your applications options, see “Managing Applications and Application Reviews” on page 119.

Applications Landing Page

From the Applications landing page, you can search for specific application types and subsets (see Figure 17). In addition, you can use the following options in the top left navigation pane:

- Access application folders that allow you to open, assign, and review applications and supplemental information to make proposed admissions decisions.
- Review or enter supplemental information that was submitted with the applications.
- Export the completed applications to Banner or Colleague (or another ERP system).
- View application reports. Four reports are delivered for applications. Application reports can be accessed in the top left navigation pane. For more information about the purpose of each report, see the “Reports” section of the Recruiter help.
- Configure application types, supplemental information types, and supplemental items.
Online Applications

The goal of the online application process is to get completed applications that will yield as many enrollments as possible. It is important that the online application process be a positive experience for the prospect in order to increase the likelihood of enrollment. The first priority of the online application process is to collect complete and accurate information to support an admissions decision. The second priority is to make the experience as easy and positive as possible for the prospect.

The first step in creating an online application is to create the application type and form. As a part of Recruiter, several templates are delivered that you can use as a starting point for creating your application form. When you are creating an application form, you can first select the template that you want to use in the Originating Application Type field. Figure 18 is an example of creating an application form.

**Note:** Delivered Recruiter templates can be overwritten in future releases; therefore, if you want to make changes to a delivered template, you should create a new application type first and then customize the application form.
Figure 18: Example of Creating an Application Form

After you have entered the general information, you can use the form designer to modify the template to meet your institution’s requirements. The form designer lets you add and remove fields, sections, and tabs. When you are satisfied with the application form, you can publish the form and add the form to your external website. After the form is available on the website, prospective students can begin applying to your institution. You can have multiple active application forms at any given time.

When prospective students apply, their applications go through multiple statuses. The statuses include Started, Submitted, Marked Complete, and Withdrawn. Depending upon the status, certain options and actions are allowed in Recruiter. Applications that are entered on your external website can be managed and edited as needed in Recruiter; however, Recruiter does not support edits to applications that have been imported.
You can also collect supplemental information for an application. Depending upon the type of supplemental information, you can have prospective students complete or upload information on the website, or you can have them mail the information to your institution. In the latter case, when you receive the supplemental item, you can mark it as received, which will allow you to mark the application as complete.

You can export the application to your ERP system where the admissions decision can be recorded, or you can keep the application in Recruiter for the admissions review and then export it to your ERP system with a proposed admissions decision. Applications can be exported one at a time or in a batch depending upon your institution’s policies.

For details about the application configuration process, see the “Configuring Applications” section of the Recruiter Configuration manual.

For more information about procedures related to preliminary application setup tasks, see the “Applications > Application Types” section of the Recruiter help. For more information about procedures related to creating and managing applications and supplemental submissions, see the “Applications > Applications” section of the Recruiter help.

Application Folder

Recruiter provides functionality that allows you to conduct a review for an application. An application folder includes information about a prospect, a cover sheet, an application, and any supplemental items.

The information in the application folder is provided for informational purposes only to allow a person to review the application and provide a proposed admissions decision about the application. Using a review form that can be customized for each application type, you can assign individual people or a group of people to review each application, comment on the application, and record their admissions decisions.
The following options are available for customizing the application folder process for your institution:

- Create different application folder review forms for different application types.
- Create different cover sheet forms for different application types.
- Create additional application folder statuses.
- Create a workflow to set the application folder status.
- Create a workflow to set the application folder owner.
- Create a workflow to assign application folder reviewers.

For more information about procedures related to application folders, see the “Applications > Application Folder” section of the Recruiter help.
Recruiting Imports Area

The Recruiting Imports area allows you to manage and import a number of delivered suspect lists, prospects, test scores, and applications from a variety of sources. These imports provide information to help you identify prospective students and to help you complete applications for prospective students. For example, you can import:

- Suspect lists from ACT, College Board, and NRCCUA.
- Prospects from the Common Application or other vendors using the general prospect import process.
- Test scores from ACT, College Board, Educational Testing Services (ETS), or other vendors using the general test score import process.
- Applications from the Common Application or other vendors using the general application import process.

Ellucian delivers and maintains templates that assist with collecting vendor data. Ellucian collects the vendor-specific file, and then passes the data through a vendor-neutral file so that the data can be imported into Recruiter.

Recruiting Imports Landing Page

From the Recruiting Imports landing page, you can select and import suspect lists from vendors (see Figure 19). In addition, you can use the following options in the top left navigation pane:

- Select and import prospects, test scores, and applications from vendors.
- View statuses, details, and specific errors of import jobs.
- View suspect, prospect, test score, and application staging records. Staging records are intermediary files that allow you to verify and correct data if necessary prior to creating a record in Recruiter.
- Map unassigned test scores with prospects, using the Prospect Matcher.
- Define suspect, prospect, and test score import contract mappings to ensure that the codes that the vendor uses for certain data map to codes that you are using in Recruiter.
- Define anticipated start term mappings for suspect list, prospect, and test score imports.
- Create an application data catalog. Catalogs map the application type and import source to the data map that you are using for the import. If you are using the general application import process, you will need to create an application data catalog.
- View duplicate detection details and rules.
- View or create data maps. If you are using the Common Application supplement import, using any of the general import processes, or creating custom imports, you will need to create data maps.

**Figure 19: Recruiting Imports Area**

Recruiting Import Process

When you import data into Recruiter using the delivered recruiting imports, the data is first moved to staging records. The staging records hold the raw data for the imports. The type of import determines how the data is processed, evaluated for duplicate records, and moved into a suspect or prospect record.

Each type of import requires a certain amount of setup to ensure that the data that is imported is correctly formatted for your institution’s needs and so that the records are properly created in Recruiter. After all setup is complete, you can click the appropriate Import Management subarea in the Recruiting Imports area to begin an import process. It is recommended that you review all steps associated with each import (in the Recruiter help) before starting this process.
Additionally, each import handles duplicate data in a specific way, and you might need to resolve duplicate data in some cases. For more information, see “Recruiter Functions That Require You to Resolve Duplicate Data” on page 208.

For details about setting up the general application import or Common Application import processes, see the “Setting Up a General Application Import” or “Importing the Common Application” sections of the Recruiter Configuration manual. For details about defining suspect, prospect, and test score import contract mappings, setting up the general prospect or test score imports, or creating custom imports, see the “Configuring Recruiter Imports” section of the same manual.

For more information about how data is processed for each delivered import and for procedures related to delivered imports, see the “Recruiting Imports” section of the Recruiter help.
**ExactTarget Area**

ExactTarget® is an e-mail configuration and interactive-marketing provider. E-mails and the templates generated by ExactTarget are customizable.

The ExactTarget area sends and tracks visually appealing marketing material, such as e-mails with institutional logos and images. Recruiter also allows links in the communications to track specific information (such as, if a prospect opened the link, the length of time the prospect stayed on the link, etc.).

For more information about your communications options, see “Managing Communications Options” on page 167.

**ExactTarget Landing Page**

From the ExactTarget landing page, you can view the Accounts entity (organizations) to which you can send ExactTarget e-mails (see Figure 20). In addition, you can use the following options in the top left navigation pane:

- View the Contacts entity (prospects), Leads (suspects), or marketing lists to which you can send ExactTarget e-mails.
- View campaigns for which you can send ExactTarget e-mails.
- Create or track ExactTarget sends, responses, and processes.
- Access system reports. The Recruiter reports that are most useful for ExactTarget are the campaign reports. For more information about the purpose of each report, see the “Reports” section of the Recruiter help.
- Specify ExactTarget configuration settings, such as account settings, user mappings, and field mappings.
ExactTarget Configuration and Features

The ExactTarget features in Recruiter work in conjunction with the features on the ExactTarget website. For example, the recipient data is maintained in Recruiter and you can set up, send, and track e-mails in Recruiter as part of your recruitment campaigns; however, you must draft e-mails on the ExactTarget website.

For the ExactTarget e-mails to work properly and pull the correct dynamic values from Recruiter, you must map certain settings between the two systems. This includes setting up user and field mappings that map the values used on the ExactTarget website with those used in Recruiter. After you have configured these settings, you can set up and send ExactTarget e-mails from Recruiter, either manually or as part of workflows. You can also set up ExactTarget e-mails to work with Quick Forms on your external website.

For details about configuring ExactTarget or setting up and sending ExactTarget e-mails, see the “Configuring ExactTarget” section of the Recruiter Configuration manual. For more information about creating, sending, and tracking e-mails, see the documentation provided by ExactTarget.
Settings Area

The Settings area provides quick access to important system-wide settings. Most settings in the Settings area are configured during the installation.

Settings Home Page

From the Settings home page (see Figure 21), you can do the following:

- Manage user accounts for the external website.
- Create and manage application types.
- Create and manage real-time configurations for custom fields exported to your ERP system.
- Create and manage export configuration settings.
- Create and manage API configurations.
- Create URLs for the external website.
- Configure the sources that are used in Recruiter for external website actions.
- Select the views to be used as criteria for suspect auto-qualification.
- Identify your institution for reporting purposes.
- Update configuration settings for primary test scores, StrikeIron® casing (integrated tool that verifies address and e-mail addresses), and unit of measurement.
- Select the configuration settings that identify the e-mail template and e-mail sender for account verification e-mails.

In addition, you can use the following options in the top left navigation pane:

- Use the Administration option to create or update security roles, teams, and field-level security profiles, and to perform other administrative tasks.
- Use the Solutions option to create an unmanaged solution for further customizations.
- Use the Templates option to create e-mail or mail merge templates.
- Use the Processes option to create, activate, or deactivate workflows.
- Use the Data Management option to view duplicate detection settings, rules, and jobs, and to view in-progress import jobs, create data maps for imports, or download existing data import templates.
- Use the System Jobs option to view the status and details of system jobs.
Recruiter Areas

- Use the Workflow Scheduler option to view and create workflow schedules.
- Use the Configuration Settings option to update specific system configuration settings values.
- Use the Validation List Management option to modify specific validation list values.
- Manage eCommerce settings and transactions under the eCommerce Settings group.
- Use the Error Log Entries option under the Extensions group to view system errors.

**Note:** The Event Settings group contains the same settings that are available from the Travel & Events area. The Import Settings group contains the same settings that are available from the Recruiting Imports area. The Recruiting Settings group contains the same settings that are available from the Recruiting area.

**Figure 21:** Settings Home Page

For details about configuration settings, see the “Specifying Recruiter Configuration Settings” section of the *Recruiter Installation Procedures* manual.
For details about configuring Recruiter customizations, creating unmanaged solutions, managing forms (field-level security, validation lists, and external website forms), using workflows or the workflow scheduler, configuring mail merge and e-mail templates, and creating custom imports, see the *Recruiter Configuration* manual.

For details about duplicate detection, see “Managing Duplicate Data” on page 205.

For more information and procedures related to administrative tasks, such as eCommerce transactions and delivered security roles, see the “Administration” section of the Recruiter help.
In This Chapter

This chapter includes information about security roles and user accounts in Recruiter. Table 9 lists the topics covered in this chapter.

Table 9: Topics in This Chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Roles Model</td>
<td>70</td>
</tr>
<tr>
<td>Terminology and Details</td>
<td>71</td>
</tr>
<tr>
<td>Delivered Security Roles</td>
<td>74</td>
</tr>
<tr>
<td>User Accounts</td>
<td>78</td>
</tr>
</tbody>
</table>
Security Roles Model

Recruiter uses the Microsoft Dynamics CRM role-based security model to assign privileges to Recruiter users. Users are assigned roles that have privileges to specific tasks and entities in Microsoft Dynamics CRM. Some entities that are used by Recruiter are native to Microsoft Dynamics CRM, such as Sales (Recruiting) and Marketing (Campaigns), while others have been created as custom entities specifically for Recruiter. Each security role can be granted access to the various native and custom entities as needed.

Figure 22 represents how privileges are assigned to a user in Recruiter. In this example, a user is assigned the security role named “Recruiter.” This role gives the user privileges to create, read, write, append, append to, assign, and share prospect records, but not to delete them. This role also gives the user similar privileges to organization records, but the user is not allowed to create or delete organization records. The privileges are assigned separately for prospects (Contact entity) and organizations (Account entity).

Figure 22: Role-Based Security Privileges
Terminology and Details

The following sections define the terminology and details that you should be familiar with when creating or editing security roles.

Security Roles

A security role contains privileges that delineate a set of actions that can be performed for a specific entity. Security roles can be assigned to individuals or teams. All users must be assigned one or more predefined or custom security roles. For example, the “Recruiter” security role is assigned a set of privileges that are relevant to the tasks that a Recruiter or Admissions Counselor might perform, such as creating, reading, and writing (changing) a prospect (Contact entity) record.

Some security roles do not directly correlate to all of the tasks that an individual in your institution may perform. In these cases, you may assign more than one security role to an individual or copy a security role and then customize it to suit your needs.

Entities

An entity is a structure that is used to maintain data. Most of the entities that you will be managing are Recruiter-delivered entities, such as Applications and Events. These entities are available on the Custom Entities tab of the Security Roles dialog box (see Figure 23). The remaining entities are native to Microsoft Dynamics CRM.

Note: Some native Microsoft Dynamics CRM entities are not used by Recruiter.
Privileges

A *privilege* authorizes the user to perform an action on a particular entity type. Privileges are native to Microsoft Dynamics CRM and cannot be changed. The privileges assigned to each security role are cumulative. As you assign more roles, you add more access. If there is a conflict with a user’s assigned privileges, the least restrictive privileges will prevail. *Table 10* lists available privileges.

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>Create an entity.</td>
</tr>
<tr>
<td>Read</td>
<td>View an entity.</td>
</tr>
<tr>
<td>Write</td>
<td>Make changes to an entity.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete an entity.</td>
</tr>
<tr>
<td>Append</td>
<td>Associate a selected entity to another entity.</td>
</tr>
<tr>
<td>Append To</td>
<td>Associate an entity to the selected entity.</td>
</tr>
</tbody>
</table>
Terminology and Details

Access Levels

The *access level* is the setting on a privilege that determines, for a given entity, who can access records. There are four options: only the owner of the record, all users in the current business unit, all users in the current or child business unit, or all users (see Figure 24). In the Security Roles dialog box, you can click a privilege on an entity to change the access level for that security role.

**Note:** You cannot remove access for a particular record. Any change to a security role privilege applies to all records for that entity.

Miscellaneous Privileges

*Miscellaneous privileges* are those that are not assigned to an entity. They are common tasks that are delivered with Microsoft Dynamics CRM. They are displayed at the bottom of each tab in the Security Roles dialog box, in the Miscellaneous Privileges section. You can either enable or disable these privileges for a security role.

Table 10: Microsoft Dynamics CRM Privileges (cont’d)

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign</td>
<td>Transfer record ownership to another user.</td>
</tr>
<tr>
<td>Share</td>
<td>Give access to a record to another user while keeping your own access.</td>
</tr>
<tr>
<td>Enable/Disable</td>
<td>Give or take away privileges.</td>
</tr>
</tbody>
</table>

**Note:** The Append and Append To privileges work together. The Append privilege allows one entity to attach records to another entity that has the Append To privilege. For example, when you attach a note to a prospect (Contact entity), you must have the Append access rights on the Contact entity and the Append To access rights on the Note entity for the operation to work.

Figure 24: Access Levels
Delivered Security Roles

Recruiter has extended many functions of Microsoft Dynamics CRM to fit the needs of the Admissions office, including security. Microsoft Dynamics CRM is delivered with multiple security roles, most of which are not used by, or recommended for use with, Recruiter.

The following two delivered Microsoft Dynamics CRM roles are those that are recommended for use with Recruiter.

- **System Administrator**: A user who defines and implements system processes at any level.
- **System Customizer**: A user who customizes Microsoft Dynamics CRM entities, attributes, relationships, and forms.

Recruiter is delivered with multiple security roles that tailor security to the most common roles and tasks in the Admissions office. ExactTarget also delivers security roles for ExactTarget functions.

You should not modify Recruiter-delivered roles. If a security role or combination of security roles do not meet your needs, you can copy an existing role and customize it to meet your needs or create new security roles from within an unmanaged solution. When you rename a role that you have copied, it is recommended that you use your client number to identify it as a custom role.

The following is a list of the delivered Recruiter security roles:

- **Administrative Assistant**: The person given this security role should be the person who is responsible for creating, configuring, and managing applications. The Administrative Assistant security role has the ability to create application types, create applications, update any application folders, and create or edit the majority of entities in Recruiter. The Administrative Assistant role does not allow the person is not allowed to override the status of an application, create recruiting teams, create recruiting periods, or use the Recruiter delivered imports.

- **Application Administrator**: The person given this security role should be the person who is responsible for managing prospective student user accounts and integration between applications and your ERP system. The Application Administrator security role has the ability to create and edit the majority of the entities in Recruiter. This includes campaigns, organizations, prospects, and trips. The Application Administrator is not allowed to create applications, create recruiting teams, create recruiting periods, or use the Recruiter delivered imports.

- **Application Folder Owner**: This is a limited security role that allows a person control over any applications they own, and the ability to view all
application folders and reviews. This security role does not allow for a person to create or edit information in Recruiter.

- **Application Folder Reviewer.** This is a limited security role that allows a person to view an application folder where they are assigned as a reviewer and update their review for the application folder. This security role does not allow for a person to create or edit information in Recruiter.

- **Application Status Override Access.** This is a limited security role that should only be given to a person who understands the application statuses and the implications of changing the status.

- **Director of Admissions.** The person given this security role should be the person who is responsible for the overall strategy of the admissions plan. The Director of Admissions has the ability to create and edit the majority of the entities in Recruiter. This includes territories, campaigns, marketing lists, application folders, and prospects. The Director of Admissions security role is the only security role that has permissions to create recruiting periods and teams. The Director of Admissions is not able to import data, create an application, or approve an event.

- **Edit Applications Access.** This is a limited security role that allows a person to edit a submitted or completed application. This security role does not allow a person to create or edit any other information in Recruiter.

- **Event Approver.** This is a limited security role that is only for the staff member who is responsible for approving events. The Event Approver role is not able to import data, create prospects, create applications, or create campaigns.

- **Import Applications Access.** This is a limited security role that is only for the person who is responsible for importing applications. This security role does not allow a person to create or edit any other information in Recruiter.

- **Import ERP Data Access.** This is a limited security role that is only for the person who is responsible for importing ERP data. This security role does not allow a person to create or edit any other information in Recruiter.

- **Import Prospects Access.** This is a limited security role that is only for the person who is responsible for importing prospects. This security role does not allow a person to create or edit any other information in Recruiter.

- **Import Suspects Access.** This is a limited security role that is only for the person who is responsible for importing suspect lists. This security role does not allow a person to create or edit any other information in Recruiter.

- **Import Test Scores Access.** This is a limited security role that is only for the person who is responsible for importing test scores. This security role does not allow a person to create or edit any other information in Recruiter.

- **Prospect Plus Access.** This is a limited security role that allows a person access to the Prospect Plus form where they can create a grid view of prospect information and export the information to a CSV file. This security role does not allow a person to create or edit information in
Recruiter, but anyone with this security role will have access to sensitive information including a prospect's SSN or SIN number.

- **Recruiter.** The person who is given this security role should be the person who is responsible for the recruitment process and guiding prospective students through the process of inquiry to enrollment. The Recruiter security role has the ability to create and edit the majority of the entities in Recruiter. This includes campaigns, organizations, prospects, and trips. The Recruiter is not allowed to create applications, create reporting teams, create reporting periods, or use the Recruiter delivered imports.

- **Recruiting Home Access.** This is a limited security role that allows a person to view data for only the current user's recruiting territories on the Recruiting home page. However, this role does not actually give access to the data; users must also have a security role that gives them access to prospect and territory data (such as the Recruiter security role). If users are only granted this security role, they will not see any data on the Recruiting home page.

- **Recruiting Home Director Access.** This is a limited security role that allows a person to view data for all recruiters' territories on the Recruiting home page. However, this role does not actually give access to the data; users must also have a security role that gives them access to prospect and territory data (such as the Director of Admissions security role). If users are only granted this security role, they will not see any data on the Recruiting home page.

- **Trip Home Access.** This is a limited security role that allows a person access to the Trips Home page in Recruiter. This security role does not allow for a person to create or edit information in Recruiter.

**Note:** If your institution has created custom security roles, the name of the security roles listed in the table may not exactly match what is in your permissions record.

When you are trying to complete a particular task, view the procedural help to see which security roles have the ability to perform the task. If you are unsure about which security roles you have been assigned, you can access your User Profile to view information about you, including your security roles. For more information, see “View and Assign Security Roles” on page 77.

If you want to restrict who can create, edit, and view entries in a validation list, you will need to create a copy of the security roles delivered in Recruiter and change the access to be only “Read” and “Append To” for each of the validation list entities. For example, you will need to change the permissions on the Country, Source, or Location lists. A complete set of validation lists can be found in the **Settings > Validation List Management** area.
View and Assign Security Roles

In Recruiter, you can view details about each security role and assign one or more security roles to users:

- To view the security roles, privileges, and access levels, go to Settings > Administration > Security Roles in Recruiter.
- To assign security roles to users, go to Settings > Administration > Users.
- To assign security roles to teams, go to Settings > Administration > Teams.

After you have assigned security roles to users, you can view permissions for a record type. While you are in a record, go to File > Properties to view permissions for that record type.

At any time, you can run the List of CRM Systems Users report to determine which security roles are assigned to your staff. To view this report, go to Recruiting > All Reports.

For more information about procedures related to security roles, search for “security roles” in the Microsoft Dynamics CRM help. To view permissions that are required for certain tasks within Microsoft Dynamics CRM, search for “permissions” in the Microsoft Dynamics CRM help.
User Accounts

In Recruiter, you can create and manage user accounts for both the Recruiter interface and the Recruiter external website, depending on your security role.

Recruiter User Accounts and Profiles

Users with the System Administrator security role can create and manage other user accounts. To do this, go to Settings > Administration > Users.

If you have another security role assigned to you, you can still view your user profile. Your user profile displays information about you, including general information such as your contact information, what teams and resource groups you belong to, which services you can perform, and your work hours and security roles. This information is visible to the entire organization. Depending on your security role, you may be able to make changes to your user profile. Likewise, understanding your security role is key to knowing what you can and cannot view, create, or edit in Microsoft Dynamics CRM.

You also have the option of configuring your personal workspace. You can change how information is displayed to you, including the following:

- What links appear in your Workplace.
- How many records are displayed in lists.
- Your language preferences.
- How to display numbers and dates.

For more information, see the Set Personal Options article in the Microsoft Dynamics CRM help.

External Website User Accounts

In Recruiter, users with the Application Administrator security role can create and manage user accounts to the external website. This includes the ability to reset passwords, force password changes, unlock accounts, and revoke a user’s access if necessary. External website users are typically prospective students.
For more information about procedures related to external website user management, see the “User Management” section of the Recruiter help.
In This Chapter

This chapter includes overview information about products or features that are integrated with Recruiter. Table 11 lists the topics covered in this chapter.

Table 11: Topics in This Chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERP Integration</td>
<td>82</td>
</tr>
<tr>
<td>Ellucian Applications</td>
<td>83</td>
</tr>
<tr>
<td>Third-Party Applications</td>
<td>84</td>
</tr>
<tr>
<td>Reporting Tools</td>
<td>85</td>
</tr>
</tbody>
</table>
ERP Integration

Recruiter is designed to work with Banner by Ellucian, Colleague by Ellucian, or another Enterprise Resource Planning (ERP) system. When integrating with an ERP system, setting up data in Recruiter requires two main steps: provisioning and integration.

Provisioning data expedites the implementation of Recruiter by loading data from other sources into Recruiter. The Recruiter installation automatically provisions data for specific Recruiter entities. You can also provision data from your ERP system or import data from third-party sources.

Integrating data automatically allows for a bi-directional transfer of real-time data between two systems. This option is available with Banner or Colleague. You can also import and export data manually between Recruiter and these systems or another ERP system as needed for an ongoing exchange of data.

For more information about provisioning data in Recruiter and setting up your ERP system for integration, see the appropriate manual:

- If you are integrating with Banner by Ellucian, see the Integrating Recruiter with Banner manual.
- If you are integrating with Colleague by Ellucian, see the Integrating Recruiter with Colleague manual.
- If you are importing data from and exporting data to another ERP system, see the “Data Provisioning and ERP Integration” section of the Recruiter Installation Procedures manual.

For more information about managing ERP integration from Recruiter, see “Managing ERP Integration Options in Recruiter” on page 219.
In addition to integrating with the Ellucian ERP systems, Recruiter also integrates with the following Ellucian software applications:

- **Payment Gateway.** Payment Gateway is the payment management software product that integrates with Recruiter, Banner, and Colleague. Payment Gateway supports the following payment providers: CASHnet, Nelnet, Official Payments, PayPal, and TouchNet. The specific payment providers that are available for use by your institution are dependent on your implementation.

  For more information about installing and configuring the Payment Gateway for Recruiter, see the *Recruiter Installation Procedures* manual.

  **Note:** PayPal is not supported for Banner.

- **Banner Document Management.** Banner Document Management (BDM) is the imaging and electronic document management software product that integrates with Recruiter and Banner. You must have a Banner implementation to use BDM with Recruiter.

  For more information about configuring BDM for Recruiter, see the *Recruiter Installation Procedures* manual.
Third-Party Applications

To extend recruiting and admissions capabilities, Recruiter integrates with the following third-party applications:

- **ExactTarget.** ExactTarget is the bulk e-mail configuration and marketing product that integrates with Recruiter as a managed solution. You must install ExactTarget before installing Recruiter. ExactTarget e-mails can include graphics, personalization fields, links to social media applications like Twitter and Facebook, white-listing capabilities, and tracking analytics. The solution allows you to create e-mails in the ExactTarget application and send the e-mails to individuals in Recruiter. The solution also allows you to analyze and measure responses of the e-mail recipients within Recruiter.

  For more information about installing ExactTarget and testing the configuration settings, see the *Recruiter Installation Procedures* manual.

  For more information about using ExactTarget, see “Managing Communications Options” on page 167 and the “Configuring ExactTarget” section of the *Recruiter Configuration* manual.

- **StrikeIron.** StrikeIron is the postal address cleansing software product that integrates with Recruiter. StrikeIron is automatically installed and configured in the Recruiter installation. However, you must enable StrikeIron verification settings to use the address verification feature.


  For more information about the Canada Post standards, see [http://www.canadapost.ca/tools/pg/manual/PGaddress-e.asp](http://www.canadapost.ca/tools/pg/manual/PGaddress-e.asp).

  For more information about configuring StrikeIron, see the *Recruiter Installation Procedures* manual.
Reporting Tools

Recruiter delivers a number of reports, organized by area, that are tailored for the recruiting and admissions process. For a variety of reasons, your institution may require additional reports or reporting data. Microsoft Dynamics CRM enables you to use a variety of reporting tools to further expand your recruiting and admissions reports. For more information about delivered Recruiter reports, see the “Reports” section of the Recruiter help.

You can use one or more of the following reporting tools to expand your recruiting and admissions reports in Recruiter:

- Microsoft Office Excel Exports
- Microsoft Dynamics CRM Report Wizard
- SQL Service Reporting Services (SSRS)
- Recruiter Analytics (for Colleague clients only)

Note: Any changes made to delivered Recruiter reports are not supported. If you want to make changes to a report, you should copy and customize it within your unmanaged solution.

Microsoft Office Excel Exports

Microsoft Dynamics CRM provides a native Microsoft Office Excel export option. This feature allows you to export data from Recruiter into a format that is usable by Excel. All of the following options allow you to export data from either a list of records or Advanced Find search results:

- Static worksheet. This option allows you to export data to an Excel static worksheet. The same fields, field order, sorting, and field widths that are in the list or Advanced Find search results are displayed as columns in the static worksheet by default. You can create a new Advanced Find view to change how this data is displayed. Also, if you are exporting data in order to make changes and then re-import data back into Recruiter, this option lets you include the column headings in the worksheet that are required for the import.
Dynamic worksheet. This option allows you to export data to an Excel dynamic worksheet so that you can refresh the worksheet and get the most current data each time you open the worksheet. To do this, you must have a remote connection to the SQL server. Before you export data, you can change the columns, column order, sorting, and column widths that will be displayed in the dynamic worksheet.

PivotTable. This option allows you to export data to an Excel PivotTable so that you can view a summary of Recruiter data to more easily see comparisons, patterns, and trends. To do this, you must have a remote connection to the SQL server. Before you export data, you can select the columns that will be included in the PivotTable.

You can access the Export to Excel option from the ribbon on the list pages and the Advanced Find search results page. After you click it, the Export Data to Excel dialog box is displayed as shown in Figure 25. For more information about exporting data to Excel, see the Export Data to Excel article in the Microsoft Dynamics CRM help.

Figure 25: Export Data to Excel Dialog Box
Microsoft Dynamics CRM Report Wizard

Microsoft Dynamics CRM provides a native Report Wizard that allows you to create, edit, or copy reports. All reports created using the Report Wizard are Fetch-based reports. All delivered Recruiter reports are also Fetch-based reports and can be used as a starting point for a new report in the Report Wizard. All default Microsoft Dynamics CRM reports are SQL-based SSRS reports and cannot be edited using the Report Wizard.

The Report Wizard provides basic report authoring capabilities and is useful for creating simple reports, such as for one primary entity and one related entity. If you require more complex reports with a broader or deeper reach into the Recruiter data model, you should consider a different reporting option, such as SSRS reporting or Recruiter Analytics (for Colleague clients).

You can access the Report Wizard from the reports list in any of the Recruiter areas. For example, click Recruiting > All Reports. From the ribbon, click New. Then, click Report Wizard. The Report Wizard dialog box is displayed as shown in Figure 26. For more information about using the Report Wizard, see the Create, Edit, or Copy a Report Using the Report Wizard article in the Microsoft Dynamics CRM help.
Figure 26: Report Wizard Dialog Box

Get Started

Select how to start your report.

Select the starting point for your report

- [ ] Start a new report
- [ ] Start from an existing report

[ ] Overwrite existing report

http://sdcrm5w8a

Trusted sites | Protected Mode: Off
You can extend Recruiter reporting by creating and integrating custom SSRS reports with Microsoft Dynamics CRM. Writing custom reports outside of the native Report Wizard requires knowledge of the data model and how to use it in report queries. For more information about the data model, see the “Recruiter Data Model” section of the Recruiter Configuration manual.

SSRS allows you to create complex reports (such as drill-through reports or sub-reports) or to change the layout and formatting of reports by writing reports directly against the SQL database. To create SSRS reports, you must have a working report authoring environment for writing reports that are used in CRM. This includes report editing software for creation and manipulation of the report definition (RDL) files that are required by CRM and access to an instance of Recruiter for testing. Building SSRS reports also requires SQL Server skills and development experience, and a working knowledge of the FetchXML query or SQL query language.

All delivered Recruiter reports use FetchXML queries. All default Microsoft Dynamics CRM reports use SQL queries. The Advanced Find tool can also be used to build FetchXML queries. With SSRS, you can create custom Fetch-based reports using an authoring environment such as Report Designer in Business Intelligence Development Studio, or SQL-based reports using an authoring environment such as Report Builder.


Fetch-Based Reports

To create Fetch-based SSRS reports, you can use an SSRS authoring environment such as Report Designer in Business Intelligence Development Studio. Business Intelligence Development Studio allows you to work within the Microsoft Visual Studio environment.

If you are using Business Intelligence Development Studio to author custom Fetch-based reports for CRM, you must also install the Microsoft Dynamics CRM 2011 Report Authoring Extension, which you can download from the following location: http://msdn.microsoft.com/en-us/library/gg328097.aspx.

For more information about creating a Fetch-based report in CRM, see the *Create a custom Fetch-based Reporting Services report* article in the Microsoft Dynamics CRM help.

### SQL-Based Reports

To create SQL-based SSRS reports, you can use an SSRS authoring environment such as Report Builder. Report Builder allows you to work within the Microsoft Office environment.


For more information about creating a SQL-based report in CRM, see *Edit a default report or create a SQL-based Reporting Services report* article in the Microsoft Dynamics CRM help.

### Recruiter Analytics (Colleague clients)

Recruiter Analytics is a reporting and analytics solution for Enrollment Management and Admissions offices that combines data from Recruiter and Colleague. Recruiter Analytics was developed to help provide increased reporting capabilities to your institution’s recruitment staff, managers, and executives to support their institutional effectiveness strategies and long-range planning efforts.

Recruiter Analytics is a powerful tool that allows you to export and transform data from Recruiter and combine it with data from Colleague to create a dimensional database that encompasses specific recruitment information for reporting purposes. One of the key advantages of using Recruiter Analytics is that it is not restricted to the same server or location as the source database. Instead, data can be exported to a target SQL-based database. For more information, see the *Using the Recruiter Analytics* manual.
Guide to Using Recruiter
Recruiting and Admissions Processes
Managing Enrollment Goals

In This Chapter

This chapter includes information about setting up and using enrollment goals in the Recruiter interface.

Table 12 lists the topics covered in this chapter.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enrollment Goals Overview</td>
<td>94</td>
</tr>
<tr>
<td>Recruiting Periods</td>
<td>95</td>
</tr>
<tr>
<td>Goal Targets and Statuses</td>
<td>95</td>
</tr>
<tr>
<td>Territory Goals</td>
<td>97</td>
</tr>
<tr>
<td>Reporting Goals</td>
<td>98</td>
</tr>
<tr>
<td>Goal Calculation</td>
<td>100</td>
</tr>
<tr>
<td>Recruiting Home Page</td>
<td>101</td>
</tr>
</tbody>
</table>
Enrollment Goals Overview

Recruiter provides enrollment goals as a means of tracking your admissions funnel progress for a particular recruiting period. Enrollment goals allow you to define goal criteria and track the number of prospects in various stages of the admissions funnel who match that criteria. You can optionally define target counts for the admissions funnel stages that can be compared against the number of prospects that progress through each stage.

**Note:** For enrollment goals tracking, prospects are Contact entity records whose Relationship Type field is set to “Prospective Student”.

There are two types of enrollment goals:

- **Territory goals.** Tracks the admissions funnel progress for prospects who belong to a particular recruiting territory.

- **Reporting goals.** Tracks the admissions funnel progress for prospects that meet the criteria of a particular view.

In both cases, an enrollment goal is defined for a specific recruiting period; therefore, prospects are counted toward the goal only if the prospect’s anticipated entry term aligns with the goal’s recruiting period. For more information, see “Recruiting Periods” on page 95.

Enrollment goal counts are not updated in real time. Instead, they must be calculated either on demand or on a scheduled basis. For more information, see “Goal Calculation” on page 100.
Recruiting Periods

Enrollment goals require that a recruiting period be specified for each goal that is defined in the system. Recruiting periods allow you to segment the year according to when you recruit different groups of prospective students based on their anticipated entry terms. You can define a recruiting period by specifying a code and then relating one or more academic terms to that code. Academic terms can be included in multiple recruiting periods.

For example, you could define a “2014” recruiting period and include all of the academic terms that begin in the 2014 calendar year. You could also define a “Fall 2014” recruiting period that includes only the Fall 2014 academic term. This flexibility allows you to track admissions funnel progress at various levels of granularity according to the needs of your institution.

**Note:** A prospect counts toward an enrollment goal only if the prospect's anticipated entry term matches one of the academic terms that are associated with the goal's recruiting period.

Recruiting periods also allow you to define a start and end date. These dates are used to set the status of any enrollment goals associated with the recruiting period.

**Note:** The start and end dates have no effect on whether or not a prospect is counted toward an enrollment goal.

Goal Targets and Statuses

Enrollment goals track the count of prospects in each of the following stages of the admissions funnel:

- Prospect
- Inquiry
- Application Started
- Applicant
- Admit
- Confirmed
- Enrolled
For more information about the admissions funnel stages, see “Recruiting and Admissions Process” on page 24. For more information about the corresponding prospect statuses, see “Prospect Statuses” on page 112.

The enrollment goal counts are cumulative, meaning that a prospect who is counted for a later stage in the funnel is also counted in the previous funnel stages that the prospect has already passed through. For example, a prospect who has submitted an application is counted in both the Application Submitted stage and the previous stages of Prospect, Inquiry, and Application Started.

These cumulative counts can be compared against target counts that you optionally define on the goal for each stage of the funnel. For example, consider a scenario in which your institution is targeting 5000 prospects in a given recruiting period, and you hope to receive 1000 submitted applications from those prospects. On the goal, you can define target counts of 5000 for the Prospect stage and 1000 for the Application Submitted stage. You can then use the goal to track your progress toward achieving those target counts as you move through the recruiting period.

Enrollment goals also contain a status that has one of the following values:
- **Pending.** The goal status has not yet been determined.
- **OK.** The goal met all of the target counts that were defined for it.
- **Not Met.** The goal did not meet all of the target counts that were defined for it.

The status of an enrollment goal is “Pending” until the goal is recalculated after the end date of the goal’s associated recruiting period. At that point, if the cumulative counts that were calculated for the goal meet or exceed all of the target counts that were defined for it, the goal’s status is set to “OK”. Otherwise, the status is set to “Not Met”.
Territory Goals

A territory goal is a type of enrollment goal that tracks the admission funnel for prospects who belong to a recruiting territory. For more information about creating and assigning territories, see the “Admissions Office Management > Recruiting Territories” section of the Recruiter help.

When the goal is calculated, prospects are counted toward the goal if they meet the following criteria:

- The prospect is assigned to the recruiting territory that is associated with the goal.
- The prospect’s anticipated entry term is one of the academic terms associated with the goal’s recruiting period.

Territory goals are created automatically when specific events occur in Recruiter. In these cases, the current recruiting period that is associated with the territory’s recruiting team determines whether the goal is created. Recruiting teams provide a way of grouping recruiting territories. You must specify a recruiting team when you create a recruiting territory, and you must specify a current recruiting period when you create a recruiting team. The current recruiting period is used to automatically create a territory goal when the following events occur:

- When a new recruiting territory is created, a territory goal is defined for the new recruiting territory, using the current recruiting period of the territory’s recruiting team.
- When the recruiting team for an existing recruiting territory is changed, a territory goal is defined for the updated recruiting territory, using the current recruiting period of the territory’s new recruiting team. A new territory goal is created only if a goal for that territory and current recruiting period does not already exist.
- When the current recruiting period for a recruiting team is changed, territory goals are created for all recruiting territories that belong to that recruiting team, using the new current recruiting period. Each new territory goal is created only if a goal for that territory and current recruiting period does not already exist.
- When the “Update Enrollment Goals” workflow is run, the admissions funnel stage counts are recalculated for all active enrollment goals. The workflow also creates territory goals for any missing territory and current recruiting period combinations for each active recruiting team. For more information, see “Goal Calculation” on page 100.
Managing Enrollment Goals

The territory goals that are automatically created might be adequate to track the admissions funnel for your institution; however, you might also want to manually create territory goals under the following conditions:

- You have recruiting periods that overlap and you want to track admissions funnel progress for them simultaneously. Only one current recruiting period can be defined for a recruiting team at any given time; therefore, you must manually create territory goals for the other recruiting periods.
- You want to track admissions funnel progress for recruiting periods in the future. In this case, you might want to manually create the territory goals for recruiting periods that have not yet been set as the current recruiting period for a recruiting team.

You can manually create a territory goal by navigating to Recruiting > Enrollment Goals, clicking New, and then providing the following information:

- Code. Text code to uniquely identify the goal.
- Recruiting Period. Recruiting period that the goal will be tracked for.
- Goal Type. Set to “Territory”.
- Recruiting Territory. Select the recruiting territory for which the goal is being defined.

Reporting Goals

A reporting goal tracks the admissions funnel for prospects who meet the criteria of a specified view for the Contact entity. Views provide a powerful and flexible way to track the admissions funnel against any set of prospects that you want. When a reporting goal is calculated, it counts a prospect toward the goal if both of the following conditions are met:

- The prospect matches the criteria defined on the view associated with the goal.
- The prospect’s anticipated entry term is one of the academic terms associated with the goal’s recruiting period.
Reporting goals are always created manually. You can create a reporting goal by navigating to Recruiting > Enrollment Goals, clicking New, and then providing the following information:

- **Code.** Text code to uniquely identify the goal.
- **Recruiting Period.** Recruiting period that the goal will be tracked for.
- **Goal Type.** Set to “Reporting”.
- **View.** Select any view that is defined for the Contact entity.

**Note:** Views that are used in reporting goals should include criteria that limits them to Contact entity records with a Relationship Type of “Prospective Student”. Records that do not specify this type of relationship do not count toward a reporting goal.

For more information, see the *Work with Views* article in the Microsoft Dynamics CRM help.
Goal Calculation

Enrollment goals do not provide real-time prospect counts for each stage of the admissions funnel. Instead, the counts for a goal must be calculated either on demand or on a scheduled basis.

To calculate an enrollment goal on demand, open the enrollment goal, and click **Recalculate Goal** on the ribbon. This option updates each of the admissions funnel stage counts for that goal.

To calculate an enrollment goal on a scheduled basis, use the Workflow Scheduler to schedule the “Update Enrollment Goals” workflow. The “Update Enrollment Goals” workflow recalculates the funnel stage counts for each active enrollment goal in Recruiter. The workflow also creates territory goals for any missing territory and current recruiting period combinations for each active recruiting team.

For more information about scheduling workflows, see the “Scheduling Workflows” section of the *Recruiter Configuration* manual.
The Recruiting home page (Recruiting > Recruiting Home) provides a dashboard view of enrollment goal data. This page allows you to view either territory goals or reporting goals by selecting the corresponding tab.

When viewing territory goals, you must first select a recruiting team. The page displays the data for each territory goal that is defined for that team’s current recruiting period. When viewing reporting goals, you must first select a single reporting goal to display the corresponding data.

In addition to displaying the target and actual cumulative admissions funnel stage counts for enrollment goals, the Recruiting home page also provides two graphical views of goal data.

The first graphical views is a funnel chart that shows the cumulative stage counts for the admissions funnel. If you are viewing territory goals, you can modify which territory goal counts are included in the funnel chart by selecting or clearing the territories.

The second graphical view is a pie chart that shows the “current” funnel stage counts. Unlike the cumulative counts, current counts only count a prospect in the funnel stage the prospect is currently in, not in the stages that the prospect has already passed through.

Access to the Recruiting home page and the data that is displayed on the page is controlled by security roles. A user must be assigned either the Recruiting Home Access or Recruiting Home Director Access security roles to view the page. A user must also be assigned one or more security roles that contain privileges to read the following entities: Recruiting Team, Recruiting Period, Recruiting Territory, Enrollment Goal, and Configuration Setting.

If a user has only the Recruiting Home Access security role, the user will see only the enrollment goals that the user is assigned. If a user has the Recruiting Home Director Access security role, the user will see all enrollment goals that the user has permission to view in the system. Users with this role also have the ability to recalculate all the enrollment goals by clicking the Re-Calculate button on this page, which has the same effect as running the “Update Enrollment Goals” workflow.

For more information about the Recruiting area and the Recruiting home page, see “Recruiting Area” on page 40.
Managing Suspects and Prospects

In This Chapter

This chapter includes details about managing suspects and prospects in the Recruiter interface. Table 13 lists the topics covered in this chapter.

Table 13: Topics in This Chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suspects and Prospects Overview</td>
<td>104</td>
</tr>
<tr>
<td>Suspect and Prospect Forms in Recruiter</td>
<td>105</td>
</tr>
<tr>
<td>Prospect Profile, Ratings, Statuses, and Sources</td>
<td>110</td>
</tr>
<tr>
<td>Recruiting Imports</td>
<td>115</td>
</tr>
</tbody>
</table>
Suspects and Prospects Overview

Recruiter allows you to manage both suspects and prospects as part of the recruiting and admissions process.

Suspects are potential students who have not yet expressed an interest in your institution. After suspects are created in Recruiter, you can begin to cultivate your relationship with them by building marketing lists, generating campaigns, and organizing events. At any time, you can convert suspects to prospects based on your institutions desire and criteria for doing so. You can create suspects in the following ways:

- Enter suspects manually into Recruiter.
- Purchase and import suspect lists from specific vendors.

Prospects are potential students who have expressed an interest in your institution and who are active in your recruiting and admissions process. You can capture more extensive information for prospects in Recruiter than for suspects. You can create prospects in the following ways:

- Enter prospects manually into Recruiter.
- Convert suspects to prospects.
- Import prospects from Banner or Colleague.
- Purchase and import test scores and applications from specific vendors, which create prospect records.
- Import prospects from the Common Application or from other vendors using the general prospect import process.
- Automatically create prospects when students inquire about your institution, create an account on your external website, submit an application, or register for an event.

For more information about how these terms are used in Recruiter, see “Admissions Terminology” on page 23. For more information about how suspects and prospects fit into the recruiting and admissions process, see “Recruiting and Admissions Process” on page 24.
Suspect and Prospect Forms in Recruiter

In Recruiter, you can manage suspects using the Suspect (Lead) form and prospects using the Prospect (Contact) form. Each form is delivered with specific fields and related entity data. You can create custom forms as needed for your institution.

For more information about entities and relationships, see the “Recruiter Data Model” section of the Recruiter Configuration manual. For more information about creating custom forms, see the “Configuring Forms” section of the same manual.

Suspect Form

The Suspect form (see Figure 27) allows you to view or manage the following types of information:

- Name, address, and contact information
- Demographic details
- Academic details, such as academic level and anticipated start term
- Related import record, if applicable
- Source of information
- StrikeIron geographic codes
- Communication methods
- SMART Approach model score
- ACT EOS predictive modeling information

Related entity data for suspects includes information such as the following:

- Open and closed activities
- Academic interests
- Extracurricular activities
- High school and college information
- AP exams

For more information about procedures related to suspect management, see the “Suspects and Prospects > Suspects” section of the Recruiter help.
Figure 27: Suspect Form
Prospect Form

The Prospect form (see Figure 28) allows you to view or manage the following types of information:

- Name, address, and contact information
- Demographic details
- Parent and guardian information
- Unofficial (self-reported) test scores for SAT, ACT, TOEFL, GRE, GMAT, LSAT, MAT, MCAT, PCAT
- Enrollment details, such as academic level and program of interest
- Campus plans, such as plans to apply for scholarships and interest in campus housing
- Work experience
- Recruiter assignments and territories
- Prospect status, origin, and inquiry details
- ERP integration flags
- Application status and admissions details
- Communication methods
- Desirability and probability ratings
- Additional search and sorting tags, if used by your institution
- SMART Approach model score
- ACT and ACT EOS predictive modeling information

Related data for prospects includes information such as the following:

- Open and closed activities
- Transcript courses
- Applications and associated status
- Recommendation requests
- Events attended
- Communication history with your institution
- High school and college information
- FAFSA data and financial aid awards
- Academic interests
- Career goals
- Extracurricular activities
- Primary and official test scores
- Self-reported test scores for AP, IB, and SAT Subject tests
- Supplemental items
Managing Suspects and Prospects

For more information about procedures related to prospect management, see the “Suspects and Prospects > Prospects” section of the Recruiter help.

For more information about the prospect and application relationship, see the “Application Entities and Relationships” section of the Recruiter Configuration manual.

**Figure 28: Prospect Form**

![Prospect Form](image)

**Prospect Plus Form**

Recruiter also provides the Prospect Plus form (see Figure 29) so that you can view a list of prospects and associated key fields. The Prospect Plus form is a Silverlight control that creates enhanced grid views that you can export to a .csv file. You can use both standard Recruiter views and custom views as a base. The formatting controls allow you to select which fields to use, which order to put the fields in, how wide the fields should be, and the number of records that will be displayed.
You can include data from the following areas:

- Prospects
- High Schools
- Colleges
- Primary Scores
- Career Goals
- Extracurricular Activities
- Academic Interests

For more information, see the *Use the Prospect Plus Form* article in the Recruiter help.

**Figure 29: Prospect Plus Form**
Prospect Profile, Ratings, Statuses, and Sources

This section contains details about the prospect profile, ratings, statuses, and sources that are available on the Prospect form.

Prospect Profile

Each prospect record contains a summary view, or profile, that enables you to get a quick idea of where the student stands in your recruitment process. The profile displays an overview of the prospect record including contact details, admissions funnel stages completed, application status, recent communications, and icons that indicate an interest in financial aid, housing, applying for scholarships, honors programs, and study abroad programs. Figure 30 is an example of a prospective student’s profile.

**Figure 30: Example of a Prospective Student’s Profile**
If desired, you can add a photo to the prospective student’s profile. To do this, click the Add tab, click Attach File, and then browse for a file with the name “prospectimage”. Click Attach to complete the process. It is important that the name of the file be “prospectimage”, but the file extension can be that of any image file type supported by a browser (for example, .jpg, .gif, or .png).

**Prospect Ratings**

The goal of prospect ratings is to help you decide the priority of a prospective student as compared to others. You can view a student’s prospect ratings on his or her profile. A prospect rating is a score associated with a prospective student. There are two ratings:

1. **Desirability rating.** Measures the desirability of a prospective student for your institution.
2. **Probability rating.** Measures how likely the prospective student is to attend your institution.

You can configure prospect ratings calculations by using Recruiter’s workflow function with conditional workflow steps that support the ability to adjust and set the rating. Within the workflow definition, you can define specific rating values for certain conditions for each type of rating by adding or removing up to 100 points. For example, if the prospect’s city equals your city, you can add 10 points to the probability rating; if the prospect’s state equals your state, you can add 5 points to the probability rating.

As part of the Recruiter product, workflow templates are delivered that you can use to create your prospect ratings. From these templates, you can add or remove any of the default criteria to create the best rating for your institution.

For more information, see the “Configuring and Using Workflows” section of the Recruiter Configuration manual.
Prospect Statuses

You can view a prospect’s status on the Prospect form and the admissions funnel stages that the student has gone through on the prospect profile.

If a student is active in the admissions process, the prospect profile will display, in green, the admissions funnel stages that the student has completed so far (see Table 14). If a student has withdrawn the application associated with their primary recruitment path, the prospect profile will display, in red, the stages that the student completed prior to withdrawing. Additionally, dates are displayed for when the application was sent to the ERP system, the student was admitted, and the student enrolled in your institution.

Table 14: Prospect Statuses and Admissions Funnel Stages

<table>
<thead>
<tr>
<th>Prospect Status</th>
<th>Admissions Funnel Stage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prospect</td>
<td>Prospect</td>
</tr>
<tr>
<td>Inquiry</td>
<td>Inquiry</td>
</tr>
<tr>
<td>Application Started</td>
<td>Application Started</td>
</tr>
<tr>
<td>Application Submitted</td>
<td>Application Started OR Applicant (depending on UseApplicationCompletedDateForApplicantFunnelStage configuration setting, which is delivered as “False”)</td>
</tr>
<tr>
<td>Application Completed</td>
<td>Applicant</td>
</tr>
<tr>
<td>Application Moved to ERP(^a)</td>
<td>Applicant</td>
</tr>
<tr>
<td>Admit</td>
<td>Admit</td>
</tr>
<tr>
<td>Confirmed</td>
<td>Confirmed</td>
</tr>
<tr>
<td>Enrolled</td>
<td>Enrolled</td>
</tr>
</tbody>
</table>

a. Deprecated in Recruiter 3.6, but existing prospects may still have this status.

Prospect Sources

Recruiter includes an option on the Prospect form for tracking how someone is added into Recruiter (origin source) and how someone first contacted your institution (inquiry source). With the ability to track the source of prospects, you can analyze the different sources to maximize yield and Return on Investment (ROI) for various market segments. Also, the separate origin source and inquiry source for each student can be used to identify whether a user that creates an account on the external website is already known to the system as a purchased suspect.
Origin Source

The origin source indicates how the person was entered into Recruiter. A suspect or prospect record could be created for a person in one of the following ways:

- Provisioning from your ERP system
- Suspect import
- Prospect import
- Test score import
- Registering for an event manually or on your external website
- Creating an account manually or on your external website
- Completing the inquiry form on your external website
- Starting an application on your external website
- Financial aid import
- Application import

The origin source is populated automatically if the suspect or prospect was created because of an import or supported activity on the external website. You must identify the origin source when you manually enter suspects or prospects in Recruiter.

Inquiry Source

The inquiry source indicates the way a prospect first contacted your institution. An inquiry could include:

- Submitting an inquiry form
- Responding to a mailing
- Directly contacting the admissions office
  - Phone
  - E-mail
  - Online chat
  - Social media (for example, a comment on Facebook)
- Sending test scores to the institution
- Sending financial aid information to the institution
- Attending an event hosted by your institution
  - High school college fair (completing inquiry card)
  - High school visit
  - Campus visit
  - Campus tour
Managing Suspects and Prospects

- Interest through a third-party partner and subsequent imports into Recruiter
- Submitting an application to the institution

You can configure Recruiter to set a particular inquiry source for a prospect depending upon the type of contact with your institution. When you import an application, you can use the Source field on the application form to specify which source to use as the inquiry source. When you import test scores, the test score inquiry source will match the test score import type.

Recruiter includes four configuration settings that automatically set the inquiry source when a prospect does the following on your external website: creates an account, submits an online inquiry, starts an application, or registers for an event. Recruiter also includes configuration settings that allow you to set the BDM inquiry source (for Banner only) and the application import inquiry source. For more information about the configuration settings, see the “Specifying Recruiter Configuration Settings” section of the Recruiter Installation Procedures manual.

Additionally, if you are integrating with Banner or Colleague, you can set the inquiry source to match the origin source when sending prospects to Recruiter. For more information, see the appropriate Recruiter integration manual.

**Note:** If the origin or inquiry source is from a student completing the Create Account or Prospect Inquiry form on your external website, the source codes are stored in the respective Origin Web Form or Inquiry Web Form field on the Contact entity forms. If the origin or inquiry source is from an event registration, a Lookup to the event is stored in the respective Origin Event or Inquiry Event field on the Contact entity forms. These fields are not delivered on the default forms, but are available for use on forms, views, or reports as needed. For more information about configuring forms, see the “Configuring Forms” section of the Recruiter Configuration manual.
Recruiting Imports

Recruiter allows you to manage and import a number of delivered suspect lists, prospects, test scores, and applications from a variety of sources. You can also import additional applications, prospects, and test scores by configuring and using the general import process for each. Imports provide information to help you identify prospective students and to help you complete applications for prospective students.

Recruiting Import Process

When you import data into Recruiter using the delivered recruiting imports, the data is first moved to staging records. The staging records hold the raw data for the imports. The type of import determines how the data is processed, evaluated for duplicate records, and moved into a suspect or prospect record.

Each type of import requires a certain amount of setup to ensure that the data that is imported is correctly formatted for your institution’s needs and so that the records are properly created in Recruiter. After all setup is complete, you can click the appropriate Import Management subarea in the Recruiting Imports area to begin an import process. It is recommended that you review all steps associated with each import (in the Recruiter help) before starting this process.

Additionally, each import handles duplicate data in a specific way, and you might need to resolve duplicate data in some cases. For more information, see “Recruiter Functions That Require You to Resolve Duplicate Data” on page 208.

For details about setting up the general application import or Common Application import processes, see the “Setting Up a General Application Import” or “Importing the Common Application” sections of the Recruiter Configuration manual. For details about defining suspect, prospect, and test score import contract mappings, setting up the general prospect or test score imports, or creating custom imports, see the “Configuring Recruiter Imports” section of the same manual.

For more information about how data is processed for each delivered import and for procedures related to delivered imports, see the “Recruiting Imports” section of the Recruiter help.
Suspect Auto-Qualification Criteria

When you import suspects, Recruiter provides functionality to automatically convert the newly created suspect records to prospect records. The suspects are converted to prospects if one of the following scenarios is true:

- The **SuspectAutoQualifyAlwaysEnabled** configuration setting is set to “True”, and therefore all of the suspects that are imported will automatically be converted to prospects.

- The **Configure Suspect Auto-Qualification** option on the Settings home page (which is the same as the **SuspectAutoQualifyCriteriaViewIdList** configuration setting) has been defined with selected system views to be used as criteria, and any suspects who meet the criteria are converted to prospects.

To select auto-qualification criteria, go to **Settings > Settings Home > Configure Suspect Auto-Qualification**. Select the views that you want to use to determine whether a suspect should be converted to a prospect, and then click **Save & Close**. You cannot use a personal view. If a suspect meets the criteria for one of the selected views, the suspect will be converted to a prospect. For more information about views, see the **Work with saved views** article in the Microsoft Dynamics CRM help.

- The **Qualify All Records** check box on the Import Suspects form is selected, and therefore all the suspects in the import file are automatically converted to prospects. If you do not select the check box, the process checks for any criteria that you have defined.

**Note:** The **Qualify All Records** check box will not be displayed on the Import Suspects form if the **SuspectAutoQualifyAlwaysEnabled** configuration setting is set to “True”.

If none of the scenarios are true, then the suspect is not converted to a prospect unless you choose to manually convert the suspect to a prospect.

**Note:** Suspect records that are created manually cannot be automatically converted to prospects. You will have to run the “Convert to Prospect” workflow to convert those suspects to prospects or click the **Convert to Prospect** option on the ribbon when viewing suspects.

**Note:** To convert all existing suspects to prospects based on the defined criteria, you must schedule the “Auto Qualify All Eligible Suspects” workflow and then run it on demand. For more information, see the “Configuring and Using Workflows” section of the **Recruiter Configuration** manual.
For more information about the configuration settings, see the “Specifying Recruiter Configuration Settings” section of the Recruiter Installation Procedures manual.
Managing Applications and Application Reviews

In This Chapter

This chapter includes details about managing applications and application reviews in the Recruiter interface. Table 15 lists the topics covered in this chapter.

Table 15: Topics in This Chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applications Overview</td>
<td>120</td>
</tr>
<tr>
<td>Applications</td>
<td>120</td>
</tr>
<tr>
<td>Additional Application Features</td>
<td>125</td>
</tr>
<tr>
<td>Letters of Recommendation Feature</td>
<td>128</td>
</tr>
<tr>
<td>Application Reviews</td>
<td>133</td>
</tr>
</tbody>
</table>
Applications Overview

Recruiter works in conjunction with the online application on the Recruiter external website, receiving applicant information in real-time. The application data is stored in Recruiter and can be exported to the ERP system for an admissions decision after the application is complete, or the proposed admissions decision can be made in Recruiter. The Applications area allows you to manage, view, coordinate reviews of, and report on applications.

Applications can be entered into Recruiter in three ways:
- The prospect enters the information through your website and the data is saved in Recruiter.
- An Admissions Officer enters the information directly into Recruiter for the prospect.
- You import application information into Recruiter from a specific vendor.

Recruiter is configured to import the Common Application. If you need to import applications from another source, for example the Royall application, you can configure Recruiter to import those applications using the general application import process. For more information, see the “Setting Up a General Application Import” and “Importing the Common Application” sections of the Recruiter Configuration manual.

Applications

Applications are a tool to collect complete and accurate information from a prospect to help aid in the admissions decision. Your institution can have several different applications to accommodate different populations of prospects. For example, you can have an undergraduate application, a graduate application, and a continuing education application. Each application can have similar information with a similar look and feel, but can also have specific information based on the program that a prospect is applying for.

Each online application consists of the application form and any supplemental items, such as a transcript, test scores, letters of recommendation, or a portfolio. After a prospect completes the application, submits the required supplemental items, and pays the application fee, the application folder in Recruiter is complete and ready for an admissions review.

In Recruiter, setting up an application form begins with creating an application type. An application type is a template for future applications. It is on the application type record that you define what information you want to
collect from a prospect and access the application form to lay out the fields on the application. After you have created your application type, customized your application form, and defined which supplemental items are required, you can add the application to your external website to make it available online.

For details about the application configuration process, see the “Configuring Applications” section of the Recruiter Configuration manual.

For more information about procedures related to preliminary application setup tasks, see the “Applications > Application Types” section of the Recruiter help. For more information about procedures related to creating and managing applications and supplemental submissions, see the “Applications > Applications” section of the Recruiter help.

**Application Type and Form**

To begin creating an application, you must first create a custom application type. As a part of Recruiter, several application types are delivered that you can use as a starting point for creating your own applications. You can then define the general application type information and customize the application form as necessary to fit the needs of your institution.

**Note:** Delivered Recruiter templates can be overwritten in future releases; therefore, if you want to make changes to a delivered template, you should create a new application type first and then customize the application form.

**Note:** Do not use any of the Recruiter-delivered Common Application application types as the originating application types when you create a new application type or a new application for an applicant.

When creating a custom application form, you can use the form designer to modify the template to meet your institution’s requirements. The form designer lets you add and remove fields, sections, and tabs. When you are satisfied with the application form, you can publish the form and add the form to your external website. After the form is available on the website, prospective students can begin applying to your institution. You can have multiple active application forms at any given time.

For more information, see the “Configuring Forms” section of the Recruiter Configuration manual.
Supplemental Items

Supplemental items are additional items that you receive from prospects when they are submitting an application. This could include items such as a transcript, test scores, letters of recommendation, or a portfolio. You can have as many supplemental items as necessary for each application. You can mark some supplemental items as required and others as not required. Supplemental items are associated with an application type, which then determines which supplemental items are assigned to prospects when they are filling out an online application.

Typically, a prospect creates an online application and Recruiter then creates the necessary supplemental item submission records. Depending upon the type of supplemental information, the prospect can either upload a corresponding supplemental item to your external website or mail the information to your institution. In the latter case, when you receive the supplemental item, you can mark it as received, which will allow you to mark the application as complete. If you are using the letters of recommendation feature, a prospect can send requests and recommenders can submit recommendations through your external website.

In some cases, you might receive a supplemental item from a prospect before the prospect begins an application. In those situations, you can manually create the supplemental item submission record and associate it with the prospect record.

When a supplemental item is received, an item received activity is created for the prospect with an activity code for that supplemental item. Supplemental item submissions can be received before or after an application is created. When an application is created, new supplemental item submissions are also created. If the prospect already has an item received activity for the matching activity code, the supplemental item submission is automatically marked as received. This ensures that a supplemental item that was received before the application has the correct submission status.

All required supplemental items must be received or waived for an application to be marked complete. If you manually mark an application complete and the required supplemental items have not been received, Recruiter prompts you to waive those supplemental items. Additionally, if the RequireAppCompleteBeforeSendToERP configuration setting is set to “True,” all supplemental items must be received or waived before you can submit the application to your ERP system. If you have received a supplemental item after an application has been submitted to your ERP system, you can manually mark the item received and can send an activity to
your ERP system to indicate that the supplemental item has been received. If the `RequireAppCompleteBeforeSendToERP` is “False,” the application will be sent to your ERP system as soon as it is submitted.

Recruiter can also be set up to automatically mark an application as complete if all supplemental items have been received or waived, and to automatically export an application to your ERP system after it has been marked complete. For more information, see “Actions in Recruiter That Send Data” on page 223.

Additionally, you can create item received activities for transcripts and test scores using workflows. For more information about creating these workflows, see the “Creating Specific Recruiter Workflows” section of the `Recruiter Configuration` manual.

Additional setup is required if you are implementing the letters of recommendation feature on the Recruiter external website. For more information about this feature, see “Letters of Recommendation Feature” on page 128.

## Application Statuses

When prospects apply to your institution, their applications move through multiple statuses. The status of an application helps you track the progress of an application through the application process. Depending upon the status, certain options and actions are allowed in Recruiter. For example, you cannot export an application to your ERP system unless the application has a Marked Complete status.

An application can have any of the following statuses:

- **Started.** The application is incomplete. This status indicates that the prospect has begun to fill out the application but has not yet completed it. Prospects are not required to complete the entire application at one time.
- **Submitted.** The application has been filled out and a payment has been received. This status does not include your institution having received any of the supplemental information.
- **Marked Complete.** The application and all the required supplemental information have been received. This status is set by an Admissions Officer or by the “Auto Mark App Complete” workflow. At this point, the application is ready to be exported to your ERP system.
- **Withdrawn.** The prospect has decided to not finish the application process and no longer wants to be considered for admission in that academic program. This status is set by an Admissions Officer.
As the status of an application changes, the date and the name of the user who changed the status is recorded. In addition, when the status of the application is set to Started, Submitted, Marked Complete, or Withdrawn, an activity is created for the prospect. The activity is assigned to the recruiter who owns the prospect record, and the activity includes information about which application type was used, the application source, and the status.

Additional Processing with the Submitted Status

When an application is marked with the Submitted status, the following information is also updated in Recruiter:

- **Prospect data is updated.** If any of the demographic information about the prospect is different from what is already in Recruiter, the information from the application is added to the prospect record.

- **Extracurricular activities are updated.** Any extracurricular activities that the prospect designates on the application are added to the prospect record and then merged if necessary. If the prospect’s application is the reason a new record is created, or if the existing record was updated because of data in the application, the source of the record is set to “Application”. For records that are directly related to the prospect, and not coming from the application, the source of the record is “Prospect”.

- **AP, IB, and SAT Subject test scores are updated.** Any AP, IB, or SAT Subject test scores that the prospect designates on the application are added to the prospect record and then merged if necessary. If the prospect’s application is the reason a new record is created, or if the existing record was updated because of data in the application, the source of the record is set to “Application”. For records that are directly related to the prospect, and not coming from the application, the source of the record is “Prospect”.

- **High schools and colleges attended are updated.** If a prospect has any high school or college attended records, the data is merged with the data from the application by using the CEEB code to identify records that are the same. If an attended record does not exist, or if the high school or college is not associated with a CEEB code, a new attendance record is created for the prospect.

For more information about the prospect and application relationship, see the “Application Entities and Relationships” section of the Recruiter Configuration manual.

For more information about merging prospect child records, see the Clean Up Duplicate Prospect Child Records article in the Recruiter help.
Additional Application Features

This section contains information about additional application features that can help you when managing your applications.

Primary Application Designation

Recruitment paths are used to drive the overall status of the prospective student’s profile in Recruiter. Because each prospect can have multiple recruitment paths, one of the prospect’s recruitment paths is designated as the primary path so that only a single path affects the prospect’s status at any time.

A prospect’s primary recruitment path is determined automatically based on the combination of the following settings:

- Primary Recruitment Path Calculation View
- PrimaryPathCalculationUseActiveNonDisqualifiedPathsFirst configuration setting
- PrimaryPathCalculationUseInactiveNonDisqualifiedPathsFirst configuration setting
- Primary Recruitment Path Calculation Method

**Note:** A recruitment path is considered “Disqualified” if the application associated with the path has a status of “Withdrawn” or “Denied.”

See “Configuring Recruitment Paths” in the Recruiter Configuration manual for more information about how the primary recruitment path is calculated and how the various settings affect the calculation.

You can use the Prospect form to override the primary recruitment path calculation and designate a specific path as the primary recruitment path.

**Note:** It is recommended that you do not deactivate applications, because Recruiter does not have any special processing that excludes deactivated applications. Instead, you should withdraw any incomplete applications.

For more information about prospect statuses, see “Prospect Statuses” on page 112.
Edit Applications

Recruiter provides the option to edit an application with a status of Submitted or Marked Complete. It might be necessary to edit an application if a prospect entered incorrect data or decided to change his or her academic interest.

When you edit an application, a copy of the original application is saved for auditing purposes. From the Application Form section of the application, you have access to the original application data. If any of the data that is updated has been mapped from the Application to the Contact entity, Recruiter also updates the prospect data with the new information.

Editing the application does not change the submitted on or submitted by information. Instead, Recruiter sets edited on and edited by information. In addition, text is added to the Notes section with the date, time, and user who completed the edits.

Note: Editing applications is intended for applications that are created within Recruiter and the external website, which can be properly validated when submitting edits. This does not include imported applications, such as the Common Application, because the data will not propagate to the prospect and there is no validation. Therefore, editing applications that are imported is not supported.

Print Applications

Recruiter provides an option to print applications using the Print Applications option on the ribbon. This option uses a stylesheet to transform data from the application into a format that you can print. If you have edited the application, you can print either the original or current application.

When you are printing an application, you can include or exclude the following, and preview the information before printing:

- Fields with Blank Entries
- Application
- Supplemental Item Information
- Completed Recommendations
- Cover Page

You can also print an application folder using the Print Application Folders option on the ribbon.
Export Applications

You can export the application to your ERP system where the admissions decision can be recorded, or you can keep the application in Recruiter for the admissions review and then export it to your ERP system with a proposed admissions decision. Applications can be exported one at a time or in a batch depending upon your institution’s policies. For more information, see “Actions in Recruiter That Send Data” on page 223.
Letters of Recommendation Feature

The letters of recommendation feature in Recruiter allows your institution to facilitate the process of requesting and receiving letters of recommendation for prospects. Through the Recruiter external website, prospects can request recommendations, and recommenders can complete recommendations or decline recommendation requests.

Letters of Recommendation User Roles

The letters of recommendation feature provides different functions depending on a user's functional role. These roles do not correspond with a Recruiter security role.

The functional roles are as follows:

- **Recruiter administrator.** Configures the setup of the letters of recommendation feature. For more information, see the “Setting Up the Letters of Recommendation Feature” section in the Recruiter Configuration manual.
- **Recruiter.** Views and manages recommendation requests and letters of recommendation within Recruiter. For more information, see the “Applications” section of the Recruiter help.
- **Prospect.** Creates and manages letters of recommendation requests within the Recruiter external website, as part of the prospect's application process with your institution.
- **Recommender.** Writes letters of recommendation or declines recommendation requests within the Recruiter external website.

Recommendation Request Statuses

Recommendation requests move through multiple statuses. The status lets you track the progress of the recommendation request for a prospect. Depending upon the status, certain options and actions are allowed in Recruiter.
A recommendation request can have any of the following statuses:

- **None.** The recommendation request has not yet been sent, and the Start link is displayed to the prospect on the external website.
- **Sent.** The recommendation request e-mail has been sent, but the recommender has not yet responded.
- **In Progress.** The recommender has saved a partially completed recommendation.
- **Completed.** The recommender has completed and submitted a recommendation.
- **Waived.** The recruiter waived the recommendation request.

**Note:** You can also waive a required recommendation by changing the submission status on the supplemental item submission to “Waived.” If you waive a recommendation, the associated recommendation request will also be set to “Waived.”

- **Declined.** The recommender declined the recommendation request.
- **Cancelled.** The prospect cancelled the recommendation request.

**Note:** The Resend and Cancel links are displayed to the prospect on the external website when the recommendation request status is set to “Sent,” “Received,” or “In Progress.”

### Prospect and Recommender Processes

This section outlines the letters of recommendation process for prospects and recommenders on the Recruiter external website.

### Prospect

A prospect can do the following on the external website:

- Complete and submit a recommendation request.

**Note:** The recommendation is tied to a specific application; therefore, the prospect must create an application before being able to request recommendations.
Managing Applications and Application Reviews

- Resend a recommendation request.
- Cancel a recommendation request that either has incorrect information in it or is not moving forward in the recommendation process.

**Note:** Prospects can view their recommendation requests on the external website, but they cannot view submitted recommendations.

**Send a Recommendation Request Process**

A prospect can create a recommendation request as part of the application process with your institution as follows.

1. The prospect starts an online application.

**Note:** If supplemental items were related to the application type, then they will be created when the application is created.

2. The prospect can either save a partially completed application or complete and submit an application.
   - If you previously assigned supplemental items to an application type, when the application is created, supplemental item submissions are automatically created. Therefore, the recommendation requests that are associated with the application type are also displayed on the external website.
   - If you previously created a workflow that is triggered when the prospect submits an application, that creates supplemental item submissions and that associates the submissions with supplemental items, then those actions will occur when the prospect submits the application. At that time, the recommendation requests that are associated with the supplemental item submissions are displayed on the external website.

3. When the prospect goes to the supplemental items page, both the supplemental item list control and the applicant recommendation request list control are displayed.

4. The prospect can start a recommendation request, which takes the prospect to the applicant recommendation request page. The recommendation form that is associated with supplemental information type for the request is displayed.

5. The prospect completes and submits the recommendation request. The prospect is then redirected back to the supplemental items page.

When a recommendation request is submitted, Recruiter sends an e-mail to the recommender that contains links to the recommendation and decline recommendation request pages, and then updates the request status to “Sent.”
Recommender

A recommender can do the following on the external website:

- Write a recommendation
- Decline a recommendation request
- Save a partially completed recommendation

Write a Recommendation Process

A recommender can write a letter of recommendation for a prospect as follows.
1. The recommender receives the request e-mail.
2. The recommender clicks on the recommend link in the e-mail.
3. The recommender is taken to the recommendation page. The recommendation form that is associated with supplemental information type for the request is displayed.
4. The recommender can either save a partially completed recommendation and come back to it later from the original request e-mail or complete and submit the recommendation.
5. The recommender is shown a confirmation message.

When a recommendation request is saved as partially completed, Recruiter updates the request status to “In Progress” and sends an e-mail to the prospect with the request status.

When a recommendation is submitted, Recruiter updates the request status to “Completed” and sends an e-mail to the prospect with the request status.

Decline a Recommendation Request Process

A recommender can decline a recommendation request for a prospect as follows.
1. The recommender receives the request e-mail.
2. The recommender clicks on the decline link in the e-mail.
3. The recommender is taken to the decline recommendation page, which prompts the recommender to confirm the decision and either decline the request or complete the recommendation. If the recommender decides to complete the recommendation instead of declining the request, the recommender is taken to the recommendation page.
4. The recommender clicks the decline button.
5. The recommender is shown a confirmation message.
When a recommendation request is declined, Recruiter updates the request status to “Declined”, sends an e-mail to the prospect with the request status, and creates a new recommendation request so that a record is kept of the declined recommendation request and the prospect can send a new request to another recommender.
Application Reviews

Recruiter provides an application review process that gives a group of people the option to review, comment, and provide a suggested admission decision on an application. An application folder is created when an application is created or imported in Recruiter. The application folder includes information about the prospect, a cover sheet, an application, and any supplemental items.

Each application folder has an owner who is responsible for tracking the status of the folder, assigning reviewers, and entering the proposed admissions decision. An application reviewer can view the application folder, but cannot make changes to the record. Also, a reviewer cannot access or view information by another reviewer. An owner can assign either an individual user or a team of users as reviewers.

To automate some of the processing of the application folder review process, you can create workflows to change the application folder status, assign a different owner, and assign reviewers. We recommend that you create one workflow to handle one or more of these options instead of separate workflows for each option. For more information about creating workflows for application folders, see the “Configuring the Application Folder” section of the Recruiter Configuration manual.

When setting up the application folder review process for your institution, you customize certain options. You can create different application folder review forms or cover sheets for different application types, and you can create additional application folder statuses that are tailored to your institution’s review needs. For more information about creating additional application folder statuses, see “Application Folder Statuses” on page 135.

You can also customize the Assign Application Folder Reviewers dialog to change the actions taken when a review is assigned. You could include a step to send a reviewer an e-mail or refine the task.

**Note:** If you customize the process, you should create a new dialog and then set the ApplicationFolderAssignReviewerDialogID configuration setting with the name of the custom dialog you created. For more information about how to customize the process, see Create or edit a dialog article in the Microsoft Dynamics CRM help.

There may be times when you want to group applications together so that they can be reviewed together. These could be applications for early decision or for a particular academic program. Using the Group field on the application
folder, you can add a value in this field and then create a view in Recruiter to see only those specific application folders. You can also add this attribute to other views so that you can see how each folder is grouped.

Application Review Process

To begin the application folder review process, an application folder must have an owner and reviewers. For each reviewer, a separate review record is created that is tied to the application folder. The contents of the application folder depend on the application type. You can open the review from a task or from the application folder to begin the process of reviewing an application folder.

During the application folder review process, each reviewer will provide a proposed decision, which the application folder owner will review. The reviews help the application folder owner to make the final proposed decision. This decision can then be sent to your ERP system, where the final decision and the notification to the applicant is made.

There might be situations where a proposed decision for the application folder cannot be reached and the application folder needs to be escalated to a committee for further review and discussion. When an application needs to be referred to a committee, you can do the following:

- Set the application folder status to one that indicates a committee review. That exact status is defined by you when you define your custom application folder statuses.
- Set the owner of the application to the team that you have defined for the committee.
- Complete the review and then set the new proposed decision and correct application folder status.

In other cases, additional information might be required to make the proposed decision. In these cases, the application folder should be placed into a hold state, and additional supplemental item submissions can be attached to the application. When they are received, the application folder owner must prepare the application folder for another review.

A decision is sometimes reached based on specific criteria, in which case you can automatically accept or deny an application folder. You can create a custom workflow that would run when the application status is set on the application folder to either Application Submitted or Application Marked Complete. The workflow can use any data on the application or prospect as conditions to determine whether the prospect should be admitted or denied.
The workflow would set the proposed decision on the application folder and set the application folder review as complete, which would then allow the information to be submitted to your ERP system.

The application can also be deferred or waitlisted. Using the Group field on the application folder, you can add a tag and comments to the application folders that have been waitlisted or deferred. Using a view on the application folder grid, you can view the waitlisted or deferred applications.

An applicant might want to appeal an admissions decision. When an appeal is received, the folder status is changed to Appealed (if you set up the codes to do this). The application folder must then be sent out for another review. For more information, see “Application Folder Statuses” below.

**Note:** A reviewer can only have one active review for each application folder. If a reviewer must review an application folder more than one time because the application has been sent to the committee or is in appeal, you must deactivate the first review.

---

**Application Folder Statuses**

An application folder status indicates what stage of the review process the application is in. You can add additional statuses that map back to the delivered categories to further refine the status of the application folder. These statuses are available in the Settings > Validation List Management > Application Folder Status area. Ellucian delivers codes of “Application in progress,” “Ready for review,” “Review in progress,” “Review on hold,” “Review complete,” and “Review cancelled,” which can be used to categorize additional status codes that you create.

If you are going to use the application folder review process for appeals, you can also set up application statuses for the different steps in the appeal process. For example, if there is a lengthy review process, the Appeal in Progress status can be set. After the final decision is made, the folder can be assigned the Appeal Completed status. If the decision is overturned, a new Application Status Type record can be used with a status of Accepted Appeal or Appeal Denied.
Managing the Prospective Student Experience

In This Chapter

This chapter includes information about managing the experience that your prospective students have with your institution through the Recruiter external website. Table 16 lists the topics covered in this chapter.

Table 16: Topics in This Chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prospective Student Experience</td>
<td>138</td>
</tr>
<tr>
<td>External Website Details</td>
<td>140</td>
</tr>
<tr>
<td>Smart Links and Quick Forms</td>
<td>158</td>
</tr>
<tr>
<td>Create Account Verification Process</td>
<td>159</td>
</tr>
</tbody>
</table>
Prospective Student Experience

Institutions must actively engage students in the recruiting and admissions process in order to reach enrollment goals and to recruit students who are a good fit for the institution. Making the student experience as friendly, easy, and personalized as possible is important to attracting and involving students in this process. Recruiter provides ways to both manage and enhance the experience that students have with your institution.

At the forefront of the prospective student experience is the Recruiter external website, which is a customizable public-facing website that students can interact with during the recruitment process. Additionally, Recruiter provides support for Smart Links and Quick Forms, which guide students to your external website by providing them with e-mail links to partially populated forms. Recruiter also offers the Create Account Verification process that lets students securely activate their user accounts on your external website and reduce duplicate prospect records within Recruiter. By using these options, you can help prospective students engage with your institution and have a positive recruitment experience.

What You Can Do to Enhance the Prospective Student Experience

You can enhance the prospective student experience in the following ways:

- Style the external website for your institution, which includes setting up Program Spotlight, Contact Us, and Facebook options on the My Account page to engage students.
- Set up a Facebook application that lets students log in to your external website using their Facebook credentials and automatically supply basic identification and e-mail information to your institution.
- Customize delivered Recruiter forms for your institution, such as those used to gather information for accounts, profiles, events, recommendations, or applications.
- Set up and send personalized e-mails to prospective students with Smart Links that access Quick Forms.
- Use the Create Account Verification process to reduce duplicate prospect records and provide secure activation for prospect accounts.
What Prospective Students Can Do on the External Website

Prospective students can engage with your institution on the external website in the following ways:

- Access the correct prospect account form on the external website from e-mail.
- Complete an inquiry request for more information.
- Log in using their Facebook credentials.
- Create an account.
- Activate an existing account.
- View information about your institution from their My Account pages.
- Update profile information, such as address and demographic details.
- Register for events, such as campus tours or admissions workshops.
- Request letters of recommendation.
- Start an online application and complete it at a later time.
- Submit supplemental items that are required in the application process.
- Contact your institution for additional information.

What Other Contacts Can Do on the External Website

Other contacts can engage with your institution on the external website in the following ways:

- Write letters of recommendation or decline recommendation requests.
- Contact your institution for additional information.
External Website Details

The Recruiter external website allows prospective students to create an account with your institution, register for events, complete an online application, and request recommendations. Depending on how your institution has set up the website, prospects can also view general information about your institution or information that is specific to them, such as an academic program of interest.

You can customize the external website by:

- **Styling the external website.** You can brand the website by changing default images and text, customizing the style sheets, and setting up controls that are used in the website. See the *Styling the Recruiter Website* manual for more information.

- **Customizing forms in Recruiter.** You can customize tabs, sections, fields, and other options used on forms, which are displayed to prospective students as pages or controls in the website. See the “Configuring Forms” section of the *Recruiter Configuration* manual for more information.

The main areas of the external website include:

- Login page
- My Account page
- Create Account and Prospect Inquiry pages
- Prospect Profile control and Update Prospect Profile page
- Event control and pages
- Online Application control and pages
- Recommendation controls and pages

The following sections outline the predominant features of each area and provide references to additional configuration information.
Login Page

Prospective students will see the Login page when accessing your external website.

If you have configured the Facebook login feature, students can click **Connect with Facebook** to log in to your external website using their Facebook credentials. By doing this, they can automatically supply your institution with basic Facebook profile information, such as name, e-mail address, and birthday. This option allows prospective students to easily log in to your external website by not having to remember additional credentials or re-enter credentials if they are already logged in to Facebook.

After clicking **Connect with Facebook**, if prospective students have not yet created an account on your external website, they will be prompted to do this. If prospective students have already created an account on your external website, they will be prompted to log in with their current account credentials. Facebook credentials will be associated with the account after they log in. In the future, when prospective students log in to your external website, they can click **Connect with Facebook** and their Facebook credentials will be used to log in to their account. If they are already logged in to Facebook, they’ll be logged in automatically to your external website.

Prospective students will be prompted to give your institution’s Facebook application permission before logging in to the external website. They will be prompted to do this in one of three cases:

- If they have never given permission to the application.
- If they have revoked access to the application.
- If the application changes and requires additional permissions than those that were originally granted by the student.

For more information about configuring the Facebook login feature, see the “Facebook Login Styling” section of the *Styling the Recruiter Website* manual.
Figure 31: Login Page Example

![Login Page Example](image-url)
My Account Page

The My Account page is the hub of a prospective student’s external website experience. This page is available to prospects after they create an account.

From this page, prospects can do the following:

- View profile information.
- Access a page to update profile information.
- Access a page to change their account password.
- View upcoming events.
- Cancel event registrations.
- Access a page to register for events.
- View steps in the application process.
- Access a page to start and manage their online applications.
- Access a page to submit supplemental items and view and manage recommendation requests.
- View Program Spotlight, Contact Us, and Facebook information for your institution.

For more information, see the “My Account Page Styling” section of the Styling the Recruiter Website manual.
Figure 32: My Account Example
Create Account and Prospect Inquiry Pages

When prospective students access your external website, you can provide them with links to create an account or, optionally, to request more information from your institution without having to create an account.

Recruiter delivers more than one prospect account form that you can use on your external website:
- **Create Account Form.** Lets prospective students share demographic information and create accounts so that they can revisit the external website to register for events and complete online applications (Figure 33).
- **Prospect Inquiry Form.** Lets prospective students share demographic information without creating accounts so that they can be contacted to learn more about your institution (Figure 34).

You can use one or both forms on your external website. You can also customize the forms within your own unmanaged solution as necessary. For more information, see the “Multiple Prospect Account Forms on the External Website” section of the *Recruiter Configuration* manual.

If you have configured the Facebook login feature, prospective students can create an account using their Facebook credentials. If you are automatically directing them to this page instead of the Login page, they will see the **Connect with Facebook** option on the Create Account form. For more information about how this feature works on the external website, see “Login Page” on page 141.
Figure 33: Create Account Example
Figure 34: Prospect Inquiry Example
Prospect Profile Control and Update Prospect Profile Page

The Prospect Profile control on the My Account page displays basic profile information that prospective students input when they create an account. This control is a combination of a Recruiter form and links to other webpages. For more information, see the “Prospect Profile Control” and “Update Profile Page Styling” sections of the Styling the Recruiter Website manual.

Recruiter delivers more than one prospect profile form that you can use on your external website:

- **Prospect Profile Form.** Lets prospects view their existing demographic information. This form is the basis of the Prospect Profile control (Figure 35).

- **Update Prospect Profile Form.** Lets prospects update their demographic information (Figure 36).

You can use one or both forms on your external website. You can also customize the forms within your own unmanaged solution as necessary. For more information, see the “Multiple Prospect Profile Forms on the External Website” section of the Recruiter Configuration manual.

**Figure 35: Prospect Profile Example**

![Prospect Profile Example](image)

My Profile

Joe Smith

Anticipated Entry Term *
2013 Fall Term

Academic Program of Interest

jsmith@gmail.com
Figure 36: Update Prospect Profile Example

Update Profile

My Profile

First Name *
Joe

Last Name *
Smith

Anticipated Entry Term *
2013 Fall Term

Academic Program of Interest

Email Address
jsmith@gmail.com

Home Phone

Check if address is outside of U.S. or Canada

Address

Address (cont)

City

State/Province

ZIP/Postal Code

Save Changes
Event Control and Pages

Below the Prospect Profile control on the My Account page is the My Events control. Prospects can view the events they have registered for and cancel event registrations, if permitted by the institution. Prospects can also click the provided link to view the Events Calendar, search for events, and select events that they would like to attend. For more information, see the “Events Registered List Control” and “Styling Event Pages” sections of the Styling the Recruiter Website manual.

When creating an event, you can decide if you want to allow prospective students to register anonymously for the event. If you do, a student can register for the event without creating an account on your external website. Otherwise, the student is required to create an account, if one has not already been created, and is then presented the registration page for that event.

The event registration pages are Recruiter forms. You can use a different form for each type of event your institution holds. For example, you might want to collect more information about a prospective student who is attending an admissions workshop than one who is attending a campus tour. To do this, you would need two different event forms with different fields. For more information, see the “Multiple Event Forms on the External Website” section of the Recruiter Configuration manual.

Figure 37: My Event Control

![My Event Control](image-url)
Figure 38: Event Calendar Control

Welcome to the Events Calendar and Registration page. Narrow or broaden the list of events by selecting a category, time period, or location and click Search. Click on an event title to see the event summary. If the event requires registration to attend, a link to the registration page is provided on the event summary page.

Time Period

Date From: 11/12/2013

Date To:

Date Shortcuts:

Category Details

Event Category: Select All

Hosting Organization: Select All

Academic Level: Select All

Location

On/Off Campus: Select All

Event Location: Select All

Zip Code:

Distance From Zip (mi):

Search

No events were found matching your search criteria.
Figure 39: Event Registration Example

Event Registration

Freshman Tour

First Name: Joe
Last Name: Smith

Email Address: jsmith@gmail.com

Meal Preference:

Address:

City:

State/Province:

Postal Code:

Phone:

Anticipated Entry Term:

Register
Online Application Control and Pages

At the bottom of the My Account page is the Next Steps control for the application process. Prospects can see where they are in the application process for up to three applications, specifically whether they have started an application, completed an application, or how many supplemental items have been received. If prospects have more than three applications, they can click a link to view them on another page. Prospects can also click the provided links to access the next step of the online application process or to start a new application. For more information, see the “Next Steps Control” and “Styling Application Pages” sections of the *Styling the Recruiter Website* manual.

To begin the application process, the prospective student is required to create an account, if one has not already been created, and is then presented with an online application. Online applications are Recruiter forms. You can use a different form for each type of online application your institution needs to create. For example, you might need an undergraduate application, a graduate application, and a continuing education application. To do this, you would need to create three different application types and then configure three different application forms with different fields. You can also import applications from different vendors into Recruiter. For more information, see the “Configuring Applications” section of the *Recruiter Configuration* manual.

**Note:** If you are using the Common Application, you can set up Recruiter to track and receive the supplemental item submissions through the external website. For more information, see “Managing Applications and Application Reviews” on page 119.

![Figure 40: Next Steps Control](image)
Figure 41: Online Application Example

<table>
<thead>
<tr>
<th>Plans</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Demographics</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Family</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Academics</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Activities</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Signature</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Please enter your information in each of the following sections. Fields with a red asterisk (*) are required and must be completed before you can submit your application. Additional questions may become required based on your answers to a previous question.

**Permanent Address**

- Address *
- City *
- State/Province
- Zip/Postal Code

**Foreign Address Line**

Enter the 2nd line of the foreign address as it appears on the mailing label.

- Country
- Best Name of Delivery
- Attention

**Contact**

- Home Phone *
- Cell Phone
- Email Address *

**Temporary Address**

Indicate current address different than permanent address?

- Yes
- No

Previous Page | Save Application | Save & Continue
Recommendation Controls and Pages

If your institution has set up the letters of recommendation feature, certain recommendation controls and pages will be displayed to prospects and others will be displayed to recommenders.

A prospect can start, resend, cancel, or view recommendation requests from the supplemental items page. When the prospect completes and submits a recommendation request, an e-mail is sent to the recommender. The recommender can access the external website from the e-mail and either decline the recommendation request or submit a recommendation on behalf of the prospect. For more information, see the “Styling Application Pages” section of the Styling the Recruiter Website manual.

The recommendation request, decline recommendation request, and recommendation pages are Recruiter forms. You can use a different form for each type of recommendation needed by your institution. For example, you might want to create different forms for professional and personal recommendations, or you might want to create different forms for undergraduate and graduate students. For each of these examples, you would need to create two different recommendation forms with different fields. For more information, see the “Multiple Recommendation Forms on the External Website” section of the Recruiter Configuration manual.

Figure 42: Applicant Recommendation Request List Control

![Recommendation Requests Table]

<table>
<thead>
<tr>
<th>Request</th>
<th>Recommender</th>
<th>Status</th>
<th>Status Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal Recommendation 1</td>
<td>Jerry Jones</td>
<td>Sent</td>
<td>07/22/2013</td>
</tr>
<tr>
<td>Professional Recommendation 2</td>
<td>David Jones</td>
<td>In Progress</td>
<td>01/22/2013</td>
</tr>
<tr>
<td>Professional Recommendation 1</td>
<td>George Jones</td>
<td>Completed</td>
<td>01/22/2013</td>
</tr>
<tr>
<td>Personal Recommendation 2</td>
<td>Clark Jones</td>
<td>Declined</td>
<td>07/22/2013</td>
</tr>
<tr>
<td>Professional Recommendation 2</td>
<td>Alix Jones</td>
<td>Cancelled</td>
<td>07/22/2013</td>
</tr>
</tbody>
</table>
Figure 43: Applicant Recommendation Request Example

Recommendation Request

Recommender Name *

Recommender Email *

I waive my right to access the requested recommendation

Use the space below to include a personal note in the notification email that is delivered

Submit Request

Figure 44: Decline Recommendation Request Example

Decline Recommendation Request

Recommendation Request Information
Applicant:
John Doe

The applicant has waived the right to view their recommendations:
Yes

Personal note from applicant:
Prof Jones, I was hoping you could provide a recommendation for my application to the school of engineering. Thanks.

Decline the request  Accept the request
**Figure 45: Recommendation Page Example**
Smart Links and Quick Forms

You can use Smart Links and Quick Forms to provide prospective students with a personalized experience and to help them access your external website. Smart Links are links in e-mails that launch a specific page on your external website. Quick Forms are webpages that are partially populated with existing data about the prospective student.

These options used in combination with a purchased suspect list allow you to pursue additional leads for prospects. You can send the suspects on the list an e-mail encouraging them to visit your website where they can create an account or complete an inquiry form, thus building a relationship with them. Likewise, you can encourage prospects to create an account so that they can register for events or complete an online application.

If Recruiter records already exist for prospective students, using Quick Forms allows certain information to be prepopulated from those records, making the process of creating a new account or completing an inquiry form easier for students. Students are required to either verify their identity or activate an account (if using the Create Account Verification process) before they are allowed access to personalized Quick Forms.

Recruiter supports using CRM e-mail templates or ExactTarget to create e-mails with Smart Links. To activate accounts using the Create Account Verification process, CRM e-mail templates must be used to create the e-mail with the activation Smart Link.

For more information about creating e-mail templates or ExactTarget e-mails to Quick Forms on the external website, see the “Configuring and Using E-mail” section in the Recruiter Configuration manual.

For more information about creating multiple prospect forms to use as Quick Forms, see the “Multiple Prospect Account Forms on the External Website” section in the Recruiter Configuration manual.

For more information about setting up and using the Create Account Verification process, see “Create Account Verification Process” on page 159.
Create Account Verification Process

The Create Account Verification process can be used to detect duplicates during the account creation process and to require that prospects activate their accounts after creation. These features can be used together to prevent duplicate records from being created and to provide a security check through further verification of the prospect’s account information.

This functionality is controlled by the following configuration settings:

- **ExternalSiteEnableCreateAccountDuplicateDetection.** This setting controls whether the create account process checks for duplicate records when a prospect creates an account.
- **RequireEmailActivationOfAllCreateAccounts.** This setting controls whether all prospects must activate their accounts after creating them regardless of whether duplicate records are found.

**Note:** By default, both of these configuration settings are disabled.

When an account is created with both configuration settings enabled, the following scenarios can occur:

- If a prospect who does not already have a prospect record in Recruiter creates an account, a prospect record is created with a status of “inactive,” and an account activation e-mail is sent to the prospect.

**Note:** If the **RequireEmailActivationOfAllCreateAccounts** configuration setting is disabled, the prospect will be redirected to the “My Account” webpage, and no activation e-mail will be sent.

- If a prospect who already has a prospect record in Recruiter, but has not yet created an account, creates an account using the same name and e-mail address as the prospect record, a new “inactive” prospect record is created and an account activation e-mail is sent to the e-mail address that the prospect entered on the Create Account form.

**Note:** If the **ExternalSiteEnableCreateAccountDuplicateDetection** configuration setting is disabled, a duplicate prospect record will be created.

- If a prospect who already has an “active” account in Recruiter creates an account, the prospect will be prompted with a screen asking whether the prospect has created an account in the past. If the prospect has already created an account, the system displays the prospect’s Security Question to
verify the prospect’s identity. If the prospect answers the Security Question correctly, the existing account and prospect records are updated with any new information that the prospect entered on the Create Account form. Alternatively, if the prospect chooses to create a new account and the e-mail address entered on the Create Account form matches an existing account, the prospect will receive an error and must enter a new e-mail address.

Until an account is activated, prospects will not have access to functionality on the external website that requires them to be logged in, such as registering for an event or completing an online application. Instead, they will be redirected to a webpage that indicates that their account is pending activation.

The create account activation process sends an e-mail to the prospect, which contains a link used to activate the account. After the account has been activated, the prospect has access to the full functionality of your external website. In addition, if any unambiguous duplicate records existed, they will be automatically merged.

**Note:** If a duplicate suspect or prospect record is found, but the e-mail address on the existing record is different than the e-mail address being used to create the account, the activation e-mail will be sent to the new e-mail address entered on the Create Account webpage, and, if activated, a new prospect record and account will be created and no records will be merged.

In Recruiter, the External User Authorization form contains the following fields that support this functionality:

- **Pending Activation.** This field indicates whether the prospect has activated the account.
- **Duplicate Suspect or Duplicate Prospect.** This field stores any duplicate records found during the create account process. The listed duplicate record will be merged with the “inactive” prospect record after the prospect activates the account.

**Merging Duplicate Records**

When a prospect creates an account, the prospect is evaluated to see if there is an existing prospect or suspect record already in Recruiter. If an unambiguous duplicate is detected, the duplicate records are merged after the account has been activated. The information that the prospect entered on the Create Account form overwrites any pre-existing information with the exception of the source and child entity data.
If there is more than one potential duplicate record, the records will not be merged and you could potentially have duplicate records for the same prospect. For example, if a prospect enters the same name and e-mail address as an existing prospect record, and you have a duplicate detection rule that checks for the same name and e-mail address, Recruiter considers this an unambiguous duplicate and the prospect records are merged. If the prospect enters the same name, but a different e-mail address, the system creates a new prospect record that might be a duplicate.

**Configuring the Create Account Verification Process**

To configure the Create Account Verification process, perform the following steps:

1. “Update Duplicate Detection Rules” on page 161
2. “Create an E-mail Template for Account Activation” on page 161
3. “Review External Website Activation Webpages” on page 162
4. “Enable Create Account Verification” on page 163
5. “Test the Create Account Activation Process” on page 164

**Update Duplicate Detection Rules**

Recruiter is delivered with basic duplicate detection rules that are used by the Create Account Verification process to check for duplicate records; however, you might want to create a more robust set of duplicate detection rules. For details about duplicate detection, see “Managing Duplicate Data” on page 205.

**Create an E-mail Template for Account Activation**

Recruiter is delivered with a default hard-coded e-mail for the e-mail that is sent to prospects if they must activate their account. If you do not want to use the default e-mail, your institution can create a new e-mail template. See the “Create an E-mail Template for Activating External Website Accounts” section of the *Recruiter Configuration* manual.
Review External Website Activation Webpages

The Recruiter external website is delivered with two ASPX webpages that are displayed to prospects during the activation process:

- `CreateAccountLockout.aspx`
- `CreateAccountActivated.aspx`

The `CreateAccountLockout.aspx` webpage (Figure 46) is displayed to prospects, whose accounts are pending activation, when they try to use a function on the external website that requires users to be logged in.

Figure 46: The Account Pending Activation Webpage

Account Pending Activation

Your account is pending activation. You will receive an e-mail soon containing instructions on how to activate your account. If you do not receive an e-mail, you can use the link below to have the activation link resent to your e-mail address.

Resend Activation E-mail

If a prospect clicks the “Resend Activation E-mail” link, a new copy of the activation e-mail is sent to the prospect, and the `CreateAccountLockout.aspx` webpage displays a confirmation that the e-mail was sent (Figure 47).

Figure 47: The Account Pending Activation E-Mail Confirmation Webpage

Account Pending Activation

Activation E-mail Sent.

The `CreateAccountActivated.aspx` webpage (Figure 48) is displayed to prospects after they activate their account using the link provided in the activation e-mail. The prospect’s account is now activated and the full functionality of the external website is available.

Figure 48: The Account Activated Webpage

Account Activated

Your account is now activated. Please log in and visit the My Account page to get started.

Your institution can customize the text that is displayed on both the `CreateAccountLockout.aspx` and `CreateAccountActivated.aspx` webpages.
Enable Create Account Verification

To enable the configuration settings for the Create Account Verification process, perform the following steps.

**Step 1.** In Recruiter, in the Navigation Pane, click **Settings**.

**Step 2.** In the General Settings section, click **Configuration Settings**.

**Step 3.** To enable the duplicate detection functionality of the Create Account Verification process, do the following:

- a. In the Configuration Settings pane, click **ExternalSiteEnableCreateAccountDuplicateDetection**.

- b. In the **Value** field of the Configuration Setting pane, enter **TRUE**.

- c. Click **Save & Close**.

**Step 4.** To enable the new account activation requirement for all prospects functionality of the Create Account Verification process, do the following:

- a. In the Configuration Settings pane, click **RequireEmailActivationOfAllCreateAccounts**.

**Note:** You should enable this setting if you want to ensure that all prospects activate their accounts after creating them regardless of whether duplicate records are found. If the **ExternalSiteEnableCreateAccountDuplicateDetection** setting is enabled, activation occurs automatically for duplicate records.

- b. In the **Value** field of the Configuration Setting pane, enter **TRUE**.

- c. Click **Save & Close**.
Test the Create Account Activation Process

Ellucian recommends that you test the create account activation process after you have configured it. If the process is not configured properly, prospects will not be able to activate their accounts and, as a result, will not be able to access functionality on your external website that requires them to be logged in, such as registering for events or completing online applications.

To test the create account activation process, perform the following steps.

Pre-Test Steps

Step 1. Before changing any settings, verify that the e-mail router is configured and working properly for the Recruiter installation that you are working with.

Step 2. If you created an e-mail template to use for the activation e-mails, verify that the URL format used in the e-mail matches the e-mail router URL formatting settings.

You can test the e-mail template by sending the e-mail to a prospect using a test e-mail address. After the e-mail has been sent, you can view the e-mail activity that is created, and then inspect the URL format by copying the URL and pasting it into a text editor.

Test Steps

Note: To test the create account activation process, the RequireEmailActivationOfAllCreateAccounts configuration setting must be enabled. See “Enable Create Account Verification” on page 163, for more information about enabling this setting.

Step 1. In a browser, access your Recruiter external website, and then click the Create Account link.

Step 2. Create an account using your e-mail address. After you have created the account, you should be redirected to the “Account Pending Activation” webpage.

Step 3. Check your e-mail account for the e-mail that contains the account activation link.
If you did not receive the activation e-mail, verify that you performed the “Pre-Test Steps” on page 164, and then verify in Recruiter that the e-mail has been sent.

In addition, you can review the error log in Recruiter and look for any entries that begin with “Account Activation Email Could Not Be Sent.” To view the error log in Recruiter, perform the following steps:

a. In Recruiter, in the Navigation Pane, click Settings.

b. In the Extensions section, click Error Log Entries.

Review the error log entries to determine the cause of the error.

- If the entry shows that the record has no Contact keys, the prospect record is missing two security key values that are generated when the record is created. To generate the missing security keys, perform the procedure described in the “Populate the Create Account Key Fields” section of the Recruiter Installation Procedures manual.

- If the entry shows that there is a missing template ID configuration setting, you must enter a value in the ExternalApplicationFormLocation configuration setting. To enter this value, perform the following steps:

1. In the Navigation Pane, click Settings.

2. In the General Settings section, click Configuration Settings.

3. In the Configuration Settings pane, click ExternalApplicationFormLocation.


5. Click Save & Close.

Step 4. Click the link in the activation e-mail. You are taken to the “Account Activated” webpage.

Step 5. After the account has been activated, log in using the account username and password that you entered during the create account process.
Step 6. Navigate to the My Account webpage. If you are able to view the “My Account” webpage, the create account activation process is properly configured. If you are redirected to the “Account Pending Activation” webpage, review the error log entries in Recruiter for details.
Managing Communications Options

In This Chapter

This chapter includes information about managing your communications options in the Recruiter interface. Table 17 lists the topics covered in this chapter.

Table 17: Topics in This Chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communications Overview</td>
<td>168</td>
</tr>
<tr>
<td>Communication Options in Recruiter</td>
<td>168</td>
</tr>
<tr>
<td>E-mail Options in Recruiter</td>
<td>171</td>
</tr>
<tr>
<td>Campaigns or Workflows</td>
<td>173</td>
</tr>
<tr>
<td>Additional Campaign Features</td>
<td>176</td>
</tr>
<tr>
<td>Ad Hoc Activities or Quick Campaigns</td>
<td>182</td>
</tr>
<tr>
<td>Create Ad Hoc Activities</td>
<td>183</td>
</tr>
<tr>
<td>Create Quick Campaigns</td>
<td>185</td>
</tr>
<tr>
<td>Create Calendar Campaigns</td>
<td>187</td>
</tr>
<tr>
<td>Create Communications Workflows</td>
<td>192</td>
</tr>
<tr>
<td>Use ExactTarget E-mails in Recruiter</td>
<td>197</td>
</tr>
<tr>
<td>Use Mail Merge in Recruiter</td>
<td>199</td>
</tr>
</tbody>
</table>
Communications Overview

A strategic communications plan is essential to promoting your institution and engaging students in the recruiting and admissions process. Designing and implementing a communications plan requires you to have compatible and flexible tools. Recruiter provides multiple ways to manage tasks and activities for your communications plans. The following sections are designed to give you additional information to make the best choices for your institution.

Communication Options in Recruiter

How you choose to communicate with suspects, prospects, applicants, and other contacts is a strategy that should take into consideration several variables. The followings communications options are available to you in Recruiter and can be combined to best fit your business requirements and goals.

Option 1 - Ad Hoc Activities

Though it is often necessary and desirable to automate functions during a campaign, in certain cases, personal engagement works better than automated functions and can inspire a more personal prospect experience. Recruiter facilitates this option by providing the ability to create and complete communication activities in an ad hoc manner.

- Example 1: A recruiter calls a prospect who has gone quiet to check in.
- Example 2: A recruiter remembers that a prospect likes basketball and the school’s team is going to be featured on television. The recruiter sends the prospect an e-mail with this information.

For more information, see “Create Ad Hoc Activities” on page 183.
**Option 2 - Quick Campaigns**

Sometimes an administrator or recruiter may want to perform an activity for a group of prospects, such as sending an e-mail, or to assign a task to a group of recruiters, such as calling prospects about a specific event in their area. Quick campaigns allow you to communicate with a list of prospective students outside of a formal communications campaign. There are three ways that you can select the list of prospective students for your quick campaign:

- Select the prospective students directly.
- Do a search using Advanced Find and create a quick campaign from the resulting list of records.
- Create a quick campaign from a marketing list that has members.

Activities that are assigned by quick campaigns can be given a due date and the activities will be displayed in the Workplace of the recruiter to which the activity is assigned.

- Example 1: An administrator creates a quick campaign to assign a task to the recruiter responsible for territory 3 to call each prospect in the fall term and remind them about the open house.
- Example 2: To encourage more individual communications, an administrator creates a quick campaign that assigns a phone call activity to each recruiter to complete with all of the recruiter’s prospects.

For more information about quick campaigns, see the *Work with Quick Campaigns* article in the Microsoft Dynamics CRM help and “Create Quick Campaigns” on page 185.

**Option 3 - Calendar Campaigns**

A calendar campaign is a structured, marketing program that uses many communication methods targeted at a specific population to accomplish specific results. Campaigns allow you to create and distribute activities the same way as quick campaigns with added functionality and planning tools.

Campaigns tie together several activities to create an overall communication plan. Campaigns also support automatic distribution of campaign activities, catch-up processing on campaign activities, and drip campaigns, which allow you to planfully stagger communications.
A calendar is provided to see scheduled activities in advance, and you can associate marketing lists of prospects (or other contacts) who should receive your campaign communications. With additional budgetary and enrollment goals tracking, you can also measure the effectiveness of the campaign.

- Example 1: A recruitment team creates a campaign that contains all of the planning activities for creating marketing materials and setting up tasks for the Fall recruitment campaign.
- Example 2: An administrator loads a four-step activity plan into a campaign and then sets the scheduled start dates on the activities to automatically distribute the planned tasks in sequence. One of the activities is to send a bulk e-mail using ExactTarget that notifies new prospects about an open house.

For more information, see “Create Calendar Campaigns” on page 187.

**Option 4 - Workflows**

Recruiter uses Microsoft Dynamics CRM workflows to automate certain functions within the system. You can also set up workflows to automate certain actions within a communications plan based on specific system triggers. These triggers can include items that are created or completed by a prospect, a recruiter, or the system automatically at a set interval. Using workflows, Recruiter can automatically generate e-mails and assign activities without manual user intervention.

- Example 1: Upon submitting an application, a prospect receives an automatic e-mail confirmation. Five days later, the prospect is reminded by an automatic e-mail to submit supplemental items.
- Example 2: As new prospects are added to Recruiter, a workflow generates a task for recruiters to call and introduce themselves.

For more information, see the “Create Communications Workflows” on page 192.
E-mail Options in Recruiter

It is important to understand which options are available to you for e-mail communications so that you can choose the methods that best fit your institution. These options can be combined to best fit your business requirements and goals.

You have three main options for creating e-mail communications:
- ExactTarget
- E-mail Templates or E-mails
- Mail Merge

ExactTarget

The ExactTarget solution allows your team to send robust HTML e-mails to larger groups of suspects or prospects for marketing purposes. These e-mails are driven through a white-listing service to ensure that they are not marked as spam. Tracking analytics are also available to manage the effectiveness of your ExactTarget e-mails.

You can send an ExactTarget e-mail from a calendar campaign or a workflow. After you have installed ExactTarget and set the initial configuration options, you can begin sending ExactTarget e-mails from Recruiter. By using the “Other” campaign activity channel, you can automatically distribute and send ExactTarget e-mails as part of a campaign. You can also configure communications workflows to automatically send ExactTarget e-mails after specific events occur. Finally, as needed, you can manually send ExactTarget e-mails to individuals or marketing lists.

You must create ExactTarget e-mails within the ExactTarget application. Ellucian provides each institution with one HTML template and each institution can create additional templates as needed.

**Note:** ExactTarget e-mails can be sent up to a certain number of recipients as specified in each individual contract.

For more information, see “Use ExactTarget E-mails in Recruiter” on page 197 and the “Configuring ExactTarget” section in the *Recruiter Configuration* manual.
**E-mail Templates or E-mails**

E-mail templates allow you to create and distribute direct e-mails, or bulk e-mails, of the same message to multiple e-mail recipients in Recruiter. You might choose to create e-mail templates for frequently requested information that falls outside of high-impact marketing e-mails, such as directions to your campus or details for attending an event. Additionally, some features, such as the Create Account Verification process, require the use of e-mail templates. By using the “E-mail” campaign activity channel, you can automatically distribute and send e-mail templates as part of a campaign. You can also create e-mails in Recruiter without using e-mail templates; however, you cannot save and re-use them later.

For more information, see the “Configuring E-mail Templates or E-mails” section in the Recruiter Configuration manual.

**Mail Merge E-mails**

Mail merge e-mails allow you to use Microsoft Office Word templates to create e-mail messages (along with letters, faxes, and envelopes). You must have Microsoft Dynamics CRM for Outlook installed to use mail merge e-mails in campaigns, which are identified by the “E-mail via Mail Merge” channel. If you use mail merge options in campaigns, you must create and distribute the campaign activities using the Outlook connector, and then close them in the CRM Web application.

You cannot automatically distribute mail merge campaign activities. Instead, you will have to manually distribute the campaign activities on the days that they should be distributed.

For more information, see “Use Mail Merge in Recruiter” on page 199.
Campaigns or Workflows

Campaigns are powerful management containers for communications plans. Because of the management, distribution, processing, tracking, and reporting options provided in campaigns, they are generally preferred for managing communications plans in Recruiter. However, there are some key reasons why you may choose to use communications workflows for certain functions in addition to using campaigns. The following general guideline can be used when choosing between campaigns and communications workflows:

- Campaigns are desirable for large-scale, structured communication plans and for ad hoc activities that you want to track within the campaign framework.
- Communications workflows are desirable when you must trigger an automated function, such as an e-mail, off of a specific event each time that it occurs.

**Note:** It is recommended that you discuss your communications plans with your Ellucian Services consultant to ensure the best choices for your particular implementation.

Table 18 outlines the main differences between using campaigns and using workflows for communications plans. There are some advantages and limitations to each option.

### Table 18: Campaigns or Workflows

<table>
<thead>
<tr>
<th>Campaigns</th>
<th>Workflows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campaigns are less complex to create and maintain than workflows, making them easier to use by admissions staff.</td>
<td>Workflows provide tremendous flexibility; however, they are more complex to create and maintain than campaigns.</td>
</tr>
<tr>
<td>Campaigns are structured and centralized in the system. You can access associated records from the Campaigns area of the Recruiter interface.</td>
<td>Workflows are contained within the Processes area of the Recruiter interface. Although you can view the records on which workflows were run, you must know where to find the associated records in the Recruiter interface.</td>
</tr>
<tr>
<td>You do not need a programmer mentality (understanding of steps and conditional statements) to use campaigns.</td>
<td>You must understand steps and conditional statements to create workflows.</td>
</tr>
</tbody>
</table>
### Table 18: Campaigns or Workflows (cont’d)

<table>
<thead>
<tr>
<th>Campaigns</th>
<th>Workflows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processing campaigns is not system intensive.</td>
<td>Processing workflows can be system intensive. Workflows process asynchronously against the system, which can slow processing of other features within the system. Additionally, efficient workflow design is critical to processing time. For more information, see the “Understanding Workflows” section of the Recruiter Configuration manual.</td>
</tr>
<tr>
<td>You can view historical campaign information and obtain year over year results.</td>
<td>You can view historical workflow information for as long as the workflow job is available.</td>
</tr>
<tr>
<td>You can copy campaigns as templates and move them to the next year.</td>
<td>You can continue to use workflows from year to year or reprogram them each year.</td>
</tr>
<tr>
<td>Campaign details are viewable from a central location within Recruiter. You can also view when a record (prospect, suspect, organization) is part of a campaign from multiple areas of the Recruiter interface.</td>
<td>Workflow details are not viewable from a central location within Recruiter. You can look at the individual record (prospect, suspect, organization) to view which workflows were run for that record. You can also view a workflow to see which records the workflow ran against and which activities were created by the workflow.</td>
</tr>
<tr>
<td>Within a campaign, you can view details about which items were distributed. For example, you can view the associated campaign activities, see when they were generated, and see the specific items that were generated (for example, 1,400 e-mails to a specific marketing list as part of a drip campaign).</td>
<td>You can view details about which items were distributed by viewing the record of the distributed item. For example, to view which ExactTarget e-mails were sent to prospects from within a workflow, you must view the associated ExactTarget send record.</td>
</tr>
<tr>
<td>You can manage campaign members with marketing lists. If you have set up marketing lists correctly, you do not have to worry about including the right group of individuals.</td>
<td>You must trigger workflows off of specific records using dynamic values, which means that you must know how to configure the individuals that you want to include in each communication.</td>
</tr>
<tr>
<td>You can use the catch-up processing and drip campaign features.</td>
<td>You must configure a workflow with step and wait conditions to mimic catch-up processing and drip campaigns features.</td>
</tr>
</tbody>
</table>
You can set up a campaign for a specific number of communications and number of days.

You cannot limit the timeline of a communications plan using workflows. Instead, you must disable the workflow when you want it to stop triggering off of a specific event.

Although you can sometimes trigger off of a specific event, setup to do this correctly can be complicated. A workflow is preferable.

You can trigger off of a specific event, such as creating an account, submitting an application, etc.

Campaigns are restricted to communications activities.

You can perform additional actions as part of a workflow, such as creating related records, updating prospect data, etc.

<table>
<thead>
<tr>
<th><strong>Campaigns</strong></th>
<th><strong>Workflows</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>You can set up a campaign for a specific number of communications and number of days.</td>
<td>You cannot limit the timeline of a communications plan using workflows. Instead, you must disable the workflow when you want it to stop triggering off of a specific event.</td>
</tr>
<tr>
<td>Although you can sometimes trigger off of a specific event, setup to do this correctly can be complicated. A workflow is preferable.</td>
<td>You can trigger off of a specific event, such as creating an account, submitting an application, etc.</td>
</tr>
<tr>
<td>Campaigns are restricted to communications activities.</td>
<td>You can perform additional actions as part of a workflow, such as creating related records, updating prospect data, etc.</td>
</tr>
</tbody>
</table>
Additional Campaign Features

This section contains information about additional campaign features that can help you when designing and implementing your campaigns.

Catch-Up Processing

Catch-up processing allows you to complete campaign activities for any members that are added to a marketing list associated with an activity after the campaign has begun. For example, if you have an activity to send a new prospect a “welcome to our website” e-mail and you have catch-up processing enabled, when new prospects are added to the marketing list, catch-up processing can create additional campaign activities so that you can send the e-mail to the new prospects.

You can enable catch-up processing options when you add campaign activities to campaigns and define the schedule upon which the campaign activity is processed. Campaign catch-up processing occurs by using the “Catchup Campaign Activity” workflow that runs on a view of campaign activities. It is recommended that you set up a workflow schedule to run this workflow against the delivered “Catchup Eligible Activities” view. Each time a campaign activity is processed by the workflow, the Last Processed field is updated with the date the workflow ran, and any necessary catch-up actions are created automatically.

For more information, see the Define Campaign Catch-Up Processing article in the Recruiter help.
Drip Campaigns

Drip campaigns are a type of campaign that allow you to schedule the distribution of campaign activities with specific offsets. For example, you can send a welcome e-mail on day 1 of the drip campaign, send an information packet on day 5, make a phone call on day 14, and send a thank you e-mail on day 15.

Drip campaigns have an initiating activity and one or more subsequent activities, called drip activities. Each drip campaign has an initiating activity to which the marketing list and all drip activities are assigned. Each drip activity contains an offset number, which specifies the number of days after the initiating activity that the drip activity should be performed.

You can enable catch-up processing on an initiating activity, but you cannot enable catch-up processing for drip activities in a drip campaign. If catch-up processing is defined on the initiating activity, Recruiter will automatically create the corresponding drip activities, and set the scheduled start date based on the offset.

You can use either a static or dynamic marketing list for drip campaigns. The marketing lists that are assigned to the initiating activity are used for all associated drip activities in the campaign. If members are added or removed from a marketing list during the campaign, Recruiter can manage the changes to your marketing list and assign the appropriate catch-up activities. For this feature to work properly, you must set up the following workflows:

- To ensure that members who are added to a marketing list during a drip campaign can receive activities that were already distributed, you must create catch-up processing on the initiating activity, and run the “Catchup Campaign Activity” workflow. It is recommended that you set up a workflow schedule to run this workflow against the delivered “Catchup Eligible Activities” view.
- To ensure that members who are removed from a marketing list that is assigned to a distributed initiating activity are also removed from its undistributed drip activities, you must run the “Synchronize Drip Marketing List” workflow. This workflow synchronizes the marketing list for the drip activities with the marketing list for the initiating activity in the drip campaign. It is recommended that you set up a workflow schedule to run this workflow against the delivered “Drip Synchronize Eligible Marketing Lists” view.

For more information, see the Create Drip Campaigns article in the Recruiter help.
Automatic Distribution of Campaign Activities

Campaign activities must be distributed after they are created. Distributing a campaign activity assigns the activity to the specified owners, creates an activity for each prospect in the marketing list, and performs the activity automatically if possible. You can set up options to automatically distribute campaign activities on the scheduled day for the following channels: appointment, phone call, e-mail, letter, fax, or other (for ExactTarget e-mails). Mail merge activities cannot be automatically generated. This feature works in conjunction with catch-up processing and drip campaigns.

To automatically distribute campaign activities, you must create activity templates. Activity templates contain all of the information that is needed to generate the individual activities that are created during distribution. You can create the activity templates before you start your campaign, and add them to your campaign activities when you are ready to begin distributing them. After you have saved a campaign activity that is set to be distributed automatically with a scheduled start date and an activity template, the campaign activity will be automatically distributed when the “Distribute Campaign Activity” workflow runs on or after the scheduled start date.

Automatic distribution of activities occurs by scheduling the “Distribute Campaign Activity” workflow to run against one or more campaign activity views. For example, if you want to distribute all of the current day’s campaign activities, you can use the delivered “Pending Automatic Distribution Activities” view when setting up your workflow schedule. Likewise, if you want to distribute campaign activities differently by channel, you can set up custom views for each channel and use them when setting up your workflow schedule.

**Note:** For optimum results, you should make sure that all catch-up and drip campaign processing is complete before running the automatic distribution process. To do this, it is recommended that you run the “Catchup Campaign Activity” and “Synchronize Drip Marketing List” workflows overnight, and run the “Distribute Campaign Activity” workflow after those processes are complete.

**Note:** You should not run the “Distribute Campaign Activity” workflow on demand. It should always be set up to run automatically on a schedule.

For more information, see the *Automatically Distribute Campaign Activities* article in the Recruiter help.
Mapping Custom Fields for Automatic Distribution

When automatically distributing campaign activities, Recruiter will first copy the fields on the activity template to the fields on the created activity. If you have custom fields that you want to include in this process, you can map those fields from the activity template to the entity for the corresponding activity type.

On the Activity Template primary entity, five 1:N relationships exist with “Referential” behavior. They are: Appointment, E-mail, Fax, Letter, and Phone Call. To create a custom field mapping, in your unmanaged solution, add a custom field of the same type and format to the Activity Template entity and then map it to the corresponding field on the activity type entity.

For more information about relationships, see the “Understanding Recruiter Data and Relationships” section of the Recruiter Configuration manual. For more information about how to map fields, see the Create or edit mappings between fields article in the Microsoft Dynamics CRM help.

Marketing List Filtering

Before distributing a campaign activity, you can filter out individuals from your targeted marketing lists who have already received a specific previous communication or who have already registered (or not registered) for an event. When filtering by previous communications, you can identify the activity codes or subjects for the campaign activities that you want to use as filtering criteria. When filtering by event registrations, you can identify individuals who have registered for specific events or those who have not yet registered for specific events as filtering criteria. If an individual in a targeted marketing list for the campaign activity meets any of the filtering criteria, that person’s record will be excluded when the campaign activity is distributed.

If you are manually distributing campaign activities, you must run the “Filter Campaign Activity Marketing Lists” workflow on demand after you identify the filtering criteria and before you distribute the campaign activity. This workflow creates new static marketing lists from the original marketing list for distribution based on the member type (Prospect, Suspect, or Organization). You cannot distribute campaign activities while the workflow is running.

If you are automatically distributing campaign activities, you do not have to run the workflow after you identify the marketing list filtering criteria in the campaign activity. Filtering is done automatically by Recruiter prior to distributing the campaign activity.
Close Activities in Bulk

When a campaign activity is distributed, individual activities are created for each member of the target marketing lists associated with the campaign activity. In widely distributed campaigns, this can result in thousands of individual activities. Additionally, you may have individual system-generated activities that you need to close, such as those created during the standard import process.

It is important to mark all activities complete so that they do not become past due or because they are no longer needed. If you have a small number of activities, you or the activity owner can do this manually. If you have a large number of activities, you can close them in bulk.

The following activity types can be closed in bulk. When the activities are closed, the state is changed to “Completed,” with the following statuses, depending on the activity type:

- Appointment: “Completed”
- Email: “Completed”
- Fax: “Completed”
- Letter: “Sent”
- Phone Call: “Made”
- Task: “Completed”

**Note:** If you close a recurring appointment, the selected appointment will be closed but not the remaining appointments in the series.

To close individual activities for a specific campaign activity, go to the **Campaigns > Campaign Activities** area. Open the campaign activity, and click the appropriate link in the Navigation Pane to access the list of individual activities. Then, click **Close All Activities** on the ribbon to close all activities on all pages.

To close system-generated activities or a specific list of activities, go to the **Workplace > Activities** area. To make sure that you are only viewing the activities that you want to close, select a specific view of activities or use...
Advanced Find to change your search criteria (click **Advanced Find** on the ribbon, specify your criteria, and view the results). Then, click **Close All Activities** on the ribbon to close all activities on all pages.

For more information, see the *Close Individual Activities* article in the Recruiter help.
Ad Hoc Activities or Quick Campaigns

You can create both ad hoc activities and quick campaigns to respond to real-time events. Both ad hoc activities and quick campaigns allow you to create activities of any type for specific records and to assign due dates to them. Table 19 describes the differences between creating ad hoc activities and quick campaigns.

Table 19: Ad Hoc Activities and Quick Campaigns

<table>
<thead>
<tr>
<th>Ad Hoc Activities</th>
<th>Quick Campaigns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use for single record (for example, one prospect).</td>
<td>Use for multiple records (for example, a group of prospects).</td>
</tr>
<tr>
<td>Use for one-time manual activities.</td>
<td>Use for one-time manual or automated activities.</td>
</tr>
<tr>
<td>Manually create the activity.</td>
<td>Can use lists of records, saved views, Advanced Find, or marketing lists to create one activity and apply it to multiple records at one time.</td>
</tr>
<tr>
<td>Manually attach the activity to a record.</td>
<td>Recruiter automatically attaches the activity to the associated records.</td>
</tr>
<tr>
<td>Typically, recruiter assigns an activity to self, although ad hoc activities can also be assigned to another user or team.</td>
<td>Administrator or recruiter can assign an activity to another user or team.</td>
</tr>
<tr>
<td>Is not used in a campaign, and therefore cannot be tracked as part of a campaign.</td>
<td>Is not used in a formal communications campaign, but contains the same tracking mechanisms as campaigns.</td>
</tr>
</tbody>
</table>
Create Ad Hoc Activities

Ad hoc activities allow you to set reminders or create tasks and activities that can enable you to interact with prospective students on an as-needed basis. You can create ad hoc activities at any time. Ad hoc activities are not used in campaigns and, therefore, cannot be tracked as part of campaigns. For a comparison of ad hoc activities and quick campaigns, see “Ad Hoc Activities or Quick Campaigns” on page 182.

You can view tasks and activities that are assigned to you along with their due dates from Workplace > My Activities. You can also view activities assigned to a specific prospect from the prospect record, even if that prospect is not assigned to you.

The main process for creating ad hoc activities in Recruiter is as follows.

Step 1. Create an ad hoc activity.

Ad hoc activities can include tasks, appointments, phone calls, e-mails, letters, or faxes. You can create ad hoc activities from the Workplace > Activities area of Recruiter. You can also create an ad hoc activity for a specific record (for example, a prospect) by adding it within the record. To do this, locate and open the record you want to add the activity to, click the Add tab, and then select the appropriate activity type on the ribbon.

Key points about creating ad hoc activities include the following:

- When you create an activity, you can use the Regarding field to link the activity to any entity that supports activities. This allows you to open another record from the activity record.
- If you are not completing the activity immediately, you can set a due date as a reminder to do something at a later date. You can also set the activity code, duration, priority, category, and sub-category fields on all activities as needed.
- If you create a phone call activity, you must set whether the call is incoming or outgoing, which changes the order of the sender and recipient.
- If you create an e-mail activity, you must insert an e-mail template. After the e-mail is sent, it is listed in the Closed Activities area of the recipient’s record.
- If you create a letter activity, either sent or received, you can save the activity and then attach a file, such as a scanned letter in PDF format.
- There is no duration or due date on incoming phone calls or letters.
Step 2. Mark the activity as complete.

When you have completed the campaign activity, you must mark it complete so that it does not become past due. To do this, you can select one or more activity records from Workplace > Activities area, or you can open a specific activity record, and click Mark Complete on the ribbon.
Create Quick Campaigns

Quick campaigns are designed for smaller groups of individuals or less formal communications. You can create a quick campaign at any time. Quick campaigns are not part of a formal communications campaign, but they contain the same tracking mechanisms as campaigns. For a comparison of ad hoc activities and quick campaigns, see “Ad Hoc Activities or Quick Campaigns” on page 182.

You can view quick campaigns in the Campaigns > Quick Campaigns area. You can view tasks and activities that are assigned to you, along with their due dates, from Workplace > My Activities. You can also view activities assigned to a specific prospect from the prospect record, even if that prospect is not assigned to you.

The main process for creating quick campaigns in Recruiter is as follows.

Step 1. Create the quick campaign.

You can start the Quick Campaign Wizard in three ways:

- Select the prospective students directly. For example, in the Navigation Pane, go to Recruiting > Prospects and select prospects from the list page (or select a view first), click the Add tab, and click Quick Campaign on the ribbon. Select the appropriate option to open the wizard.

- Do a search using Advanced Find and create a quick campaign from the resulting list of records. For example, in the Navigation Pane, go to Recruiting > Prospects, and click Advanced Find on the ribbon. Select the criteria for your query, and click Results. Select the records, and click Quick Campaign on the ribbon. Select the appropriate option to open the wizard.

- Create a quick campaign from a marketing list that has members. Go to Campaigns > Marketing Lists. Select the marketing list, and click Create Quick Campaign on the ribbon.

Key points about creating quick campaigns include the following:

- Quick campaigns distribute tasks immediately (unless assigned to a queue) and only one task can be added.

- Not all fields are active.

- Some fields are populated after you complete the wizard and the individual tasks are assigned. For example, Sender, Recipient, Phone Number, Direction, Regarding, and Owner fields are completed based on information from the list or view used for the campaign or other options selected in the wizard.
Step 2. Mark the activities complete.

When a quick campaign activity is created, a main activity is generated in the Campaigns > Quick Campaigns area and individual activities are created and assigned to the appropriate owner.

When the owners have completed an individual activity, they must mark it complete so that it does not become past due. To do this, they can select one or more activity records from the Workplace > Activities area, or open a specific activity record, and click Mark Complete on the ribbon. You can also close individual activities in bulk. For more information, see “Close Activities in Bulk” on page 180.

When all individual activities are complete, you can mark the main activity complete. To do this, open the quick campaign activity, click the Quick Campaign tab, and click Mark Complete on the ribbon.
Create Calendar Campaigns

Calendar campaigns are designed to combine planning tasks, budget information, calendar dates, multiple campaign activities (appointments, phone calls, e-mails, letters, and faxes), and campaign reviews. For a comparison of campaigns and workflows, see “Campaigns or Workflows” on page 173.

The main process for using calendar campaigns in Recruiter is as follows.

Step 1. To automatically distribute campaign activities in a calendar campaign, create activity templates.

Activity templates contain all of the information that is needed to generate the individual activities that are created during distribution. An activity template can contain reminder notes, talking points, e-mail text, etc.

You can create the activity templates before you start your campaign and add them to your campaign activities when you are ready to begin distributing them, or you can create them from within the campaign activity. After you have saved a campaign activity that is set to be distributed automatically with a scheduled start date and an activity template, the campaign activity will be automatically distributed when the “Distribute Campaign Activity” workflow runs on or after the scheduled start date.

You can create activity templates from the Campaigns > Activity Templates area. You can also create activity templates from within a campaign activity by using Lookup on the Template field, and then clicking New.

For more information, see “Automatic Distribution of Campaign Activities” on page 178 and the Create an Activity Template article in the Recruiter help.

Step 2. Create the campaign.

You can create a campaign from the Campaigns > Manage Campaigns area.

Key points about creating campaigns include the following:

- You can copy existing campaigns to use as a basis for a new campaign.
- The Name, Campaign Code, and Campaign Color fields are required. All campaign activities for the campaign will be displayed in the selected color on the Campaign Calendar.
- You can optionally associate a campaign with a specific recruiting cycle, campaign goals, or schedule. By including details such as these, you can
run campaign reports that compare your goals during a specific cycle with the actual results.

For more information, see the Create a Recruiting Campaign article in the Recruiter help. You can also view the Planning Campaigns article in the Microsoft Dynamics CRM help.

**Step 3.** Create campaign activities.

Campaign activities are the building blocks of communications campaigns. When used in a calendar campaign, you can include the planning tasks that you want to perform before you launch the campaign and the campaign activities that you want to manage as part of the campaign.

Campaign activities contain channel and scheduling information, budgets and expenses, and configuration options for catch-up processing, drip campaigns, or automatic distribution. Campaign activity channels can include appointments, phone calls, e-mails, letters, faxes, or other (used for ExactTarget e-mails). You can also select mail merge activities for e-mails, letters, or faxes.

You can create campaign activities from within a campaign. Open the campaign to which you want to add activities. In the Navigation Pane, click Campaign Activities. On the ribbon, click Add New Campaign Activity and select the appropriate activity type.

Key points about creating campaign activities include the following:

- For all activities, the Parent Campaign, Subject, and Owner fields are required.
- You must select the channel to be able to specify the automatic distribution details.
- If you are not using activity templates (that is, you are not automatically distributing your campaign activities), then your campaign activities can contain reminder notes, talking points, e-mail text, etc.
- To track data or run reports, you must specify additional tracking information, such as scheduled start and end dates, budget, and priority.
- You can set up catch-up processing for all activities except drip activities. See “Catch-Up Processing” on page 176 for more information.
- You can set drip campaign activity settings to use the activity in a drip campaign. Drip activities can be any type of campaign activity, but they must be tied to an initiating activity to be included in a drip campaign. See “Drip Campaigns” on page 177 for more information.
- You can set automatic distribution settings that include an activity template. See Step 1.
After you have saved a campaign activity that is set to be distributed automatically with a scheduled start date and an activity template, the campaign activity will be automatically distributed on the scheduled start date. If you have not specified these settings, you must manually distribute the activity on the scheduled start date.

When a campaign activity is created, a main activity is generated within the **Campaigns > Campaign Activities** area.

For more information, see the *Add a Campaign Activity to a Campaign* article in the Recruiter help.

### Step 4. Create marketing lists.

A marketing list is a group of individuals who are included in a campaign. The following two types of marketing lists can be used in a campaign:

- **Static.** Static marketing lists add individuals at the time the list is created. You can find members in the system or create a list based on location.

- **Dynamic.** Dynamic marketing lists add or remove individuals to the list after it is created based on specific criteria. For example, you can add new prospects to a marketing list as they are created in Recruiter.

You can create marketing lists from the **Campaigns > Marketing Lists** area.

Key points about creating marketing lists include the following:

- Name, Member Type, Owner, and Type fields are required. Member type can be Contact (prospect), Lead (suspect), or Account (organization).

- After you have selected a type, you must save the form before you can add marketing list members.

- After the marketing list has been saved, the type cannot be changed.

- For a dynamic marketing list, you can add members from a saved view or based on specific criteria.

- Only static marketing lists support adding members by location. To add members in this way, you must enter the selection criteria and location address, and then click **Search** to return the list of members.

For more information, see the *Create a Marketing List* and *Add Members to a Marketing List by Location* articles in the Recruiter help.

### Step 5. Assign a marketing list to a campaign or campaign activities.

You can assign marketing lists to campaigns or campaign activities from the **Campaigns > Manage Campaigns** area or **Campaigns > Marketing Lists** area.
Managing Communications Options

Key points about assigning marketing lists include the following:

- You can add a marketing list to the campaign level and associate the marketing list to all activities in the campaign.
- You can also assign a different marketing list for each activity in a campaign by opening the campaign activity and associating the marketing list with the campaign activity. To do this, you must first add a marketing list at the campaign level.
- You can choose to add a marketing list to the open undistributed campaign activities in the current campaign.

For more information, see the Assign a Marketing List to a Campaign article in the Recruiter help.

**Step 6.** View the Campaign Calendar.

You can view all campaigns in a color-coded Campaign Calendar for a single-month or multiple-month period. This feature provides an overview of multiple campaigns and which activities are to be performed on a given day. All campaigns appear on the calendar. Each campaign is color-coded to identify which activities belong to which campaign.

You can view the calendar from the **Campaigns > Campaign Calendar** area.

**Step 7.** Execute the campaign and perform activities that are not automatically performed by Recruiter.

You can view all campaign activities from within a campaign. Open the campaign for which you want to view activities. In the Navigation Pane, click **Campaign Activities**.

Key points about executing campaigns include the following:

- A campaign is started when the campaign activities that are added to a campaign are scheduled and saved, and the scheduled start date is reached.
- If you have not specified automatic distribution settings for your campaign activities, you must manually distribute the campaign activities on the scheduled start date. To do this, open the campaign activity and click **Distribute Campaign Activity** on the ribbon.
- When a campaign activity is distributed, individual activities are created for each member of the target marketing lists.
- Certain fields, for example Sender, Recipient, and Direction fields, are automatically populated from the marketing list when a campaign activity is distributed.
- Not all fields are active on a distributed campaign activity.
Step 8. Mark the individual activities complete, and close the main campaign activities.

When the owners have completed an individual activity, they must mark it complete so that it does not become past due. To do this, they can select one or more activity records from the Workplace > Activities area, or open a specific activity record, and click Mark Complete on the ribbon. You can also close individual activities in bulk. For more information, see “Close Activities in Bulk” on page 180.

**Note:** When distributing “E-mail” campaign activities, you can choose to send and automatically close the individual activities. If you have done this, you do not need to mark the individual activities complete.

When all individual activities are complete, you can close the main campaign activity. To do this, open the campaign activity from the Workplace > Activities area, and click Close Campaign Activity on the ribbon.

**Note:** If you have enabled catch-up processing on a campaign activity, do not close the main campaign activity until after the catch-up expiration date; otherwise, the catch-up processing will stop.


You can use the delivered campaign reports to review campaign performance. From the reports, you can rank campaigns by goal, view performance of campaigns, and view the last activities for suspects, prospects, and organizations. For more information, see the Recruiting Campaign Reports article in the Recruiter help.
Create Communications Workflows

Communications workflows can be used to automate certain actions within a communication plan based on specific system triggers. These triggers can include items that are created or completed by a prospect, a recruiter, or the system automatically at a set interval. For a comparison of campaigns and workflows, see “Campaigns or Workflows” on page 173.

When creating communications workflows, you should follow these specific workflow guidelines:

- Communications workflows should be created off of the core Application entity ("datatel_application") rather than a specific application entity ("datatel_applicationtypename" entity). For more information about the Recruiter application entities, see the “Application Entities and Relationships” section of the Recruiter Configuration manual.

- You should not create workflows that are triggered by either the Prospect Status field or the date fields in the Application Status Information section of the Prospect form. These fields are updated any time an application that is related to the prospect is created or an application status changes. Instead, you should use the Application Status field or date fields on the application form (Application entity), because those fields are only updated when there is a change to a specific application status.

The main process for using communications workflows in Recruiter is as follows.

Note: Workflows can be designed to meet the needs of your institution. The following process is only an example of the steps needed to create a communications workflow. It is recommended that you review the “Configuring and Using Workflows” section of the Recruiter Configuration manual for additional details, guidelines, and limitations.

Step 1. Create the workflow and set the workflow properties.

Workflows contain all of the properties and logic necessary to automate specific business processes, tasks, or sets of actions to be performed on records. Properties are basic details, such as the name, primary entity that the workflow acts on, when the workflow should be available to run, and when the workflow should start. Logic consists of all of the conditions, actions, and other logical elements that define when and how a particular workflow takes action on records. You can optionally organize steps into stages.

You can create a workflow from the Settings > Processes area.
Key points about creating workflows and setting workflow properties include the following:

- You can start a workflow by an action triggered by a prospect or a recruiter, or you can run it at timed intervals using the Workflow Scheduler.
- To get started, you must enter a name, select an entity, select the “Workflow” category, and select a new blank process (unless you have already created a workflow template for your communications workflow).
- You can designate how you want the workflow to be available to run. Each workflow is set to run automatically by default. If you also want to be able to run the workflow on demand or as a child process in another workflow, you must select those options when you create the workflow. If you want to run a workflow using the Workflow Scheduler, you must allow the workflow to be available to run on demand.
- When a workflow runs automatically, it is run from the context of the owner rather than the user who triggered it. To assign a new owner, click the Administration tab and select the owner.
- The default scope is set to the user. If you want the workflow to be available to be run at a business unit or organization level, you must select the appropriate option. For more information, see “Access Levels” on page 73.
- You can select when the workflow should start (for example, when a record is created, or when a specific field changes).
- When you are finished creating the workflow properties, you can save the workflow and keep it open to add the workflow logic.

For more information, see the “Creating Workflows” section of the Recruiter Configuration manual. You can also view the Creating and Using Workflows article in the Microsoft Dynamics CRM help.

**Step 2. Create conditions.**

You can create the following main types of conditions:

- **Check condition.** This type of condition is a logical “if-then” statement that defines a specific situation and any actions that should be taken if that situation occurs.

  To add a check condition, make sure your cursor is in the correct place within the workflow, and then click **Add Step > Check Condition**.

- **Wait condition.** This type of condition enables a workflow to pause itself until the criteria defined by the condition is met. The workflow starts again automatically after the criteria in the wait condition is met.

  To add a wait condition, make sure your cursor is in the correct place within the workflow, and then click **Add Step > Wait Condition**.
Managing Communications Options

Key points about creating check or wait conditions include the following:

- You can use check conditions at the beginning of a workflow to make sure that communications go to the correct audience by configuring the condition to look for a specific group of individuals.
- When creating a check condition, you must select the field on which to search and identify the appropriate criteria on which to match.
- You can use wait conditions to delay communications for a specific system trigger that you want to occur after the first step, but not immediately after.
- When adding wait conditions, you can define criteria based on changes to the target record (for example, “wait until a field equals a specific value”), a specific time interval that can be relative to a field on the record (for example, “wait until 2 days after the created date”), or an absolute rule (for example, “wait 2 days”).
- When adding wait conditions, you can use the Form Assistant to create a dynamic value (for example, months, days, hours, or minutes) as needed. When creating a dynamic value, the “Before” and “After” options allow you to reference a time period before or after a specific date or date field, and the “Duration” option allows you to specify a time period to wait.
- It is important to make sure that your conditions are in the correct place (hierarchy) within the workflow. If a step is contingent upon another condition, you must add it indented under that condition.
- After you have set the properties for a condition, save and close the condition to return to the workflow.

Step 3. Create records.

You can create records when you want to add an ExactTarget e-mail or an activity to a workflow. To create a record, make sure your cursor is in the correct place within the workflow, and then click Add Step > Create Record. You can create records when you want to add an ExactTarget e-mail or an activity to a workflow. To create a record, make sure your cursor is in the correct place within the workflow, and then click Add Step > Create Record. You can create records when you want to add an ExactTarget e-mail or an activity to a workflow. To create a record, make sure your cursor is in the correct place within the workflow, and then click Add Step > Create Record.

Key points about adding ExactTarget e-mails to workflows:

- You can add one or more ExactTarget e-mails to a single workflow.
- You must create your ExactTarget e-mails before creating the workflow.
- Also, before creating the workflow, you must create an ExactTarget Marketing Automation for each ExactTarget e-mail to link the field mapping with the e-mail. For more information, see the “Create ExactTarget Marketing Automations” section of the Recruiter Configuration manual.
- It is important to make sure that you create records in the correct place (hierarchy) within the workflow. If a step is contingent upon another condition, you must add it indented under that condition.
- When creating a record, in the Create field, select ExactTarget Send Recipient.
When you set the properties, you must specify the following fields at a minimum:

- **Name.** Name of the ExactTarget Send Recipient record.
- **Type.** Type of record. You can send e-mails to individuals or marketing lists.
- **Individual** or **Marketing List.** You must specify either an individual or a marketing list depending on the type you selected. You can use the Form Assistant to set a dynamic field for an individual. For example, “{Contact(Contact)}”.
- **From.** Indicates who the e-mail is from. You can use the Form Assistant to set a dynamic field. For example, “{Owner(Contact)}”.
- **ExactTarget Send.** Identifies which ExactTarget e-mail to send.

After you have set the properties for the ExactTarget e-mail, save and close the record to return to the workflow.

Key points about adding activities to a workflow:

- You can add one or more activities to a single workflow.
- It is important to make sure that you create records in the correct place (hierarchy) within the workflow. If a step is contingent upon another condition, you must add it indented under that condition.
- When creating a record, in the Create field, select the type of record that you want to create. For example, Phone Call, E-mail, etc.
- Creating an e-mail record opens an e-mail activity. To send an e-mail, you must select Add Step > Send E-mail. This option allows you to use an e-mail template or create an e-mail from within the workflow.
- Setting properties for activities in a workflow is similar to creating ad hoc or campaign activities. The minimum required fields are dependent on the type of record that you are creating. You can use the Form Assistant with certain fields to make them dynamic. Examples of such fields include the following:
  - Sender: {Owner(Contact)}
  - Recipient: {Contact(Contact)}
  - Phone Number: {Address 1 - Home Phone(Contact)}

After you have set the properties for an activity, save and close the record to return to the workflow.
Step 4. Save and activate the workflow.

Workflows are automatically created with a status of “Draft”. You must first save a workflow and then publish it to change its status to “Activated” before the workflow can send out your communications and activities. If you want to edit an activated workflow, you must first unpublish it so that its status changes to “Deactivated”. You must also publish a workflow before you can schedule it using the Workflow Scheduler.

For more information, see the “Publish Workflows” section of the Recruiter Configuration manual.

Step 5. Use this workflow and other delivered workflows.

Workflows can run automatically or on demand. Each workflow is set to run automatically by default. For a workflow to also be run on demand or as a child process in another workflow, those options must have been selected when the workflow was created. If a workflow is set to run on demand, you can schedule it using the Workflow Scheduler.

On-demand delivered workflows are also available from the Run Workflow option on the ribbon of the associated area for the target entity of the workflow. For example, the “Prospect Territory Reassignment” workflow is available from the prospects list page, whereas the “Organization Territory Reassignment” workflow is available from the organizations list page.

For more information about delivered workflows, creating workflows, or scheduling workflows, see the “Configuring and Using Workflows” section of the Recruiter Configuration manual.
Use ExactTarget E-mails in Recruiter

The main process for using ExactTarget e-mails in Recruiter is as follows.

**Step 1.** Configure ExactTarget field mapping sets.

You must create field mapping sets in Recruiter that connect the ExactTarget personalization fields with the corresponding fields in Recruiter. Each time you send an ExactTarget e-mail from Recruiter, you can identify the field mapping set that will be used. You must create at least one default field mapping set. The same field mapping set can be used for multiple ExactTarget e-mails. You should only need to create a few field mapping sets when you begin to use ExactTarget.

For more information, see the “Configuring ExactTarget” section of the Recruiter Configuration manual.

**Step 2.** Create e-mails in ExactTarget.

To send ExactTarget e-mails from Recruiter, you must create the e-mails in the ExactTarget application. ExactTarget e-mails can include graphics, personalization fields, links to social media applications like Twitter and Facebook, white-listing capabilities, and tracking features. The default template has been pre-formatted and tested to ensure that it will not be stopped by spam filters and that images are displayed correctly. Ellucian provides each institution with one default HTML template. You can use the default template or your institution’s to create ExactTarget e-mails. Your institution can create additional templates and e-mails within the ExactTarget application as needed.

For more information, see the documentation provided by ExactTarget.

**Step 3.** Send ExactTarget e-mails from Recruiter.

You can send an ExactTarget e-mail from a calendar campaign or a workflow. You can also manually send an ExactTarget e-mail from a specific record (for example, prospect, related contact, suspect, or organization) or a marketing list using the Send ExactTarget Email option on the ribbon.

For more information, see the “Recruiting Campaigns > Recruiting Campaigns” section of the Recruiter help and the “Configuring ExactTarget” section of the Recruiter Configuration manual.
Step 4. Review results of ExactTarget e-mails in Recruiter.

ExactTarget provides analytics so that you can see specific results about your communications e-mails and evaluate their effectiveness. These statistics include high-level details for each ExactTarget send, such as the e-mail delivery rate, open rate, click through rate, unsubscription rate, and bounce rate. You can also view additional details, such as how many recipients clicked on the link in the e-mail, how many were unique clicks compared to total clicks, how many people unsubscribed based on the e-mail, and specific reasons for the e-mail bounces.

Additionally, you can view how a specific recipient responded to an e-mail by viewing the ExactTarget responses. You can view delivery statistics, click statistics, and events from the ExactTarget response record. Also, when viewing a prospect’s profile, you can see the recent communications activities, including ExactTarget responses that were received for the prospect.

To access this information, in the Navigation Pane, click ExactTarget > ExactTarget Sends or ExactTarget Responses. To view a prospect’s profile, in the Navigation Pane, click Recruiting > Prospects. Open the prospect record and view the recent communications within the profile.

Note: It is recommended that you clean up ExactTarget data and set your ExactTarget tracking options to ensure that you are not maintaining large amounts of outdated or unnecessary data. For more information, see the “ExactTarget Tracking Settings and Guidelines” section of the Recruiter Configuration manual.
Use Mail Merge in Recruiter

With mail merge, you can use Microsoft Office Word and Word templates to create letters, faxes, envelopes, and e-mail messages.

You must have Microsoft Dynamics CRM for Outlook installed to use the mail merge options in campaigns, which are identified by the “via Mail Merge” channel label. If you use mail merge options in campaigns, you must create and distribute the campaign activities using the Outlook connector. You also cannot automatically distribute mail merge campaign activities. Instead, you will have to manually distribute the campaign activities on the days that they should be distributed.

If you are not using CRM for Outlook and you want to use mail merge for letters or faxes in a campaign, you can also do this directly in the CRM Web application. In this case, you would use the “Letter” or “Fax” channel in a campaign activity, although you cannot connect the mail merge item to the campaign activity.

You might also choose to create mail merge documents outside of campaigns if you are going to create a communications workflow that requires a mail merge document, such as a letter, to be created based on a system trigger. You can use either CRM for Outlook or the CRM Web application to create mail merge documents in this way.

Note: In most cases, it is recommended that you use e-mail templates (or e-mails) in Recruiter instead of using mail merge to create e-mail messages; however, you can use mail merge to create letters, faxes, or envelopes. You can create mail merge for letters, faxes, or envelopes using either CRM for Outlook or the CRM Web application.

CRM for Outlook Mail Merge Process (in Campaigns)

The main process for using mail merge in campaigns if you are using CRM for Outlook is as follows.

Step 1. Optionally, create mail merge templates.

Mail merge templates allow you create a framework for mail merge documents. To create mail merge templates, in the Navigation Pane, click Settings > Templates, and then click Mail Merge Templates.
Managing Communications Options

For more information, see the “Create Mail Merge Templates” section of the *Recruiter Configuration* manual.

**Step 2.** Create a mail merge campaign activity, identified by the “via Mail Merge” channel label.

To create a campaign activity, open the campaign to which you want to add the activity. In the Navigation Pane, click *Campaign Activities*. On the ribbon, click *Add New Campaign Activity* and select the appropriate activity type.

For more information, see “Create Calendar Campaigns” on page 187.

**Step 3.** In CRM for Outlook, distribute the campaign activity and perform the mail merge.

After you perform the mail merge, you can optionally create individual activities for each mail merge item. You can also choose to have the individual activities closed immediately after they are completed. If you do not select this option, you will have to close the individual activities later. (See **Step 4**.)

For more information, see the “Distribute Mail Merge Campaign Activities in CRM for Outlook” section of the *Recruiter Configuration* manual.

**Step 4.** Mark the individual activities complete, and close the main campaign activity.

When the owners have completed an individual activity, they must mark it complete so that it does not become past due. To do this, they can select one or more activity records from the *Workplace > Activities* area, or open a specific activity record, and click *Mark Complete* on the ribbon. You can also close individual activities in bulk. For more information, see “Close Activities in Bulk” on page 180.

When all individual activities are complete, you can close the main campaign activity. To do this, open the campaign activity from the *Workplace > Activities* area, and click *Close Campaign Activity* on the ribbon.
CRM Web Application Mail Merge Process (in Campaigns)

The main process for using mail merge in campaigns if you are using the CRM Web application is as follows.

Step 1. Optionally, create mail merge templates.

Mail merge templates allow you create a framework for mail merge documents. To create mail merge templates, in the Navigation Pane, click Settings > Templates, and then click Mail Merge Templates.

For more information, see the “Create Mail Merge Templates” section of the Recruiter Configuration manual.

Step 2. Create a campaign activity with the “Letter” or “Fax” channel.

To create a campaign activity, open the campaign to which you want to add the activity. In the Navigation Pane, click Campaign Activities. On the ribbon, click Add New Campaign Activity and select the appropriate activity type.

For more information, see “Create Calendar Campaigns” on page 187.

Note: You can only use the “via Mail Merge” channels if you are using Microsoft Dynamics CRM for Outlook.

Step 3. Distribute the campaign activity, either manually or automatically.

If you have not specified automatic distribution settings for your campaign activities, you must manually distribute the campaign activities on the scheduled start date. To do this, open the campaign activity and click Distribute Campaign Activity on the ribbon.

For more information about automatic distribution, see “Automatic Distribution of Campaign Activities” on page 178.

Step 4. Use the Advanced Find feature to perform the mail merge.

Note: Using this option, you cannot create individual activities for each mail merge item.
Managing Communications Options

For more information, see the “Create Mail Merge Documents Using Advanced Find” section of the *Recruiter Configuration* manual.

**Step 5.** After you have performed the mail merge, mark the individual activities complete, and close the main campaign activity.

When the owners have completed an individual activity, they must mark it complete so that it does not become past due. To do this, they can select one or more activity records from the **Workplace > Activities** area, or open a specific activity record, and click **Mark Complete** on the ribbon. You can also close individual activities in bulk. For more information, see “**Close Activities in Bulk**” on page 180.

When all individual activities are complete, you can close the main campaign activity. To do this, open the campaign activity from the **Workplace > Activities** area, and click **Close Campaign Activity** on the ribbon.

---

**Mail Merge Process (in Communications Workflows)**

The main process for using mail merge in communications workflows is as follows. To do this, you can use either CRM for Outlook or the CRM Web application.

**Step 1.** Optionally, create mail merge templates.

Mail merge templates allow you create a framework for mail merge documents. To create mail merge templates, in the Navigation Pane, click **Settings > Templates**, and then click **Mail Merge Templates**.

For more information, see the “Create Mail Merge Templates” section of the *Recruiter Configuration* manual.

**Step 2.** Create a communications workflow that creates a campaign activity with the “Letter” or “Fax” channel based on a system trigger.

For more information, see “Create Communications Workflows” on page 192.

**Note:** You can only use the “via Mail Merge” channels if you are using Microsoft Dynamics CRM for Outlook.
**Step 3.** Use the Advanced Find feature to perform the mail merge.

For more information, see the “Create Mail Merge Documents Using Advanced Find” section of the *Recruiter Configuration* manual.
Managing Duplicate Data

In This Chapter

This chapter includes information about understanding the duplicate detection feature and managing duplicate data in the Recruiter interface.

Table 20 lists the topics covered in this chapter.

Table 20: Topics in This Chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate Detection Overview</td>
<td>206</td>
</tr>
<tr>
<td>Detecting Duplicate Data</td>
<td>211</td>
</tr>
<tr>
<td>Resolving Duplicate Data</td>
<td>215</td>
</tr>
</tbody>
</table>
Duplicate Detection Overview

Microsoft Dynamics CRM provides native functionality for detecting duplicate records. To determine whether a record is a potential duplicate, CRM uses duplicate detection rules, which specify criteria for identifying a record as a duplicate.

The duplicate detection feature does the following:
- Automatically detects duplicate information based on duplicate detection rules.
- Warns users when they are creating or updating a possible duplicate record.
- Allows users to run duplicate detection jobs manually or on a schedule to identify duplicates that already exist.
- Allow users to determine which record to keep when duplicate records are identified. Users can merge duplicate records and decide which values to use, or they can deactivate or delete one of the duplicate records.

You can also choose to do the following:
- Ignore duplicates when importing records from a CSV file.
- Detect duplicates between two entities (for example, suspects and prospects).
- Use delivered rules or create your own rules as to what makes a duplicate for many of the entities.

Duplicate Detection Options

Duplicate detection can take place only if duplicate detection settings are enabled and if at least one duplicate detection rule is published for a record type. The System Administrator or System Customizer security roles make duplicate detection available to other users, and define and publish duplicate detection rules for your Recruiter organization. For more information, see “Security Roles and User Accounts” on page 69.
You can manage the following duplicate detection options in the Settings > Data Management area of Recruiter:

- **Duplicate Detection Rules.** This option allows you to view, create, modify, and publish duplicate detection rules. The delivered duplicate detection rules will be displayed in this area.
- **Duplicate Detection Jobs.** This option allows you to create and monitor duplicate detection jobs.
- **Duplicate Detection Settings.** This option allows you to enable duplicate detection when a record is created or updated, when Microsoft Dynamics CRM for Outlook goes from offline to online, and when importing data using the Import Data Wizard. These settings are enabled by default and it is recommended that you do not disable them.

**Note:** At times, you might want to disable duplicate detection rules, for example for custom data imports so that no errors are delivered. You can do this and then run a duplicate detection job manually upon completion of the import. However, it is recommended that you do not disable this option and instead that you configure the import to allow duplicates. For more information, see the “Configuring Recruiter Imports” section of the Recruiter Configuration manual.

### Delivered Recruiter Duplicate Detection Rules

By default, Microsoft Dynamics CRM delivers simple duplicate detection rules for the Account, Contact, and Lead entities. These default rules look for records with the same e-mail address. Recruiter delivers additional duplicate detection rules to prevent duplicate records for certain Recruiter entities and features. For example, Recruiter delivers rules to prevent duplicate records for installed values, such as states, academic programs, and academic terms, and to extend rules to better manage records for existing entities, such as the Contact entity (prospects).

**Note:** If a delivered duplicate detection rule for the Contact, Lead, or Account entities does not meet your institution's needs, you can unpublish it, create a new rule, and then publish the new rule. However, you should not unpublish or delete any of the other delivered duplicate detection rules for installed values. You should also not modify the delivered rules because they are overwritten during upgrades and your customizations will be lost.
Preventing Duplicate Data

You can prevent the creation of duplicate data in the following ways:

- **Use Smart Links and Quick Forms.** You can prevent duplicates by encouraging prospective students to visit your external website and complete information in existing records. For more information, see “Smart Links and Quick Forms” on page 158.

- **Use the Create Account Verification Process.** You can detect and merge two unambiguous duplicates when a prospect creates an account on your external website. For more information, see “Create Account Verification Process” on page 159.

For more information about preventing duplicate records, see the *Avoiding Duplicate Records* article in the Microsoft Dynamics CRM help.

Recruiter Functions That Require You to Resolve Duplicate Data

By design, the following Recruiter functions require you to resolve duplicate records.

- **Importing suspects.** When importing suspects into Recruiter, the imported suspects are checked against the other suspect and prospect records in Recruiter to determine whether there are any duplicate records. The duplicate detection rules for the Lead and Contact entities are used to determine whether duplicate records exist.

  If a single duplicate record is found, new data from the staging record is added to the existing record. If multiple duplicate suspect records or multiple duplicate prospect records are found, an open activity is created on the staging record indicating that no records of that type were created.

  It is important that you resolve all existing duplicate suspect and prospect records before you begin importing suspects into Recruiter. You must also enable the `DuplicateDetectionDuringSuspectImportEnabled` configuration setting to ensure that you do not create additional duplicate records during the import.

  For more information, see the *Suspect Import Overview* article in the Recruiter help.
Importing prospects. When importing prospects into Recruiter, the imported prospects are checked against the other suspect and prospect records in Recruiter to determine whether there are any duplicate records. The duplicate detection rules for the Lead and Contact entities are used to determine whether duplicate records exist.

If a single duplicate record is found, new data from the staging record is added to the existing record. If multiple duplicate suspect records or multiple duplicate prospect records are found, an open activity is created on the staging record indicating that no records of that type were created.

It is important that you resolve all existing duplicate suspect and prospect records before you begin importing prospects into Recruiter. You should also verify that the `DuplicateDetectionDuringProspectImportEnabled` configuration setting is enabled so that you do not create additional duplicate records during the import. This setting is delivered enabled by default.

For more information, see the `Prospect Import Overview` article in the Recruiter help.

Associating a test score with a prospect. When a test score record is created, a process runs that matches the test score record to the associated suspect or prospect record. This process uses duplicate detection rules to match the student information on a suspect or prospect record with the test score’s related staging record, where all of the student information is stored.

If Recruiter finds a suspect or prospect match, the test score is associated with the corresponding suspect or prospect record. If Recruiter finds possible duplicates, the records are listed in the Prospect Matcher. Possible duplicates can include multiple suspect records, multiple prospect records, or both a suspect and a prospect record for the same individual.

You can use the Prospect Matcher to associate unmatched test scores with a suspect or prospect record. If the correct record is not detected for a test score, you can use the Prospect Matcher to create a new prospect record. If you associate the test score with a suspect record, the suspect is automatically converted to a prospect. The Prospect Matcher can also be used to correct errors in data, which prevent a prospect record from being created.

For more information, see the `Test Score Import Overview` and `Manage Unassigned Test Scores` articles in the Recruiter help.

Cleaning up duplicate prospect child records. In some cases, Recruiter might contain duplicate records for prospect child data (related entities), such as multiple High School Academic History records for the same school or identical Extracurricular Activities. Additionally, duplicate records for a prospect might exist if a prospect record already had related entity records before an application was submitted.
New prospect child records will be merged automatically if the associated `AutoMergeDuplicateRecordsPluginEnabled` configuration setting is enabled. However, you must clean up any existing duplicate records by running the “Clean Up Prospect Child Data” workflow on those records. For more information, see the *Clean Up Duplicate Prospect Child Records* article in the Recruiter help.

**Note:** When importing applications into Recruiter, an application is linked to the first prospect record that it matches. You will not be alerted if the application matches more than one prospect record.
Detecting Duplicate Data

In many cases, the delivered duplicate detection rules are sufficient for detecting duplicate data for common entities, such as Account (organization), Contact (prospect), or Lead (suspect). However, there may be instances where you want to change duplicate detection rule criteria or create rules for additional entities. You can also create duplicate detection jobs to detect duplicate data for a specific entity using the duplicate detection rules that are defined for that entity.

Duplicate Detection Rules

You can access duplicate detection rules from Settings > Data Management > Duplicate Detection Rules. From this area, you can view the delivered duplicate detection rules, and create, modify, and publish rules as needed.

If a delivered duplicate detection rule for the Contact, Lead, or Account entities does not meet your institution’s needs, you can unpublish it, create a new rule, and then publish the new rule. However, you should not unpublish or delete any of the other delivered duplicate detection rules for installed values. You should also not modify the delivered rules because they are overwritten during upgrades and your customizations will be lost.

You must publish rules for them to be active. Each entity can have only five active duplicate detection rules at a time. If creating a new duplicate detection rule will exceed that allotment, you can unpublish an existing rule.

Note: Changes to an entity will automatically unpublish the duplication detection rules associated with the entity. If a record is added or modified before the rules are republished, errors will occur.

From this area, you can select an entity in the Entity Type field or sort on the Base Record Type column to view the rules that have been delivered for a specific entity. You can double-click a duplicate detection rule to view the rule criteria. Additionally, you can select rules and click Unpublish or Publish to deactivate or activate them as needed.
When creating a duplicate detection rule, you can select the following options as needed:

- Select **Case-sensitive** if you want the rule to match on case.
- Select **Exclude inactive matching records** if you do not want the rule to detect records that have already been deactivated.
- Select the appropriate **Ignore Blank Values** check box if you want to ignore blank (null) values for a particular field. In most cases, you should select this option to ensure an unambiguous match for field values.

**Note:** Recruiter is delivered with rules that match last name and e-mail address for the Contact and Lead entities. The e-mail address is required on all online forms and will be collected at most events or high school recruitment visits. According to these rules, if siblings share a last name and email address, their records will be tagged as duplicates. To prevent this, you can unpublish the appropriate duplicate detection rules and create new rules that add the first name to the list of fields that should be matched. You can also set up the rules to match on partial characters instead of exact matches.

**Note:** You should not create a duplicate detection rule based on a prospective student’s full name. This is a Recruiter field that is populated after the suspect or prospect record is created.

For more information, see the *Define Rules for Duplicate Detection* article in the Recruiter help and the *Work with Duplicate-detection Rules* article in the Microsoft Dynamics CRM help.

**Duplicate Detection Jobs**

It is possible to inadvertently create duplicate records. Therefore, it is recommended that, where necessary, you manually run a duplicate detection job or schedule duplicate detection jobs to detect duplicate records. A duplicate detection job runs in the background while you do other things in Microsoft Dynamics CRM. You can request an e-mail notification from CRM upon the completion of a duplicate detection job.

You can manually check for duplicates from any list of records, including results of an Advanced Find search, by first selecting the records and then selecting the appropriate **Detect Duplicates** option on the ribbon. Options include searching on selected records or all records in the list. The **Check for Duplicates** dialog box is displayed (*Figure 49*), which prompts you to run the duplicate detection job immediately.
You can also create a duplicate detection job using the Duplicate Detection Wizard (Figure 50). You can run a duplicate detection job immediately or you can schedule it to run automatically at a time of your choosing. You can access the Duplicate Detection Wizard from the Tools menu, Workplace, or Settings area:

- Select the File menu, select Tools, and then click Duplicate Detection.
- In the Navigation Pane, click Workplace, and then click Duplicate Detection. Click New.
- In the Navigation Pane, click Settings, click Data Management, and then click Duplicate Detection Jobs. Click New.
You can create duplicate detection jobs for only those record types that have published duplicate detection rules. When creating a duplicate detection job, you can select the entity, additional record criteria, and options (name of job, start date, start time, automation options, alerts). An e-mail can be sent each time the duplicate detection job is run and duplicates are ready to be resolved.

For more information, see the Work with Duplicate-detection Jobs article in the Microsoft Dynamics CRM help.
Resolving Duplicate Data

You can resolve duplicate data by editing, deleting, merging, or deactivating records as needed.

If you attempt to create a record that already exists, the Duplicates Detected dialog box is displayed (Figure 51) that shows the potential duplicate records. You can select records in the bottom list and edit, deactivate, or delete them as needed to resolve the duplicate issues. You can also cancel or continue to create the record by saving it. For more information, see the Duplicates Detected Form article in the Microsoft Dynamics CRM help.

Figure 51: Duplicates Detected Dialog Box
You can also view duplicates that are detected within a duplicate detection job (Figure 52). You can access completed duplicate detection jobs from the Workplace or Settings area:

- In the Navigation Pane, click **Workplace**, and then click **Duplicate Detection**. Open the duplicate detection job. In the Navigation Pane, click **View Duplicates**.
- In the Navigation Pane, click **Settings**, click **Data Management**, and then click **Duplicate Detection Jobs**. Open the duplicate detection job. In the Navigation Pane, click **View Duplicates**.

**Figure 52: View Duplicates**

When viewing duplicates, the top list displays all records that have potential duplicates. When you select a record in the top list, the bottom list shows all of the potential duplicates for that record. You can select records in the bottom list and edit, deactivate, or delete them as needed to resolve the duplicate issues. Additionally, you can merge potential duplicates for the Contact, Lead, or Account entities. For more information about merging duplicate records, see “Merging Duplicate Records” on page 217.
After you have made changes to the records, you must run a new duplicate detection job to refresh the list of duplicate records. Until you do this, the following applies:

- After a record has been merged, deactivated, or deleted, the record is still displayed on the top list.
- After a record has been merged or deactivated, the record is still displayed on the bottom list.
- You can use the Modified On column to determine whether a record was modified after the duplicate detection job was run.

For more information, see the Resolve potential duplicate records article in the Microsoft Dynamics CRM help.

### Merging Duplicate Records

When resolving duplicate data, you may need to merge two records. You can do this from a duplicate detection job or from a list of records. You can only merge records for the Contact, Lead, or Account entities.

When selecting records to merge from a duplicate detection job (Figure 52), we recommend that you manually select the master record and the specific fields that you want to merge. To do this, select the records in the bottom list that you want to merge, click **Merge**, and then click **Select Master**.

You can also manually merge records from any list of records, including results of an Advanced Find search, by first selecting the two records that you want to merge and then clicking **Merge** on the ribbon.

Whether you are manually merging records from a duplicate detection job or from a list of records, the **Merge Records** dialog box is displayed (Figure 53) so that you can select which record will be the master record, and which field level data should carry over to the master record.

When manually resolving duplicate records, we recommend the following:

- A record with an ERP ID should always be the master record.
- A record with an External User Authentication ID, but without an ERP ID, should always be the master record.
- When one record contains an ERP ID and the other record contains an External User Authentication ID, the record with the ERP ID should be the
master record but the External User Authentication ID data should be selected and carried over to the master record.

- Select all data in a section, because undesirable results might occur otherwise.

Depending on the record data, you can optionally select the following check box at the bottom of the dialog box: **Select all fields with data. If both records have data in the same field, the master record is selected.** If you select this check box, when you click **OK** to merge records, the master record inherits all of the other record’s child records, and then the other record is deactivated.

**Figure 53: Merge Records Dialog Box**
Managing ERP Integration Options in Recruiter

In This Chapter

This chapter includes information about understanding and managing ERP integration options in the Recruiter interface. The system setup for these options to work correctly is not covered in this section. For more information about provisioning data in Recruiter and setting up your ERP system for integration, see the appropriate manual:

- If you are integrating with Banner by Ellucian, see the *Integrating Recruiter with Banner* manual.
- If you are integrating with Colleague by Ellucian, see the *Integrating Recruiter with Colleague* manual.
- If you are importing data from and exporting data to another ERP system, see the “Data Provisioning and ERP Integration” section of the *Recruiter Installation Procedures* manual.

This chapter does not cover information about importing data from third-party sources, such as suspect lists, prospects, test scores, or applications. For more information, see the “Recruiting Imports” section of the Recruiter help and the “Configuring Recruiter Imports” section of the *Recruiter Configuration* manual.

Table 21 lists the topics covered in this chapter.

Table 21: Topics in This Chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recruiter and Your ERP System</td>
<td>220</td>
</tr>
<tr>
<td>Before You Begin Transferring Data</td>
<td>220</td>
</tr>
<tr>
<td>How Data Gets Into Recruiter</td>
<td>221</td>
</tr>
<tr>
<td>Data Transferred Between Recruiter and Your ERP System</td>
<td>222</td>
</tr>
<tr>
<td>Sending Data from Recruiter to Your ERP System</td>
<td>223</td>
</tr>
</tbody>
</table>
Recruiter and Your ERP System

Recruiter is designed to work with Banner, Colleague or another Enterprise Resource Planning (ERP) system. Data can be imported into Recruiter and exported from Recruiter. The following sections detail what options are available to you in Recruiter.

The options that are available to you are dependent on the ERP system you are using. Recruiter works in an automated way with both Banner and Colleague ERP systems to transfer data between the systems. You can also manually import and export data as needed for Banner, Colleague, and other ERP systems.

Before You Begin Transferring Data

Before you can automatically transfer data between Recruiter and Banner or Colleague, you must do the following:

- Make sure that ERP integration is enabled. For more information, see the “Enabling ERP Integration” section in the Recruiter Installation Procedures manual.
- Enable the appropriate configuration settings in Recruiter. For more information about Recruiter configuration settings, see the “Enabling ERP Export Configuration Settings” section in the Recruiter Installation Procedures manual.
- Set up custom fields for export in Recruiter. For more information about setting up custom fields for export, see the Define Real Time Export Configurations article in the Recruiter help. For information about how to set up the import of these custom fields in your ERP system, see the appropriate manual referenced at the start of this chapter.
- Set up your ERP system to work with Recruiter. For more information about additional required ERP system setup, see the appropriate manual referenced at the start of this chapter.

Note: To automatically transfer data, the connection to Banner or Colleague that was configured in the Recruiter installation must also be working properly. You can use the Recruiter Diagnostics Tool to test this connection. For more information, see the “Recruiter Diagnostics Tool” section of the Recruiter Installation Procedures manual.
How Data Gets Into Recruiter

Data is imported into Recruiter in one of four ways:

1. **Installation.** Certain entities are loaded with specific values during the Recruiter installation. Some of these values can be overwritten with values from your ERP system. Other values, such as those for Country and State entities, cannot be removed or changed after the installation.

2. **Initial Data Provisioning.** Provisioning data expedites the implementation of Recruiter by loading data from other sources into Recruiter. Typically, you will provision data only once. The purpose of this process is to import data that should be managed in Recruiter, such as prospects, or to import values that your ERP system uses so that the values in both systems match and do not cause errors. If you are using Banner or Colleague, you can provision this data in an automated way between the systems. If you are using another ERP system, you can manually provision data in Recruiter using CSV files.

3. **Third-Party Sources Imports.** You can import data from third-party sources, such as suspect lists, prospects, test scores, and applications. For more information, see the “Recruiting Imports” section of the Recruiter help and the “Configuring Recruiter Imports” section of the Recruiter Configuration manual.

4. **Ongoing Data Integration.** Integrating data automatically allows for a bi-directional transfer of real-time data between two systems. This transfer includes sending items such as ERP IDs and application statuses from the ERP system to Recruiter, and sending items such as prospects and applications from Recruiter to the ERP system. This option is available with Banner or Colleague. You can also import and export some data manually between Recruiter and these systems or another ERP system as needed. Recruiter allows you to import data in CSV format and export applications in either CSV or XML format.

**Note:** The Recruiter validation lists, which are populated during the installation, contain many of the record types that match your ERP system. To view the values used by Recruiter, go to **Settings > Validation List Management**, and select the appropriate setting.

**Note:** After you have prepared for and imported data into Recruiter from your ERP system, you can verify the results of your import and resolve errors as needed. For more information, see the “Verifying Results of Import into Recruiter” section of the Recruiter Configuration manual.
Data Transferred Between Recruiter and Your ERP System

Table 22 lists the data that is sent from Banner or Colleague to Recruiter. You can provision data from another ERP system by creating a custom import. You can also create custom imports for ongoing data imports. For more information, see the “Provisioning Data from Your ERP System” section of the Recruiter Installation Procedures manual and the “Configuring Recruiter Imports” section of the Recruiter Configuration manual.

**Table 22: From ERP System to Recruiter**

<table>
<thead>
<tr>
<th>To Recruiter</th>
<th>ERP System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provisioning of Values, Institutions, or Prospects</td>
<td>Banner, Colleague, Other ERP System</td>
</tr>
<tr>
<td>ERP IDs</td>
<td>Banner, Colleague</td>
</tr>
<tr>
<td>Application Statuses</td>
<td>Banner, Colleague</td>
</tr>
<tr>
<td>Communication History</td>
<td>Banner, Colleague</td>
</tr>
<tr>
<td>Financial Aid Prospects</td>
<td>Banner, Colleague</td>
</tr>
<tr>
<td>Financial Aid Awards</td>
<td>Banner, Colleague</td>
</tr>
<tr>
<td>FAFSA Data</td>
<td>Banner, Colleague</td>
</tr>
<tr>
<td>Prospect Statuses (include admit, confirmed, and enrolled statuses)</td>
<td>Banner, Colleague</td>
</tr>
</tbody>
</table>

Table 23 lists the data that is sent from Recruiter to Banner or Colleague. Applications can be manually exported to another ERP system in CSV or XML format.

**Table 23: From Recruiter to ERP System**

<table>
<thead>
<tr>
<th>From Recruiter</th>
<th>ERP System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applications</td>
<td>Banner, Colleague, Other ERP System</td>
</tr>
<tr>
<td>Prospects</td>
<td>Banner, Colleague</td>
</tr>
<tr>
<td>Proposed Admissions Decision</td>
<td>Banner, Colleague</td>
</tr>
<tr>
<td>Activities</td>
<td>Banner, Colleague</td>
</tr>
<tr>
<td>Test Scores</td>
<td>Banner, Colleague</td>
</tr>
<tr>
<td>Transcript Courses</td>
<td>Colleague</td>
</tr>
</tbody>
</table>
Sending Data from Recruiter to Your ERP System

This section contains details about sending data from Recruiter to your ERP system, specifically which actions send data and which data is sent. For details about sending data from your ERP system to Recruiter, see the appropriate manual referenced at the start of this chapter.

For information about the setup required to send data to your ERP system, see “Before You Begin Transferring Data” on page 220.

Actions in Recruiter That Send Data

The following sections identify the actions in Recruiter that send each type of data to your ERP system.

To sync data with your ERP system, you can manually place the ERP ID on the prospect record or send the prospect or application record to your ERP system, which will trigger your ERP system to respond with data referenced in Table 22 on page 222. For example, if communication history information for an existing prospect exists in Colleague, it will be sent to Recruiter. As long as the configuration settings in Recruiter are enabled, the ERP ID also prompts Recruiter to automatically send activities, test scores, and transcript courses. If you’ve already synced data and you add additional activities, test scores, or transcript courses, you will need to select those items and send them manually to your ERP system.
Applications

You can send applications from Recruiter to Banner or Colleague in the following ways:

- From the Applications pane (Applications > Applications), select the applications that you want to send, and click Submit to ERP from the ribbon.

- Open the application record from the Applications pane, and click Submit Application to ERP on the application form.

- Automatically mark applications complete and send them to your ERP system by enabling the following workflows and the application type auto-mark and auto-send options.

  To enable the workflows, go to Settings > Processes, select the workflow, and click Activate.

  - **Auto Mark App Complete.** Two versions of this workflow exist based on the Application and Supplemental Information Submission entities. The purpose of the workflows is to set the correct status on the application so that it can be sent to your ERP system.

  - **Auto Send App to ERP.** The purpose of this workflow is to send the application to your ERP system.

  **Note:** These workflows can be enabled independently of each other; however, the Auto Send App to ERP workflow must be configured to send an application automatically to Banner or Colleague.

To enable the application type auto-mark and auto-send options, go to Applications > Application Types, select an application type, and set the following options to Yes.

- **Auto Mark Complete When Submitted.** Automatically marks an application as complete when it is submitted. This setting corresponds to the Auto Mark App Complete workflow.

- **Auto-Send to the ERP.** Automatically sends applications from Recruiter to your ERP system. This setting corresponds to the Auto Send App to ERP workflow.

  **Note:** The timing of when an application will be automatically send to your ERP system depends on the RequireAppCompleteBefore SendToERP configuration setting. If the configuration setting is True (the default setting), all of the supplemental items must be received or waived before the application can be automatically exported to your ERP system. If the configuration setting is False, the application will be automatically exported to your ERP system as soon as it is submitted by the prospect. The RequireAppCompleteBefore SendToERP configuration setting is a global setting that applies to all application types.
Export applications to CSV or XML format. You must then import the files into your ERP system and manage the imported data.

For more information about exporting applications manually, see the Define Export Configurations and Export Configurations Manually articles in the Recruiter help. For information about importing and managing the files in your ERP system, see the appropriate manual referenced at the start of this chapter or the documentation for your ERP system.

**Note:** After you have defined an export configuration and you have exported applications manually, you can download the export file from the export configuration record. To do this, from the Navigation Pane, click Settings > Settings Home > Export Configurations. Open the export configuration record, click Export Jobs, and then open the export job. The export file is stored in the Notes section of the export job. Click the export file attachment to download it and save it to another location.

**Prospects**

You can send prospects from Recruiter to Banner or Colleague in the following ways:

- From the Prospects pane (Recruiting > Prospects), select the prospects that you want to send, and click Send Prospect to ERP from the ribbon.
- Open the prospect record from the Prospects pane, and click Send to ERP from the ribbon.
- Automatically send prospects to your ERP system by scheduling the “Send Prospect to ERP” workflow to run or by triggering the workflow based on other criteria. For example, you might want to resend prospects to the ERP system if the anticipated entry term or academic program was updated after the application was submitted by the prospect. The workflow can be used to automatically send the prospect with the updated information when the application folder is sent. For more information, see the “Configuring and Using Workflows” section of the Recruiter Configuration manual.
Proposed Admissions Decision

You can send the proposed admissions decision from Recruiter to Banner or Colleague in the following ways:

- From the Application Folders pane (Applications > Application Folders), select the applications that you want to send, and click **Send Application Folder to ERP** from the ribbon.
- Open the application folder record from the Application Folders pane, and click **Send to ERP** from the ribbon.

Activities

You can send activities from Recruiter to Banner or Colleague in the following ways:

- Manually place the ERP ID on the prospect record, which will cause any pending activities to be sent.
- Send prospect or application data to your ERP system. This prompts the ERP ID to be returned from your ERP system, which will cause any pending activities to be sent.
- To send activities for a prospect to your ERP system, open the prospect record from the Prospects pane, and click **Activities** in the Navigation Pane. Select the activity records that you want to export, and then click **Submit to ERP** from the ribbon.

**Note:** You can configure which particular activity types are sent to your ERP system. For more information, see the “Enabling ERP Export Configuration Settings” section in the *Recruiter Installation Procedures* manual.

Test Scores

You can send test scores from Recruiter to Banner or Colleague in the following ways:

- Manually place the ERP ID on the prospect record, which will cause any pending test scores to be sent.
- Send prospect or application data to your ERP system. This prompts the ERP ID to be returned from your ERP system, which will cause any pending test scores to be sent.
- To send official test scores for more than one prospect to your ERP system, from the Prospects pane (Recruiting > Prospects), select the “Prospects
with Test Scores Ready for Export” view, select the prospects in the list, and then click Send Scores to ERP from the ribbon.

- To send official test scores for a specific prospect to your ERP system, open the prospect record from the Prospects pane, and click Official Test Scores in the Navigation Pane. Select the test score records that you want to export, and then click Send Scores to ERP from the ribbon.

**Note:** A pending test score is a record where the ERP Submitted Date is null. Pending test scores are determined by running the “Determine Prospect Pending Scores” workflow.

**Note:** You can configure which particular test types are sent to your ERP system. For more information, see the “Enabling ERP Export Configuration Settings” section in the Recruiter Installation Procedures manual.

### Transcript Courses

You can send transcript courses from Recruiter to Colleague in the following ways:

- Manually place the ERP ID on the prospect record, which will cause any pending transcript courses to be sent.

- Send prospect or application data to your ERP system. This prompts the ERP ID to be returned from your ERP system, which will cause any pending transcript courses to be sent.

- To send transcript courses for more than one prospect to your ERP system, from the Prospects pane (Recruiting > Prospects), select the “Prospects with Transcript Courses Ready for Export” view, select the prospects in the list, and then click Send Transcript Courses to ERP from the ribbon.

- To send transcript courses for a specific prospect to your ERP system, open the prospect record from the Prospects pane (Recruiting > Prospects) and do one of the following:
  - To send specific or all transcript courses, in the Navigation Pane, click Transcript Courses. Select the records that you want to send to the ERP system, and click Send Transcript Courses to ERP from the ribbon.
  - To send transcript courses associated with a specific high school or college, in the Navigation Pane, click either High School Info or College Info. Double-click the academic history record to open it. Then, in the Navigation Pane, click either High School Transcripts or College Transcripts, select the records that you want to send to the ERP system, and click Send Transcript Courses to ERP from the ribbon.
Which Data Is Sent and When

The following sections identify which data is sent from Recruiter to your ERP system and under what circumstances the data is sent.

Applications and Prospects

Recruiter provides the ability to export applications and prospects to Banner or Colleague. Applications and prospects will only be exported automatically if the appropriate ERP configuration settings have been enabled and, for applications, if the application type auto-send option and workflow have been enabled. If you are using another ERP system, you can manually export applications only.

Application and prospect records contain many of the same fields. Details about the prospect and application exports are identified in the following mapping spreadsheets:

- For Banner implementations, view the “Recruiter to Banner Field Mappings” spreadsheet in the Ellucian Support Center Recruiter/Banner Field Mappings content pack.
- For Colleague implementations, view the “Recruiter to Colleague Application and Prospect Data Contract” spreadsheet in the Ellucian Support Center Recruiter/Colleague Field Mappings content pack.

If you are integrating Recruiter with Banner Document Management (BDM), sending applications to Banner also sends the associated supplemental items to BDM. For more information about the BDM export, see the Banner Document Management (BDM) Export Overview Recruiter help article.
Data can be sent initially to your ERP system using one of the two following methods:

1. Send the prospect to your ERP system before sending an application. Most of the fields in the applicable spreadsheet are exported to the ERP system, with the exception of those listed in Step 2. When you send the prospect, the following types of data are sent from the prospect record in Recruiter:
   - Demographic information, such as name, Social Security or Social Insurance number, birth date, and gender.
   - Academic Program
   - Location
   - Anticipated Entry Term
   - Admit Type
   - Source
   - Address information
   - Ethnicity information
   - Parent or Guardian information
   - High School or College Academic History

2. Send the application to your ERP system. All of the fields in the spreadsheet are exported, and all of the fields are also located on the application record in Recruiter. All fields that are sent when exporting the prospect are also sent when exporting the application. Additionally, sending the application exports the following fields that are not exported with the prospect:
   - Custom fields
   - Notes

**Note:** Custom fields for both applications and prospects can be exported to Banner; only custom fields for applications can be exported to Colleague.

**Note:** When an application is sent, there is one exception that will cause certain fields on the prospect record to be sent with the application. If StrikeIron has verified a prospect's address since the application was submitted by the prospect, then sending the application to your ERP system will send the updated address from the prospect record.

An application can only be sent to your ERP system once. If the application data has already been sent to your ERP system, you can re-send the prospect at a later time to update demographic or address information. For more information regarding where data is imported into Banner or Colleague, see the appropriate manual referenced at the start of this chapter.
Proposed Admissions Decision

Recruiter provides the ability to export the proposed admissions decision to Banner or Colleague. The proposed admissions decision will only be exported if the prospect has an ERP ID and the appropriate ERP configuration settings have been enabled. If the application has not already been sent to your ERP system, Recruiter will also send the application to your ERP system when you send the proposed admissions decision.

**Note:** If you are integrating Recruiter with Banner, you must send the application to Banner before entering and sending a proposed admissions decision.

When the proposed admissions decision is exported, the following data is sent to your ERP system:

- Application Status

Details about the proposed admissions decision exports are identified in the following mapping spreadsheets:

- For Banner implementations, view the “Recruiter to Banner Field Mappings” spreadsheet in the Ellucian Support Center Recruiter/Banner Field Mappings content pack.
- For Colleague implementations, view the “Recruiter to Colleague Miscellaneous Data Contracts” spreadsheet in the Ellucian Support Center Recruiter/Colleague Field Mappings content pack.

Activities

Recruiter provides the ability to export activities to Banner or Colleague. Activities will only be exported if the prospect has an ERP ID and the appropriate ERP configuration settings have been enabled.

When an activity is exported, the following data is sent to your ERP system:

- Activity Date (Start Time, if it exists, otherwise Date Created)
- Activity Code
- Activity Subject

If the activity type is “Item Received,” two additional fields are sent:

- Item Location
- Item Status
Details about the activity exports are identified in the following mapping spreadsheets:

- For Banner implementations, view the “Recruiter to Banner Field Mappings” spreadsheet in the Ellucian Support Center Recruiter/Banner Field Mappings content pack.

- For Colleague implementations, view the “Recruiter to Colleague Miscellaneous Data Contracts” spreadsheet in the Ellucian Support Center Recruiter/Colleague Field Mappings content pack.
Test Scores

Recruiter provides the ability to export official test scores to Banner or Colleague. Test scores will only be exported if the prospect has an ERP ID, the appropriate ERP configuration settings have been enabled, and the test type has been marked for submission to the ERP system.

When a test score is exported, the following data is sent to your ERP system:
- Test Type
- Test Date
- Subtest Type
- Score
- Test Score Source

Details about the test score exports are identified in the following mapping spreadsheets:
- For Banner implementations, view the “Recruiter to Banner Field Mappings” spreadsheet in the Ellucian Support Center Recruiter/Banner Field Mappings content pack.
- For Colleague implementations, view the “Recruiter to Colleague Test Score Data Contract” spreadsheet in the Ellucian Support Center Recruiter/Colleague Field Mappings content pack.
Transcript Courses

Recruiter provides the ability to export transcript courses to Colleague. This option is not yet supported in Banner. Transcript courses will only be exported if the prospect has an ERP ID and the appropriate ERP configuration settings have been enabled.

When a transcript course is exported, the following data is sent to your ERP system:

- Institution
- Created On Date
- Course Title
- Course ID
- Start Date
- End Date
- Academic Term
- Transcript Category
- Transcript Status
- Transcript Source
- Number of Credits
- Grade
- Interim Grade

Details about the transcript course exports are identified in the “Recruiter to Colleague Transcript Course Data Contract” spreadsheet in the Ellucian Support Center Recruiter/Colleague Field Mappings content pack.

Official Transcript Information

The official transcript information (for example, Transcript GPA, Transcript Class Rank, etc.) on the college or high school academic history record will be sent to the ERP system when the application is first submitted or when prospect data is sent. For example, if you submit an application and then later add official transcript information to a high school academic history record, then you must send the prospect data to the ERP system to export that data using the “Send Prospect to ERP” option.